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第一部分 ICETEK–F2812-A 评估板硬件使用指导 

第一章 ICETEK–F2812-A 评估板技术指标 
 

 主处理芯片：TMS320F2812，运行速度为 150M； 

 工作速度可达 150MIPS； 

 片上 RAM  18k*16bit； 

 片上扩展 RAM 存贮空间 64K×16Bit； 

 自带 16 路 12bit A/D， 最大采样速率 1 5msps； 

 2 路的 DAC7528 转换，10M/S，8Bit； 

 两路 UART 串行接口，符合 RS232 标准； 

 16 路 PWM 输出； 

 1 路 CAN 接口通讯； 

 片上 128*16bit FLASH，自带 128 位加密位； 

 设计有用户可以自定义的开关和测试指示灯； 

 4 组标准扩展连接器，为用户进行二次开发提供条件； 

 具有 IEEE1149.1 相兼容的逻辑扫描电路，该电路仅用于测试和仿真； 

 +5V 电源输入，内部+3.3V、+1.6V 电源管理； 

 4 层板设计工艺，工作稳定可靠； 

 具有自启动功能设计，可以实现脱机工作； 

 可以选配多种应用接口板，包括语音板，网络板等。 
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第二章 ICETEK-F2812 –A 评估板原理图和实物图 
 

 
一．ICETEK–F2812-A 评估板实物图 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

图 1.1   ICETEK-F2812-A 评估板实物图 
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二．ICETEK-F2812-A 器件分布图 
 

  
图 1.2  ICETEK–F2812-A 器件分布图 

 

 

三．ICETEK–F2812–A 评估板原理框图 
 

 
图 1.3  ICETEK–F2812-A 评估板原理框图 
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第三章 ICETEK–F2812-A 评估板接口说明 
 

我们将详细说明这些外围接口的功能和特征定义。首先，表 I-1 归纳总结了这些跳线和功

能分类，接口位置请参考图 I-1 
 

表 1.1：接口和功能分类 

功能分类 接口名称 接口定义 

电源接口 +5v 电源插座 5V 电源输入 

外设接口 标准 RS-232 九针 D 型异步串口（可以和计算机直接通讯） 

P1 扩展插座 用于二次开发的 34 芯外扩总线 

P2 扩展插座 用于二次开发的 34 芯外扩总线 

P3 扩展插座 用于二次开发的 34 芯外扩总线 
总线接口 

P4 扩展插座 用于二次开发的 34 芯外扩总线 

电源指示灯 接通电源后会亮 指示灯 

用户可控指示灯 共有四个 

辅助接口 JTAG 仿真接口 DSP 仿真器从此处接入 

用户可控开关 共有四个 
开关 

复位按钮 手动复位开关 

跳线设置 JP2 Can 总线使能。 

ADREFLO1 2812芯片上管脚ADCLO 

AD 参考低电压输入，默认 2，3 连接。 
模式跳线设置 2 

ADREFIN1 2812芯片上管脚ADCBGREFIN， 

测试端，可以悬空或 2，3 脚连接 

MP/MC1 2812芯片上管脚XMP/MC,  

MP/MC 工作方式选择，默认 2，3 连接 

MDXA1 2812芯片上管脚MDXA,  

默认 1，2 连接。 

SCITXDA1 2812芯片上管脚SCITXDA,  

默认 1，2 连接。 

SPICLKA1 2812芯片上管脚SPICLKA,  

默认 1，2 连接。 

模式跳线设置 1 

SPISTEA1 2812芯片上管脚SPISTEA,  

默认 1，2 连接。 
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下面将分别介绍这些接口： 
1． +5v 电源插座: 这个接口用于接入为整个板子供电的电源，电源电压为+5V,标准配置

的电源电流为 1A，如果不使用随板提供的电源，请注意电源的正负极性和电流的大

小。下面是这个接口的插孔示意图： 
 

 
                                     +5V 

 
 

                                                地（GND） 
图 1.4  电源插孔示意图 

 

2． 标准 RS-232:  9 针 D 型连接器，异步串口连接器，符合 RS-232 规范，输出电平为正

负 12V.下面是 9 针连接器的管脚定义： 
 

       
                     
                     

         
             

    
 

图 1.5  异步串口连接器示意图 

 

 

表 1.2    DB9 管脚定义表 

管脚号 管脚定义 说明 

1 NC 无连接 

2 TxD 数据输出引脚，与对方的输入脚连接 

3 RxD 数据输入引脚，与对方的输出脚连接 

4 NC 无连接 

5 GND 共地端 

6 NC 无连接 

7 NC 无连接 

8 NC 无连接 

9 NC 无连接 

 
3． P1 扩展插座:  34 芯扩展总线接口。P1 接口主要是扩展评估板上空闲的 DSP 外设引脚，

以便于定制用户的硬件环境。 

1 
2 
3 
4 
5 

6 
7 

8 
9 
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注意：由于这组引脚是直接来自于 F2812 DSP 芯片,因此，这些引脚为 TTL 3.3V 标准，

其输出最高电压为 3.3V。如果要接入 5V 器件，请在外接时注意电平转换。 

 

表 1.3  P1 的管脚定义和说明 

管脚号 管脚名 说明 

1 +5V 电源 由 POWER 提供的+5V 电源 

2 +5V 电源 由 POWER 提供的+5V 电源 

3 PWM1 PWM1 输出引脚 

4 PWM2 PWM2 输出引脚 

5 PWM3 PWM3 输出引脚 

6 PWM4 PWM4 输出引脚 

7 PWM5 PWM5 输出引脚 

8 PWM6 PWM6 输出引脚 

9 PWM7 PWM7 输出引脚 

10 PWM8 PWM8 输出引脚 

11 PWM9 PWM9 输出引脚 

12 T1PWM T1 输出引脚 

13 T2PWM T2 输出引脚 

14 T3PWM T3 输出引脚 

15 T4PWM T4 输出引脚 

16 T1CTRP 定时器 1 比较输出 

17 GND 地线 

18 GND 地线 

19 T2CTRP 定时器 2 比较输出 

20 T3CTRP 定时器 3 比较输出 

21 T4CTRP 定时器 4 北京输出 

22 C1CTRIP 比较器 1 比较输出 

23 C2CTRIP 比较器 2 比较输出 

24 C3CTRIP 比较器 3 比较输出 

25 TDIRA 定时器计数方向选择信号 A 

26 TCKINA 定时器时钟输入 A 

27 SCITXB 异步串口 TX 端 B 

28 SCIRXB 异步串口 RX 端 B 

29 SPSIMA SPI 从收主发 端 

30 SPSOMA SPI 主发从收 端 

31 SPICLKA SPI 时钟 

32 SPISTEA SPI Slave 设备发送使能 

33 GND 地线 

34 GND 地线 
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4． P2 扩展插座: 34 芯扩展总线接口。P2 接口主要是 AD 和 DA 接口，P2 中扩展了所有的 AD

和 DA 引脚。请注意评估板的对采集信号的要求。 
表 1.4   P2 的管脚定义和说明： 

管脚号 名称 说明 

1 VCCA 模拟电源+5V 

2 VCCA 模拟电源+5V 

3 CAP1 CAP 输入端 1 

4 CAP2 CAP 输入端 2 

5 ADINA2 模拟输入通道 A2 

6 ADINA3 模拟输入通道 A3 

7 ADINA4 模拟输入通道 A4 

8 ADINA5 模拟输入通道 A5 

9 ADINA6 模拟输入通道 A6 

10 ADINA7 模拟输入通道 A7 

11 ADINB0 模拟输入通道 B0 

12 ADINB1 模拟输入通道 B1 

13 ADINB2 模拟输入通道 B2 

14 ADINB3 模拟输入通道 B3 

15 ADINB4 模拟输入通道 B4 

16 ADINB5 模拟输入通道 B5 

17 AGND 模拟地 

18 AGND 模拟地 

19 ADINB6 模拟输入通道 B6 

20 ADINB7 模拟输入通道 B7 

21 ADREFIN 测试引脚，必须悬空 

22 ADCREFLO 模拟参考低电压输入 

23 ADINA0 模拟输入通道 A0 

24 ADINA1 模拟输入通道 A1 

25 DAOUT1 模拟输出通道 1 

26 DAOUT2 模拟输出通道 2 

27 DAOUT3 模拟输出通道 3 

28 DAOUT4 模拟输出通道 4 

29 CAP3 CAP 输入端 3 

30 CAP4 CAP 输入端 4 

31 CAP5 CAP 输入端 5 

32 CAP6 CAP 输入端 6 

33 AGND 模拟地 

34 AGND 模拟地 
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a) P3 扩展插座:  34 芯扩展总线接口。包含 16 根地址线和 16 根数据线（A16，A17， 
A18 扩展在 P4），可以用于读入和输出并行的数据。 
 
注意：这个插座上的地址线是由 F2812 芯片提供的，如果您在外部扩展的话，请注意

F2812 的地址线只能输出 3.3V 的电平。 

 
表 1.5   P3 的管脚定义和说明： 

管脚号 名称 说明 
1 A0 F2812 地址线 A0 
2 A1 F2812 地址线 A1 
3 A2 F2812 地址线 A2 
4 A3 F2812 地址线 A3 
5 A4 F2812 地址线 A4 
6 A5 F2812 地址线 A5 
7 A6 F2812 地址线 A6 
8 A7 F2812 地址线 A7 
9 A8 F2812 地址线 A8 

10 A9 F2812 地址线 A9 
11 A10 F2812 地址线 A10 
12 A11 F2812 地址线 A11 
13 A12 F2812 地址线 A12 
14 A13 F2812 地址线 A13 
15 A14 F2812 地址线 A14 
16 A15 F2812 地址线 A15 
17 GND 数字地 
18 GND 数字地 
19 D0 F2812 数据线 D0，双向总线 
20 D1 F2812 数据线 D1，双向总线 
21 D2 F2812 数据线 D2，双向总线 
22 D3 F2812 数据线 D3，双向总线 
23 D4 F2812 数据线 D4，双向总线 
24 D5 F2812 数据线 D5，双向总线 
25 D6 F2812 数据线 D6，双向总线 
26 D7 F2812 数据线 D7，双向总线 
27 D8 F2812 数据线 D8，双向总线 
28 D9 F2812 数据线 D9，双向总线 
29 D10 F2812 数据线 D10，双向总线 
30 D11 F2812 数据线 D11，双向总线 
31 D12 F2812 数据线 D12，双向总线 
32 D13 F2812 数据线 D13，双向总线 
33 D14 F2812 数据线 D14，双向总线 
34 D15 F2812 数据线 D15，双向总线 
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6． 扩展插座：34 芯扩展总线接口。包括 F2812 外部扩展总线的控制线、McBSP 接口线、 
外部中断和外部复位等重要的引脚信号。 
注意：这里的引脚都是由 DSP 直接引出的，在和外部设备连接时注意电平转换。 

 

表 1.6   P4 管脚定义和说明 

管脚号 管脚定义 管脚说明 
1 VCC +5V 电源 
2 VCC +5V 电源 
3 XZCS01 XINTF 0 区 1 区选择信号 
4 XZCS2 XINTF 2 区 选择信号 
5 XZCS6 XINTF 6 区 7 区选择信号 
6 A16 F2812 地址线 A16 
7 WE 写信号，低电平有效 
8 RD 读信号，低电平有效 

9 R/W 
F2812 的读/写信号，常为高电平。低电平时写有效，高电平

时读有效。 
10 A17 F2812 地址线 A17 
11 READY READY 信号线 
12 A18 F2812 地址线 A18 
13 RS Reset 信号（输入）；Watchdog Reset 信号（输出） 
14 EXT_RST 外部输入 DSP 评估板的复位信号 
15 NMI 不可屏蔽中断 
16 INT1 外部中断 1 
17 GND 数字地 
18 GND 数字地 
19 INT2 外部中断 2 
20 TDIRB 定时器方向选择 B 
21 TCLKINB 定时器时钟输入 B 
22 XF F2812 同名引脚 
23 MDRA McBsp 数据接收端 
24 MDXA McBsp 数据发送端 
25 PWM10 PWM10 输出引脚 
26 PWM11 PWM11 输出引脚 
27 PWM12 PWM12 输出引脚 
28 MCLKRA McBsp 接收时钟 
29 MFSXA McBsp 发送帧同步 
30 MCLKXA McBsp 发送时钟 
31 MFSRA McBsp 接收帧同步 
32 CLKOUT F2812 的时钟输出 
33 GND 数字地 
34 GND 数字地 
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7． 指示灯：如果评估板工作正常，此灯常亮。 
8． 用户可控指示灯: 用户指示灯，在板上有 4 个可编程的指示灯，分别为 DS1..DS4，这 

4 个指示灯的开关由 F2812 编程控制。 
9． JTAG 仿真接口：F2812 的仿真接口，用于连接 ICETEK-5100 系列的仿真器或兼容产 

品。注意，使用的仿真器必须支持 3.3V 仿真。 
10．JP2：Can 总线使能。当 1、2 短路时禁止 Can 总线工作；当 2、3 短路时，允许 Can 

总线工作。 
11．用户可控开关：4 个用户开关输入。可以用作 DSP 的输入信号。软件可以读取它的状 

态。当开关处于断开状态，即 OFF 状态时，开关输出高电平，DSP 读到逻辑“1”，而 
当开关处于连通状态，即 ON 状态时，开关输出低电平，DSP 读到逻辑“0”。 

12．复位按钮:手动复位开关。 
13．模式跳线设置 1：  

    MP/MC1，MCXA1，SCITXDA1，SPICLKA1，SPISTEA1 这几个跳线都是 2812
芯片上对应管脚引出，在 2812 的 datasheet 手册中可以查阅到（手册在配套光盘“外

围器件参考资料”目录中有提供，或从 www.ti.com 上下载最新版本的文档）。 
            每个跳线的 1，2，3 脚定义：靠近名称这边（例如：MP/MC1）为跳线 1 脚，往

右一个为 2 脚，再往右一个是 3 脚。1、2 脚相连为设置该 2812 管脚高电平，2、3 脚

相连为设置该 2812 管脚低电平 
 

 

例如： 

 
14．模式跳线设置 2： 

ADREFIN1, ADREFLO1 这几个跳线都是 2812 芯片上对应管脚引出，在 2812 的

datasheet 手册中可以查阅到（手册在配套光盘“外围器件参考资料”目录中有提供，

或从 www.ti.com 上下载最新版本的文档）。 
每个跳线的 1，2，3 脚定义：靠近三个小电阻这边为跳线 1 脚，往右一个为 2 脚，

再往右一个是 3 脚。1、2 脚相连为设置该 2812 管脚高电平，2、3 脚相连为设置该 2812
管脚低电平。 

 

 

例如： ADREFLO1 1 2 3 

MP/MC1 1 2 3 
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16．ICETEK–F2812-A 评估板跳线及开关位置示意图： 
    下图中说明了 ICETEK–F2812-A 评估板中，跳线和开关以及扩展口的具体描述。其

中 MP/MC1 与 SPITEA1 之间自下而上分别是 MDXA1，SCITXDA1，SPICLKA1。 
 
                     P4                              P2 
            33                      1      33                      1 
            34                      2      34                      2  
                                   ADREFIN1     1                             
                                   ADREFLO1     1              
                                                                               
       SPISTEA1    1 
                     
        MP/MC1    1                                  
 
 
 
                                                                JP2       1  
                     P3                               P1 
            33                      1      33                      1 
            34                      2      34                      2 
   
                              图 1.6  跳线及开关位置示意图 

 
TMS320 

F2812PGFA 
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第四章 ICETEK–F2812-A 

评估板的存储空间定义及寄存器映射说明 

 
一、 ICETEK–F2812-A 评估板的内存映射 

ICETEK–F2812-A 评估板（以下简称评估板）的内存映射图如下，与 TMS320F2812A 芯

片不同的是，所有的寄存器和存储器全部映射在 XINTF ZONE 2 译码的空间内，占用

TMS320F2812A 芯片的 80000h-0FFFFFh 地址单元中。因此，如果您需要使用 DSP 芯片的管脚

外扩硬件设备的话，请避免使用这部分地址资源。 
 对于这部分地址单元，基本上分为两个部分，从 80000h 到 0BFFFFh 共 256K 的地址单元

分配给片外扩展存储器。这里有一个声明，一般来说，在出厂时，板上所连接的存储器一般为

64K 的存储器，因此这部分的实际有效内存是 80000h-8FFFFh。为了特殊的需求，这里最多可

以扩展到 256K 的实际存储器。 
 从 C0000h 到 FFFFFh 是外围其他设备的寄存器接口，这里包含一个 12 位的模数转换器

DAC7528，以及四位的状态显示数码管和四位可读入数字量的开关。 
 下面是评估板的内存映射图，红色部分是板子上有外扩硬件资源的地址空间，其他部分来

自于 TMS320F2812A 芯片的数据手册（data sheet）,关于与芯片相关的地址空间的详细介绍，

请参考 tms320f2812 数据手册的相关说明。 
注意：  数据手册会不定期的修改，除了红色部分，其他地址如与数据手册有出入，以数

据手册的说明为准。我们推荐用户在使用评估板时，下载最新的数据手册。（数

据手册在配套光盘中“外围器件参考资料”目录中） 
 

块起始地址 片内存储空间（On-Chip） 片外存储空间（XINTF） 

 数据空间 程序空间 数据空间 程序空间 

0x00 0000 
M0 向量 –随机存储器（32*32） 

（当 VMAP = 0 时有效） 
0x00 0040 M0 SARAM(单存取随机存储器) 1K*16

0x00 0400 M1 SARAM(单存取随机存储器) 1K*16

0x00 0800 
外设寄存器组 0 

（2K*16） 

0x00 0D00

外设向量 
（PIE Vector） 
（256*16） 

(当
VMAP=1,ENPIE=1

时有效) 

无效 

   

相当于

TMS320F
24x/LF24
0x 数据存

储空间 

0x00 0E00 保留 

保留 
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块起始地址 片内存储空间（On-Chip） 片外存储空间（XINTF） 

片外空间 0（8K*16 XZCS0AND1） 

0x0
0  

200
0 

0x00 2000 保留 

片外空间 1（8K*16 XZCS0AND1）(保护) 

0x0
0 

400
0 

0x00 6000 
外设寄存器组 1 
(4K*16)受保护 

 

0x00 7000 
外设寄存器组 2 
(4K*16)受保护 

 

0x00 8000 
L0 SARAM(单存取随机存储器) 4K*16 

(安全块) 

0x00 9000 
L1 SARAM(单存取随机存储器) 4K*16 

(安全块) 

保留 

片外空间 2（0.5M*16 XZCS2） 
片外扩展存储器（256K*16） 

0x0
8 

000
0 

片外空间 2（0.5M*16 XZCS2） 
片外扩展寄存器（256K*16） 

0x0
c 

000
0 

0x00 A000 保留 

片外空间 6（0.5M*16 XZCS6AND7） 

0x1
0 

000
0 

 0x3D 7800 OTP ROM (1K *16,安全块) 

0x1
8 

000
0 

0x3D 7C00 保留 
0x3D 8000 片上 Flash（ 128K*16 安全块） 

0x3F 7FF8 128 位加密字 

0x3F 8000
H0 SARAM(单存取随机存储器) 8K*16 

(安全块) 

0x3F A000 保留 

保留 
相当于

TMS320F
24x/LF24
0x 程序存

储空间 

0x3F F000
启动代码（4K*16）当 MP/MC=0 时有

效 
片外空间 7（16K*16 XZCS6AND7）当

MP/MC=1 时有效 

0x3
F 

C0
00
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块起始地址 片内存储空间（On-Chip） 片外存储空间（XINTF） 

0x3F FFC0
BROM 向量，（32*32）当 VMAP 
=1,MP/MC=0，ENPIE=0 时有效 

外部扩展向量（32*32）当

VMAP=1,MP/MC=，ENPIE=0 时有效 
图 1.7  评估板的内存映射图 

① 存储器不能任意调整 
 ② 保留区为今后的扩展做准备，用户应用不应该访问这些区域 

③ 启动代码和片外扩展空间 7 依赖 MP/MC 引脚的状态来选择其中之一，不能同时映射到

DSP 的地址空间中 

④ 外设寄存器组 0、1 和 2 仅仅作为数据存储器访问，不能作为程序存储器访问。 
⑤ 保护表示为了配合流水线的工作在读操作之后的写操作将会被妥善的处理， 

⑥  一部分存储器被 EALLOW 保护，（参见 TMS320F2812 数据手册）是不希望在初始化之后

再次改变他们的值 

⑦ 片外空间0和1，6和7共享相同的片选信号，因此，他们虽然地址不同，但却是相同存储

器的镜像 （ mirrored locations）。  
 

二．片外扩展存储器 
如上所述，我们在芯片外扩展了 64K*16 位的存储器，存储器占用的地址空间共有 256K，

因此片外存储器实际占用的地址是 0x080000-0x08FFFF，其他的部分暂时没有使用，如果有特

殊需要，可以最多放置 256K 的存储器，或者 0x90000-0xBFFFF 可以用作其他外围设备的译码

空间。 
片外扩展的存储器型号是 IS61LV6416,这种器件可以按照 8 位或 16 位的方式使用，它的电

平可以和通常的 3.3V 器件连接。存储器与 DSP 连接的示意图如下所示。 
 
 
 
 
 
 
 
 
 
 
 

 

图 1.8    存储器与 DSP 连接的示意图 

 

外扩的存储器可以实现随机访问，这部分映射空间可以在DSP上电复位后的任何时候访问，

此时不需要对DSP做任何初始化。如果需要这部分存储器在高速的状态下运行，需要修改DSP的
存储器等待状态。具体设置DSP的存储器和数值可以参考TMS320F2812数据手册。一般来说，为

保证存储器的稳定读写，当DSP在最高速状态运行时，只需要1个软件等待状态。    

    
       XZCS2
 
         XWE
 
         XRD
TMS320F2812 
 
 
       A15-A0
 
     

D15-D0

CE 
 
WE 
 
OE 
 
IS61LV6416 
 
A15-A0 
 
 
D15-D0 

地址译码 
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三． 外扩硬件的存储器映射寄存器总结 

除了外部扩展存储器之外，板上还扩展了一些数据和控制端口，这些端口用来驱动板上的 
其他外设。在这一节我们给出所有外扩寄存器的地址和数据信息，详细的编程分别在接下来的 
其他小节说明。下面是所有的外扩寄存器列表和简单的介绍： 

 
表 1.8   外扩寄存器列表 

外扩寄存器地址 寄存器名称 有效位数 读写状态 上电复位状态 
0xC0000 LEDR D3 到 D0 有效 读/写允许 0000b 

0xC0001 SWR D3 到 D0 有效 读允许 -------- 

0xC0002 DAOUT1 D7 到 D0 有效 读/写允许 0000 0000b 
0xC0003 DAOUT2 D7 到 D0 有效 读/写允许 0000 0000b 

 

注意：0xc0002---0xc0003 这几个寄存器定义在第五章的 DA 说明中有介绍。 

 
 
ICETEK–F2812-A 评估板提供了四位的状态显示数码管和四位可读入数字量的开关，这些

接口不使用 TMS3202812 的芯片管脚实现。下面是显示数码管和开关的寄存器定义和说明： 
 

7                                    4 3                                    0 

无效位 LEDR3 LEDR2 LEDR1 LEDR0 

    R/W-0 R/W-0 R/W-0 R/W-0 

图 1.9  LEDR 寄存器：地址是 0xC0000 

图例：R 读允许，W：写允许，R/W:读写允许，-0：复位值,-x 没有固定值 

 
位 名称 说明 

3 LEDR3 

2 LEDR2 

1 LEDR1 

0 LEDR0 

四位显示数码管。向某位写“1”，点亮相应的发光管，写“0”，则使数码管熄灭。

这个寄存器可读，在使用时可以通过读操作得到最后一次写操作的值。 

图 1.10  LEDR 寄存器说明 

 

 

7                                    4 

 

3                                    0 

无效位 SWR3 SWR2 SWR1 SWR0 

    R-x R-x R-x R-x 

图 1.11  SWR 寄存器: 地址是 0xC0001 

图例：R 读允许，W：写允许，R/W:读写允许，-0：复位值,-x 没有固定值 
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位 名称 说明 
3 SWR3 
2 SWR2 
1 SWR1 
0 SWR0 

四位开关。当开关连通（处于 ON 一侧）时，寄存器读入“0”，当开关断开（不处

于 ON 一侧）时，寄存器读入“1”。寄存器可读，在使用时可以通过读操作得到四

个开关的当前状态。 

图 1.12   SWR 寄存器: 地址是 0xC0001 
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 第五章 DA 转换器 TLC7528 使用说明 

 
TLC7528C 是双路、8 位数字－模拟转换器，内部具有各自单独的数据锁存器，其特性包

括两 DAC 非常精密的一致性，数据通过公共 8 位输入口转送至两 DAC 数据锁存器的任意一个。

控制输入端 DACA/DACB 决定哪一个 DAC 被装载。器件的装载周期与随机存取存储器的写周

期类似，能方便地与大多数通用微处理器总线或端口相接口。 器件的工作电压 5V 至 15V，功

耗小于 15mW（典型值）。2 或 4 象限的乘法功能使该器件成为许多微处理器的增益设置和信号

控制的良好选择。它可工作于电压模式，与电流输出相比较，更适合于电压输出。 TLC7528C
的工作温度范围从 0℃至 70℃。 

 

1．结构框图：(图 1.13.1) 

 

 

 

 

图 1.13.1  TLC7528 结构框图 
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2． 基本参考应用图示如下：图 1.13.2 (TLC7528) 

 

 

 

图 1.13.2  TLC7528 基本参考应用图 

 

3. TLC7528 的引脚描述 表 1.9.1 

 

表 1.9.1  TLC7528的引脚定义 

 
 

引脚 名称 描述 引脚 名称 描述 

1  AGND 模拟地 11 OUTB  通道2输出 

2  OUTA 通道1输出  12 RFBB  通道2反馈电压 

3  RFBA  通道1反馈电压 13 REFB  通道2参考电压 

4  REFA  通道1参考电压  14 VDD 驱动电压  

5  DGND  数字地 15 WR  读写选通  

6  A/B  通道1，2选通 16 CS  片选  

7  DB7  数据位 7，（最高位）  17 DB0  数据位0（最低位）  

8  DB6 数据位 6  18 DB1 数据位1 

9  DB5  数据位 5  19 DB2 数据位2 

10  DB4  数据位 4  20 DB3 数据位3 
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4．简单应用及时序介绍 

    TLC7528 的两路转换通道分别映射在 2812 的地址 0xc0000 和 0xc0001。向该地址写入的数

据会直接送到 TLC7528 进行转换。 

 

 

图 1.14  TLC7528 基本参考应用图 
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第六章 语音编解码芯片 TLV320AIC23 编程指南 
 

（注意：此芯片是在一个语音背板上扩展的，如果没有使用语音 

         背板，此章节可以跳过不看。背板型号为：ICETEK-AIC23-E） 

 

语音背板上有一个语音编解码芯片 TLV320AIC23。TLV320AIC23 是一个高性能的多媒体

数字语音编解码器，它的内部 ADC 和 DAC 转换模块带有完整的数字滤波器。（digital 
interpolation filters）数据传输宽度可以是 16 位，20 位，24 位和 32 位，采样频率范围支持从

8khz 到 96khz。在 ADC 采集达到 96khz 时噪音为 90-dBA，能够高保真的保存音频信号。在

DAC 转换达到 96khz 时噪音为 100-Dba，能够高品质的数字回放音频，在回放时仅仅减少 23 
mW。 

 
TLV320AIC23 详细指标： 
+高品质的立体声多媒体数字语音编解码器 
*在 ADC 采用 48 kHz 采样率时噪音 90-dB 
*在 DAC 采用 48 kHz 采样率时噪音 100-dB  
*1.42 V – 3.6 V 核心数字电压： 兼容 TI F28x DSP 内核电压 
*2.7 V – 3.6 V 缓冲器和模拟：兼容 TI F28x DSP 内核电压 
*支持 8-kHz – 96-kHz 的采样频率 
+软件控制通过 TI McBSP 接口 
+音频数据输入输出通过 TI McBSP 接口 

 
立体声接口图示： 

 
 

 
                                                                      

 地 
右声道 

                  左声道 
               

图  1.15   立体声接口 

 

 
AIC23 芯片是通过 2812 的 mcbsp 接口来控制和传输音频数据的。下表是 AIC23 芯片的映

射寄存器地址及名称。（详细说明见配套光盘中“外围器件参考资料”目录下的 aic23.Pdf
文档） 
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表 1.10  TLV320AIC23的 映射寄存器定义： 
ADDRESS REGISTER 
0000000 左声道输入控制 
0000001 右声道输入控制 
0000010 左耳机通道控制 
0000011 右耳机通道控制 
0000100 模拟音频通道控制 
0000101 数字音频通道控制 
0000110 启动控制 
0000111 数字音频格式 
0001000 样本速度控制 
0001001 数字界面激活 
0001111 初始化寄存器 

 
表 1.11  左声道输入控制(Address: 0000000) 

8 7 6 5 4 3 2 1 0 
LRS LIM X X LIV4 LIV3 LIV2 LIV1 LIV0 

R/W-0 R/W-1 R/W-0 R/W-0 R/W-1 R/W-0 R/W-1 R/W-1 R/W-1 
图例：R 读允许，W：写允许，R/W:读写允许，-0：复位值,-x 没有固定值 

LRS：左右声道同时更新 0 = 禁止 1 = 激活 

LIM：左声道输入衰减 0 = Normal 1 = Muted 

LIV[4:0]： 左声道输入控制衰减 (10111 = 0 dB缺省) 

最大 11111 = +12 dB 最小 00000 = –34.5 dB  

 
表 1.12   右声道输入控制(Address: 0000001) 

8 7 6 5 4 3 2 1 0 
RLS RIM X X RIV4 RIV3 RIV2 RIV1 RIV0 

R/W-0 R/W-1 R/W-0 R/W-0 R/W-1 R/W-0 R/W-1 R/W-1 R/W-1 
图例：R 读允许，W：写允许，R/W:读写允许，-0：复位值,-x 没有固定值 

LRS：左右声道同时更新 0 = 禁止 1 = 激活 

LIM：右声道输入衰减 0 = Normal 1 = Muted 

LIV[4:0]： 右声道输入控制衰减 (10111 = 0 dB缺省) 

最大 11111 = +12 dB 最小 00000 = –34.5 dB 

 
表 1.13    左耳机通道控制 (Address: 0000010) 

8 7 6 5 4 3 2 1 0 
LRS LZC LHV6 LHV5 LHV4 LHV3 LHV2 LHV1 LHV0 

R/W-0 R/W-1 R/W-1 R/W-1 R/W-1 R/W-1 R/W-0 R/W-0 R/W-1 
图例：R 读允许，W：写允许，R/W:读写允许，-0：复位值,-x 没有固定值 

LRS：左右耳机通道控制 0 = 禁止 1 = 激活  

LZC：0 点检查   0 = Off 1 = On 

LHV[6:0]：左耳机通道控制音量衰减(1111001 = 0 dB default) 

最大 1111111 = +6 dB  
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最小 0110000 = –73 dB (mute) 

表 1.14    右耳机通道控制(Address: 0000011) 
8 7 6 5 4 3 2 1 0 

RLS RZC RHV6 RHV5 RHV4 RHV3 RHV2 RHV1 RHV0 
R/W-0 R/W-1 R/W-1 R/W-1 R/W-1 R/W-1 R/W-0 R/W-0 R/W-1 
图例：R 读允许，W：写允许，R/W:读写允许，-0：复位值,-x 没有固定值 

LRS：左右耳机通道控制 0 = 禁止 1 = 激活  

LZC：0 点检查   0 = Off 1 = On 

LHV[6:0]：右耳机通道控制音量衰减(1111001 = 0 dB default) 

最大 1111111 = +6 dB  

最小 0110000 = –73 dB (mute) 

 

表 1.15   模拟音频通道控制 (Address: 0000100) 
8 7 6 5 4 3 2 1 0 
X STA1 STA0 STE DAC BYP INSEL MICM MICB 

R/W-0 R/W-0 R/W-0 R/W-0 R/W-1 R/W-1 R/W-0 R/W-1 R/W-0 
STA[1:0] 侧音衰减 00= –6 dB 01= –9 dB 10= –12 dB 11= –15 dB 

STE 侧音激活 0 = 禁止 1 = 激活   
DAC DAC 选择 0 = DAC 关闭 1 = DAC 选择   
BYP 旁路 0 = 禁止 1= 激活   

INSEL 模拟输入选择 0 = 线路 1= 麦克风   
MICM 麦克风衰减 0 = 普通 l 1 = 衰减   
MICB 麦克风增益 0=OdB 1 =20dB   

       

 表 1.16    数字音频通道控制 (Address: 0000101) 
8 7 6 5 4 3 2 1 0 
X X X X X DACM DEEMP1 DEEMP0 ADCHP 

R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-1 R/W-0 R/W-0 
图例：R 读允许，W：写允许，R/W:读写允许，-0：复位值,-x 没有固定值 

DACM：DAC 软件衰减    0 = 禁止 1 = 激活 

DEEMP[1:0]：De-emphasis 控制 00=禁止 01=32kHz 10 = 44.1kHz 11= 48 Khz 

ADCHP：ADC 滤波器  0 = 禁止 1 = 激活 

X：保留 

 
表 1.17    启动控制 (Address: 0000110) 

8 7 6 5 4 3 2 1 0 
X OFF CLK OSC OUT DAC ADC MIC LINE 

R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-1 R/W-1 R/W-1 
OFF 设备电源 0= On 1=OFF 
CLK 时钟 0= On 1=OFF 
OSC 振荡器 0= On 1=OFF 
OUT 输出 0= On 1=OFF 
DAC DAC 0= On 1=OFF 
ADC ADC 0= On 1=OFF 
MIC 麦克风输入 0= On 1=OFF 
LINE Line 输入 0= On 1=OFF 
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 表 1.18    数字音频格式(Address: 0000111) 
8 7 6 5 4 3 2 1 0 
X X MS LRSWAP LRP IWL1 IWL0 FOR1 FOR0 

R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-1 
图例：R 读允许，W：写允许，R/W:读写允许，-0：复位值,-x 没有固定值 

MS：主从选择   0 = 从模式  1 = 主模式 

LRSWAP：DAC 左/右通道交换  0 = 禁止 1 = 激活 

LRP： DAC 左/右通道设定  0 = 右通道在 LRCIN 高电平 

1 =右通道在 LRCIN 低电平 

IWL[1:0]：输入长度  00 = 16 bit 01 = 20 bit 10 = 24 bit 11 = 32 bit 

FOR[1:0]：数据初始化 11 = DSP 初始化, 帧同步来自于两个字 

10 = I2S 初始化, 

01 = MSB 优先 ，左声道排列 00 = MSB 优先 ，右声道排列 

X：保留 

 
表 1.19    样本速度控制(Address: 0001000) 

8 7 6 5 4 3 2 1 0 
X CLKOU

T
CLKIN SR3 SR2 SR1 SR0 BOSR USB/Normal 

R/W-0 R/W-0 R/W-0 R/W-1 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 
CLKIN 

CLKOUT 
时钟输入分割 
时钟输出分割 

0 = MCLK 
0 = MCLK 

1 = MCLK/2 
1 = MCLK/2 

SR[3:0] 样本速度控制 
BOSR 基础速度比率 

 USB 模式: 0= 250 fs 1= 272 fs 
 普通模式: 0= 250 f 1= 384 fs 
USB/Normal 时钟模式选择 0= 普通 1= USB 
X 保留   

 

表 1.20    数字界面激活 (Address: 0001001) 
8 7 6 5 4 3 2 1 0 
X X X X X X X X ACT 

R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 
图例：R 读允许，W：写允许，R/W:读写允许，-0：复位值,-x 没有固定值 

ACT：激活控制   0 = 停止   1 =  激活 

X：  保留 

  

 表 1.21    初始化寄存器(Address: 0001111) 
8 7 6 5 4 3 2 1 0 

RES RES RES RES RES RES RES RES RES 
R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 

图例：R 读允许，W：写允许，R/W:读写允许，-0：复位值,-x 没有固定值 

RES ：写 000000000 到这个寄存器引发初始化 

 



    REALTIME—DSP 系列应用丛书 

24 
 

地址：北京市海淀区知春路 108 号豪景大厦 A 座 18 层                     http://www.realtimedsp.com.cn 
电话：010-62105690(中继)/91-97                                         传真：010-62105699   

GND 

SCL
SDA

TMS320F2812 
 
CLKR0
CLKX0

FSX0

FSR0

DX0
DR0

SCLK 
SDIN            

MODE 
CS 
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BCLK 
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关于TLV320AIC23的详细信息，请参考随板软件中的数据手册。下图是 2812 

与 TLV320AIC23 的连接示意图。 
 

 
 
 
 

  
 
 
 
 
 
 
 
 
 

 

 
 

 

注：关于 ICETEK-AIC23-E 板的语音测试程序请看第三部分中的实验 7.1。 

图 1.16   2812 与 TLV320AIC23 的连接示意图 
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第七章 ICETEK-CTR 液晶板寄存器说明 
 
目前 F2812 实验箱上扩展的液晶板分为以下三种： 
       60 型液晶控制板 

61 型液晶控制板 
       80 型液晶控制板 
液晶控制板的详细说明请参阅《DSP 教学实验箱用户手册》，在这里我们就不详说了。下

面我们将以列表的形式介绍针对 2812 芯片上的扩展液晶控制板的寄存器地址。 
60 型液晶控制板： 

名称 地址 功能 属性 
CTRGR 0x108000 全局控制寄存器 W 

CTRLCDCR 0x108002 液晶控制寄存器 W 
CTRLCDCMDR 0x108001 液晶命令寄存器 W 

CTRLCDLCR 0x108003 液晶左半屏控制寄存器 W 
CTRLCDRCR 0x108004 液晶右半屏控制寄存器 W 

CTRLR 0x108007 辅助控制寄存器 W 
CTRLA 0x108005 发光二极管控制寄存器 W 

CTRKEY 0x108001 键盘数据回读寄存器 R 
CTRCLKEY 0x108002 清除键盘寄存器 R 

表 1.22 
61 型液晶控制板： 

名称 地址 功能 属性 
CTRGR 0x108000 全局控制寄存器 W 

CTRLCDCR 0x108002 液晶控制寄存器 W 
CTRLCDCMDR 0x108001 液晶命令寄存器 W 

CTRLCDLCR 0x108003 液晶左半屏控制寄存器 W 
CTRLCDRCR 0x108004 液晶右半屏控制寄存器 W 

CTRLR 0x108007 辅助控制寄存器 W 
CTRLA 0x108005 发光二极管控制寄存器 W 

CTRKEY 0x108001 键盘数据回读寄存器 R 
CTRCLKEY 0x108002 清除键盘寄存器 R 

表 1.23 
80 型液晶控制板： 

名称 地址 功能 属性 
CTRSTATUS 0x108000 全局控制寄存器 W 
CTRLED 0x108004 指示灯控制寄存器 W 
MCTRKEY 0x108005 键盘接收寄存器 R 
CTRCLKEY 0x108006 键盘清除寄存器 W 
LCDCOMMAND 0x108000 液晶屏幕指令寄存器 W 
LCDDATA 0x108001 液晶屏幕参数寄存器 W/R 
LCDSTATUS 0x108002 液晶屏幕状态字寄存器 R 
CTRMOTORBSPEED 0x108002 电机速度回读寄存器 R 

表 1.24 
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第二部分 ICETEK–F2812-A 教学系统软件实验目录介绍 
 

目前 F2812 实验箱上扩展的液晶板分为以下三种： 
       60 型液晶控制板 

61 型液晶控制板 
       80 型液晶控制板 
液晶控制板的详细说明请参阅《DSP 教学实验箱用户手册》，在这里我们就不详说了。在

第三部分的软件实验中我们将包含这三种液晶控制板的所有实验程序，下面我们将针对不同的

液晶控制板所能完成的实验做一个说明。 
    
   60 型液晶控制板实物图： 
 

        
 

图 2.1 
 
   60 型液晶控制板实验目录： 
    

一．CCS 软件应用实验 
实验 1.1：Code Composer Studio 入门 
实验 1.2：编写一个以 C 语言为基础的 DSP 程序 
实验 1.3：编写一个以汇编(ASM)语言为基础的 DSP 程序 
实验 1.4：编写一个汇编和 C 混合的 DSP 程序 

二．基于 DSP 芯片的实验 
实验 2.1：DSP 数据存取实验 

三．基于 DSP 系统的实验 
实验 3.1：指示灯实验 



         瑞泰创新—ICETEK-F2812-A 教学系统软件实验指导 

 
 
地址：北京市海淀区知春路 108 号豪景大厦 A 座 18 层                    http://www.realtimedsp.com.cn 
电话：010-62105690(中继)/91-97                                      传真：010-62105699   

27 

实验 3.2：拨码开关控制实验 
实验 3.3：DSP 的定时器 
实验 3.4：外中断 
实验 3.4.1：外中断(V60 版) 

实验 3.5：单路，多路模数转换（AD） 
实验 3.6：单路，多路数模转换（DA） 
实验 3.7：自启动（自举） 
实验 3.8：异步串口通信 
实验 3.9：PWM 输出实验 
实验 3.10：CAN 接口通讯自检测 

四．DSP 实现外部控制实验 
实验 4.1：通用输入输出管脚应用 
   实验 4.1.1：通用输入输出管脚应用(V60 版) 
实验 4.2：外设控制实验—发光二极管阵列显示实验 

               实验 4.2.1：外设控制实验—发光二极管阵列显示实验(V60 版) 
实验 4.3：液晶显示器控制显示 

实验 4.3.1：液晶显示器控制显示(V60 版) 
实验 4.4：键盘输入 

实验 4.4.1：键盘输入(V60 版) 
实验 4.5：外设控制实验—音频信号发生实验 

实验 4.5.1：外设控制实验—音频信号发生实验(V60 版) 
实验 4.6：直流电机控制实验 

实验 4.6.1：直流电机控制实验(V60 版) 
实验 4.7：步进电机控制 

实验 4.7.1：步进电机控制(V60 版) 
五．DSP 算法实验 

实验 5.1：有限冲击响应滤波器（FIR）算法实验 
实验 5.2：无限冲激响应滤波器(IIR)算法 
实验 5.3：快速傅立叶变换(FFT)算法 
实验 5.4：卷积算法实验 
实验 5.5：自适应滤波器算法 
实验 5.6：抽样定理 

六．综合实验 
实验 6.1：交通灯综合控制 

实验 6.1.1：交通灯综合控制(V60 版) 
实验 6.2：多路信号混频 
实验 6.3：FIR 滤波器的信号滤波 
  实验 6.3.1：FIR 滤波器的信号滤波(V60 版) 
实验 6.4：PID 算法控制实验 

实验 6.4.1：PID 算法控制实验(V60 版) 
七. 语音信号采集与分析实验 

实验 7.1：语音采集和放送 
实验 7.2：语音信号编码解码(G.711)  
实验 7.3：语音信号的 FIR 滤波 

Administrator
矩形
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61 型液晶控制板实物图： 
 

 
 

图 2.2 
 
61 型液晶控制板实验目录： 
    

一．CCS 软件应用实验 
实验 1.1：Code Composer Studio 入门 
实验 1.2：编写一个以 C 语言为基础的 DSP 程序 
实验 1.3：编写一个以汇编(ASM)语言为基础的 DSP 程序 
实验 1.4：编写一个汇编和 C 混合的 DSP 程序 

二．基于 DSP 芯片的实验 
实验 2.1：DSP 数据存取实验 

三．基于 DSP 系统的实验 
实验 3.1：指示灯实验 
实验 3.2：拨码开关控制实验 
实验 3.3：DSP 的定时器 
实验 3.4：外中断 
实验 3.4.2：外中断(V61 版) 

实验 3.5：单路，多路模数转换（AD） 
实验 3.6：单路，多路数模转换（DA） 
实验 3.7：自启动（自举） 
实验 3.8：异步串口通信 
实验 3.9：PWM 输出实验 
实验 3.10：CAN 接口通讯自检测 
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四．DSP 实现外部控制实验 
实验 4.1：通用输入输出管脚应用 
   实验 4.1.2：通用输入输出管脚应用(V61 版) 
实验 4.2：外设控制实验—发光二极管阵列显示实验 

               实验 4.2.2：外设控制实验—发光二极管阵列显示实验(V61 版) 
实验 4.3：液晶显示器控制显示 

实验 4.3.2：液晶显示器控制显示(V61 版) 
实验 4.4：键盘输入 

实验 4.4.2：键盘输入(V61 版) 
实验 4.5：外设控制实验—音频信号发生实验 

实验 4.5.2：外设控制实验—音频信号发生实验(V61 版) 
实验 4.6：直流电机控制实验 

实验 4.6.2：直流电机控制实验(V61 版) 
实验 4.7：步进电机控制 

实验 4.7.2：步进电机控制(V61 版) 
五．DSP 算法实验 

实验 5.1：有限冲击响应滤波器（FIR）算法实验 
实验 5.2：无限冲激响应滤波器(IIR)算法 
实验 5.3：快速傅立叶变换(FFT)算法 
实验 5.4：卷积算法实验 
实验 5.5：自适应滤波器算法 
实验 5.6：抽样定理 

六．综合实验 
实验 6.1：交通灯综合控制 

实验 6.1.2：交通灯综合控制(V61 版) 
实验 6.2：多路信号混频 
实验 6.3：FIR 滤波器的信号滤波 

实验 6.3.1：FIR 滤波器的信号滤波(V61 版) 
实验 6.4：PID 算法控制实验 

实验 6.4.2：PID 算法控制实验(V61 版) 
七. 语音信号采集与分析实验 

实验 7.1：语音采集和放送 
实验 7.2：语音信号编码解码(G.711)  
实验 7.3：语音信号的 FIR 滤波 
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80 型液晶控制板实物图： 
 

 
 

图 2.3 
 
80 型液晶控制板实验目录： 
    

一．CCS 软件应用实验 
实验 1.1：Code Composer Studio 入门 
实验 1.2：编写一个以 C 语言为基础的 DSP 程序 
实验 1.3：编写一个以汇编(ASM)语言为基础的 DSP 程序 
实验 1.4：编写一个汇编和 C 混合的 DSP 程序 

二．基于 DSP 芯片的实验 
实验 2.1：DSP 数据存取实验 

三．基于 DSP 系统的实验 
实验 3.1：指示灯实验 
实验 3.2：拨码开关控制实验 
实验 3.3：DSP 的定时器 
实验 3.4：外中断 
实验 3.4.3：外中断(V80 版) 

实验 3.5：单路，多路模数转换（AD） 
实验 3.6：单路，多路数模转换（DA） 
实验 3.7：自启动（自举） 
实验 3.8：异步串口通信 
实验 3.9：PWM 输出实验 
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实验 3.10：CAN 接口通讯自检测 
四．DSP 实现外部控制实验 

实验 4.1：通用输入输出管脚应用 
   实验 4.1.3：通用输入输出管脚应用(V80 版) 
实验 4.3：液晶显示器控制显示 

实验 4.3.3：液晶显示器控制显示(V80 版) 
实验 4.4：键盘输入 

实验 4.4.3：键盘输入(V80 版) 
实验 4.5：外设控制实验—音频信号发生实验 

实验 4.5.3：外设控制实验—音频信号发生实验(V80 版) 
五．DSP 算法实验 

实验 5.1：有限冲击响应滤波器（FIR）算法实验 
实验 5.2：无限冲激响应滤波器(IIR)算法 
实验 5.3：快速傅立叶变换(FFT)算法 
实验 5.4：卷积算法实验 
实验 5.5：自适应滤波器算法 
实验 5.6：抽样定理 

六．综合实验 
实验 6.2：多路信号混频 
实验 6.3：FIR 滤波器的信号滤波 
实验 6.3.3：FIR 滤波器的信号滤波(V80 版) 

实验 6.4：PID 算法控制实验 
实验 6.4.3：PID 算法控制实验(V80 版) 

七. 语音信号采集与分析实验 
实验 7.1：语音采集和放送 
实验 7.2：语音信号编码解码(G.711)  
实验 7.3：语音信号的 FIR 滤波 
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第三部分 ICETEK–F2812-A 教学系统软件实验指导 
 

第一章  实验设备安装 
 

一．开发环境 
开发 TMS320C28xx 应用系统一般需要以下设备和软件调试工具： 
1． 通用PC一台，安装Windows9x或Windows2000或WindowsXP操作系统及常用软件(如：

WinRAR 等)。 
2．TMS320C28xx 评估板及相关电源。如：ICETEK–F2812-A 评估板。 
3．通用 DSP 仿真器一台及相关连线。如：ICETEK-5100USB 仿真器。 
4．控制对象(选用)。如：ICETEK-CTR 控制板（在 2812 实验箱中已包含）。 
5．TI 的 DSP 开发集成环境 Code Composer Studio。如：CCS3. 3。 
6．仿真器驱动程序。（见配套光盘“开发系统驱动”目录中。） 
7．实验程序及文档。 

 
二．ICETEK-DSP 教学实验箱的硬件连接 
 

1．连接电源：打开实验箱，取出三相电源连接线(如右图)，将电源线 
的一端插入实验箱外部左恻箱壁上的电源插孔中。确认实验箱面板上电   
源总开关(位于实验箱底板左上角)处于“关”的位置，连接电源线的另 
一端至 220V 交流供电插座上，保证稳固连接。 

2．使用电源连接线(如右图，插头是带孔的)连接各模块电源：确认 
实验箱总电源断开。连接 ICETEK-CTR 板上边插座到实验箱底板上+12V 
电源插座；ICETEK-CTR 板下边插座到实验箱底板上+5V 电源插座；如 
使用 PP(并口)型仿真器，则连接仿真器上插座到实验箱底板上+5V 电源插座； 
连接 DSP 评估板模块电源插座到实验箱底板上+5V 电源插座。注意各插 
头要插到底，防止虚接或接触不良。 
  注：新改良的实验箱上无需外接电源连接线了。 

3．连接 DSP 评估板信号线：当需要连接信号源输出到 A/D 输入插座   
时，使用信号连接线(如右图)分别连接相应插座。 

4、接通电源：检查实验箱上 220V 电源插座(箱体左侧)中保险管是否完好，在连接电源线 
以后，检查各模块供电连线是否正确连接，打开实验箱上的电源总开关(位于实验箱底板左上

角)，使开关位于“开”的位置，电源开关右侧的指示灯亮。 
 
三．构造 DSP 开发软件环境 

1．安装 CCS 软件(此文档假定用户将 CCS 安装在默认目录 C:\ CCStudio_v3.3 中，同时也

建议用户按照默认安装目录安装) 
(1) 将实验箱附带的教学光盘插入计算机光盘驱动器。 
(2) 打开教学光盘的根目录中有“ccs3.3”目录，用鼠标右键单击文件夹中 “Setup.exe”，
进入安装程序。 
   建议您安装时使用默认路径“ C:\CCStudio_v3.3”。 
(3) 选择“Code Composer Studio”，按照安装提示进行安装，并重新启动计算机。 
(4) 安装完毕，桌面上出现两个新的图标，如下图。  
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2．安装 DSP 通用仿真器驱动请参看光盘中实验箱附带的《ICETEK-5100USB 开发系统安

装说明》文档中相关章节来安装。 
3．安装实验程序 

双击光盘中的实验安装文件，自动解压缩后安装到 C:\ICETEK 目录下。 
例如：实验安装文件为“SetupF2812A.exe” 
 

 
四．设置 CCS 
 

1．设置 CCS 工作在软件仿真环境 

CCS 可以工作在纯软件仿真环境中，就是由软件在 PC 机内存中构造一个虚拟的 DSP 环

境，可以调试、运行程序。但一般软件无法构造 DSP 中的外设，所以软件仿真通常用于调试

纯软件的算法和进行效率分析等。 

在使用软件仿真方式工作时，无需连接板卡和仿真器等硬件。 

 (1)单击桌面上图标：进入 CCS 设置窗口。 

(2)在出现的窗口中按标号顺序进行如下设置： 
 
 
 
 
 
 

Administrator
线条

Administrator
线条
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图 3.1.1   删除掉原有的驱动设置 

(3)在出现的窗口中按标号顺序进行如下设置： 

 
                       图 3.1.2   选择软件仿真 F2812 芯片驱动 

②鼠标左键

单击删除此

配置 

①鼠标右键

单击此项 

①单击选

择此项 

②双击此项 

③退出保存 
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此时 CCS 已经被设置成 Simulator 方式(软件仿真 TMS320F2812 器件的方式)，如果一

直使用这一方式就不需要重新进行以上设置操作了。 
 
 

2．设置 CCS 通过 ICETEK-5100USB 仿真器连接 ICETEK–F2812-A 硬件环境进行软件调

试和开发。 
(1) 单击桌面上图标：                                     

进入 CCS 设置窗口。 
 

(2) 在出现的窗口中按标号顺序进行如下设置： 
 

 
                       图 3.1.3  删除掉原有的驱动设置 

(3)在出现的窗口中按标号顺序进行如下设置： 

①鼠标右键

单击此项 

②鼠标左键

单击此项删

除配置 
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                  图 3.1.4  选择硬件仿真 F2812 芯片驱动 

 
(4) 接着在下面的窗口中按标号顺序进行如下选择： 

 
 

 
图 3.1.5 设置 gel 文件 

①单击

此项 

②单击

此项 

①右键

单击此

项 
 

②单击

此项 
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(5) 在出现的窗口按标号顺序进行如下设置： 
 

 
 

图 3.1.6 加入 gel 文件 
(6) 在出现的窗口按标号顺序进行如下设置： 

 
 

图 3.1.7 退出 ccs 设置界面 

单击此处选

择 gel 文件 

①选择此

f2812.gel 文
件 
 

②单击 ok 
③保存退出 
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(7)在出现的窗口中按标号顺序进行如下设置： 

 
图 3.1.8  保存退出 

以上设置完成后，CCS 已经被设置成 Emulator 的方式(用仿真器连接硬件板卡的方式)，
并且指定通过 ICETEK-5100USB 仿真器连接 ICETEK–F2812-A 评估板。如果您需要一直

使用这一方式就不需要重新进行以上设置操作了。 
 

五．启动 CCS  
1． 启动 Simulator 方式 （请确认已按照上面说明设置为软仿真方式了。）                     

设置好软仿真驱动后，双击桌面上图标：     
2． 启动 Emulator 方式                                   
(1) 首先将实验箱电源关闭。连接实验箱的外接电源线。 
(2) 检查 ICETEK-5100USB 仿真器的黑色 JTAG 插头是否正确连接到 ICETEK–F2812-A

评估板的 P5 插头上。注：仿真器的插头中有一个孔加入了封针，与 P5 插头上的缺针

位置应重合，保证不会插错。 
(3) 检查是否已经用电源连接线连接了 ICETEK–F2812-A 评估板上的 POW1 插座和实验

箱底板上+5V 电源插座。 
   注：新改良的实验箱都不需要额外插电源连接线了。 
(4) 检查其他连线是否符合实验要求。检查实验箱上三个拨动开关位置是否符合实验要求。 
(5) 打开实验箱上电源开关(位于实验箱底板左上角)，注意开关边上红色指示灯点亮。

ICETEK–F2812-A评估板上指示灯VCC点亮。如果打开了 ICETEK-CTR的电源开关，

ICETEK-CTR 板上指示灯 POWER 点亮。如果打开了信号源电源开关，相应开关边的

指示灯点亮。 
(6) 用实验箱附带的 USB 信号线连接 ICETEK-5100USB 仿真器和 PC 机后面的 USB 插座，

注意 ICETEK-5100USB 仿真器上指示灯 Power 和 Run 灯点亮。 

选“否” 
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(7) 双击桌面上仿真器初始化图标：  
如果出现下面提示窗口，表示初始化成功，按一下空格键进入下一步操作。 

 
图 3.1.9  仿真器复位 

如果窗口中没有出现“按任意键继续…”，请关闭窗口，关闭实验箱电源，再将 USB
电缆从仿真器上拔出，返回第(2)步重试。 

如果窗口中出现“The adapter returned an error.”，并提示“按任意键继续…”，表示

初始化失败，请关闭窗口重试两三次，如果仍然不能初始化则关闭实验箱电源，再将

USB 电缆从仿真器上拔出，返回第(2)步重试。 
 
 
 

⑻ 双击桌面上图标： 
启动 CCS3. 3。 

 
⑼ 如果进入 CCS 提示错误，先选“Abort”，然后用“emurst”初始化仿真器，如提示

出错，可多做几次。如仍然出错，拔掉仿真器上 USB 接头(白色方形)，按一下 ICETEK
–F2812-A 评估板上 S1 复位按钮，连接 USB 接头，再做“快捷方式 xdsrstusb”。 

⑽ 如果遇到反复不能连接或复位仿真器、进入 CCS 报错，请打开 Windows 的“任务管理”，

在“进程”卡片上的“映像名称”栏中查找是否有“cc_app.exe”，将它结束再试。 

⑾  与 ccs 的以前版本（例如 ccs2.21 版本）不同的是，仅仅进入 ccs3.3 软件环境后，CCS
软件和 2812 芯片还无法连接在一起，如下图显示： 
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             图 3.1.10   未连接到 2812 芯片显示 

⑿  此时要按照如下图所示操作，才能把 ccs 软件和 2812 芯片连接在一起，然后才能对

2812 芯片进行控制。 

 
                       图 3.1.11  设置连接 2812 芯片 
⒀  如下图所示，我们就可以确认 CCS 软件和 2812 芯片连接在一起了。 

单击此项进

行连接 
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                        图 3.1.12   成功连接上 2812 板卡 

六．退出 CCS 

 
图 3.1.13 退出 ccs 软件 

单击此项退出 

或单击此

项退出 
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第二章  实验手册 
 

一．CCS 软件应用实验 
 

实验 1.1：Code Composer Studio 入门 
 

一．实验目的 
1．掌握 Code Composer Studio 3.3 的安装和配置步骤过程。 
2．了解 DSP 开发系统和计算机与目标系统的连接方法。 
3．了解 Code Composer Studio 3.3 软件的操作环境和基本功能，了解 TMS320C28xx 软件 

开发过程。 
(1)学习创建工程和管理工程的方法。 
(2)了解基本的编译和调试功能。 
(3)学习使用观察窗口。 
(4)了解图形功能的使用。 

 
二．实验设备 

1．PC 兼容机一台；操作系统为 Windows2000 (或 WindowsNT、Windows98、WindowsXP， 
以下假定操作系统为 Windows2000)。Windows 操作系统的内核如果是 NT 的应安装相应的补

丁程序（如：Windows2000 为 Service Pack3，WindowsXP 为 Service Pack1）。 
2．ICETEK-F2812-A 实验箱一台。如无实验箱则配备 ICETEK-ICETEK-USB 仿真器或 

ICETEK-ICETEK-PP 仿真器和 ICETEK–F2812-A 评估板，+5V 电源一只。 
3．USB 连接电缆一条(如使用 PP 型仿真器换用并口电缆一条)。 

 
三．实验原理 

*开发 TMS320C5xxx 应用系统一般需要以下几个调试工具来完成： 
-软件集成开发环境(Code Composer Studio 3.3)：完成系统的软件开发，进行软件和硬件

仿真调试。它也是硬件调试的辅助手段。 
-开发系统(ICETEK 5100 USB 或 ICETEK 5100 PP)：实现硬件仿真调试时与硬件系统的

通信，控制和读取硬件系统的状态和数据。 
-评估模块(ICETEK F2812-A 等)：提供软件运行和调试的平台和用户系统开发的参照。 

*Code Composer Studio 3.3 主要完成系统的软件开发和调试。它提供一整套的程序编制、维

护、编译、调试环境，能将汇编语言和 C 语言程序编译连接生成 COFF (公共目标文件)格
式的可执行文件，并能将程序下载到目标 DSP 上运行调试。 

*用户系统的软件部分可以由 CCS 建立的工程文件进行管理，工程一般包含以下几种文件： 
-源程序文件：C 语言或汇编语言文件(*.ASM 或*.C) 
-头文件(*.H) 
-命令文件(*.CMD) 
-库文件(*.LIB,*.OBJ) 

 
四．实验步骤 

1．实验准备 
由于本实验采用软仿真模式，不要打开实验箱电源。 

Administrator
线条

Administrator
矩形
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2．设置 Code Composer Studio 3.3 在软仿真(Simulator)方式下运行 
 
请参看本书第三部分、第一章、四、1。 

3．启动 Code Composer Studio 3.3 
请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 
成功地启动了 CCS 后会出现如下窗口： 
注：下面窗口是打开了所有 CCS 软件功能后显示的。 
 
 
 

 
图 3.2.1.1 CCS 软件界面介绍

标题区，标明 CCS
启动方式 菜单条 

编译工具条

编辑工具条 

调试工具条 

工程管理 
窗口 

 

工作区，用户 
文件管理 

工作区中 C
源程序编

辑窗口 

工作区中

反汇编调

试窗口 

工作区中数

据显示窗口 

工作区中图

形显示窗口 

编译运行结

果信息窗口 
 

工作区中图

象显示窗口 

工作区中

BIOS 设置 
窗口 

变量观察 
窗口 
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实际上打开的 CCS 界面没有上图所示的那么多内容。 
原始的刚打开的 CCS 界面包含如下图的基本元素： 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

图 3.2.1.2 
 

图中的其他部分都是在工作中根据需要打开的。而且图像和图形显示窗口打开时，还要做

一些相关的参数设置才能正常使用，具体的设置方法我们留到后面实验中应用时再详细说明。 
 
 

 
4．创建工程 

(1) 创建新的工程文件 
(2) 选择菜单“Project”的“New…”项。 

 

标题区，标明

CCS 启动方式 菜单条 编辑工具条

编译工具条 

调试工具条 

工程管理窗口 

工作区，用户文件管理 
（空） 
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图 3.2.1.3 创建工程文件 
 

如下图，按编号顺序操作建立 volume.pjt 工程文件： 
 

 
                      

图 3.2.1.4 新建工程 
 

展开主窗口左侧工程管理窗口中“Projects”下新建立的“volume.pjt”，其各项均为空。 
(2)在工程文件中添加程序文件： 

选择菜单“Project”的“Add Files to Project…”项；在“Add Files to Project”对话框 
中选择文件目录为 C:\ICETEK\F2812\DSP281x_examples\Lab0101-UseCCS，改变文件类型

为“C Source Files(*.c;*.ccc)”，选择显示出来的文件“volum.c”；重复上述各步骤，添加

C:\ICETEK\F2812\DSP281x_examples\Lab0101-UseCCS\volume.cmd 文件到 volum 工程中；

添加 C:\ CCStudio_v3.3\c2000\cgtools\lib \rts2800_ml.lib。 
(3)编译连接工程： 

选择菜单“Project”的“Rebuild All”项，或单击工具条 中的按钮；注意编

译过程中 CCS 主窗口下部“Build”提示窗中显示编译信息， 最后将给出错误和

警告的统计数。 
 

① 输入新建 
工程名 volume

②单击此按钮，选择工程所在目

录为 C:\ICETEK\F2812 
\DSP281x_examples\Lab0101-U
seCCS 

③单击完

成设置 



   REALTIME—DSP 系列应用丛书 

 
 
地址：北京市海淀区知春路 108 号豪景大厦 A 座 18 层                     http://www.realtimedsp.com.cn 
电话：010-62105690(中继)/91-97                                         传真：010-62105699   

46 

5．编辑修改工程中的文件 
(1)查看工程文件 

展开 CCS 主窗口左侧工程管理窗中的工程各分支，可以看到“volume.pjt”工程中包

含“volume.h”、“rts2800.lib”、“volume.c”和“volume.cmd”文件，其中第一个为程序在

编译时根据程序中的“include”语句自动加入的。 
(2)查看源文件 

*双击工程管理窗中的“volume.c”文件，可以查看程序内容。可以看到，用标准 C
语言编制的程序，大致分成几个功能块： 

-头文件。描述标准库程序的调用规则和用户自定义数据、函数头、数据类型等。具体

包含哪一个头文件，需要根据程序中使用了哪些函数或数据而定。比如：如果程序中

使用了 printf 函数，它是个标准 C 提供的输入/输出库函数，选中“printf”关键字，按

Shift+F1 会启动关于此关键字的帮助，在帮助信息中可发现其头函数为 stdio.h，那么

在此部分程序中需要增加一条语句：#include “stdio.h”。 
-工作变量定义。定义全局变量。 
-子程序调用规则。这部分描述用户编制的子程序的调用规则。也可以写到用户自己编 
制的.h 文件中去。 
-主程序。即 main()函数。它可分为两部分：变量定义和初始化部分、主循环部分。主 
循环部分完成程序的主要功能。 
-用户自定义函数。 
这个程序是一个音频信号采集、处理输出的程序。程序的主循环中调用自定义的函数

read_signals 来获得音频数据并存入输入缓存 inp_buffer 数组；再调用自定义函数

write_buffer 来处理音频数据并存入输出缓存；output_signals 将输出缓冲区的数据送输出设

备；最后调用标准 C 的显示信息的函数 printf 显示进度提示信息。整个系统可以完成将输

入的音频数据扩大 volume 倍后再输出的功能。 
read_signal 子程序中首先应有从外接 AD 设备获得音频数据的程序设计，但此例中由

于未采用实际 AD 设备，就未写相应控制程序。此例打算用读文件的方式获得数据，模拟

代替实际的 AD 输入信号数据。 
write_buffer 子程序中首先将输入缓冲区的数据进行放大处理，即乘以系数 volume，

然后放入输出缓冲区。 
output_signals 函数完成将处理后的设备输出的功能，由于此例未具体操作硬件输出设

备，所以函数中未写具体操作语句。 
*双击工程管理窗中的“volume.h”文件，打开此文件显示，可以看到其中有主程序中

要用到的一些宏定义如“BUF_SIZE”等。 
*volume.cmd 文件定义程序所放置的位置，此例中描述了 ICETEK–F2812-A 评估板

的存储器资源，指定了程序和数据在内存中的位置。 
比如：它首先将 ICETEK–F2812-A 评估板的可用存储器分为八个部分，每个区给定

起始地址和长度(区域地址空间不允许重叠)；然后指定经编译器编译后产生的各模块放到

哪个区。这些区域需要根据评估板硬件的具体情况来确定。 
(3)编辑修改源文件及编译程序 

打开“volume.c”，找到“main()”主函数，将语句“input=inp_buffer;”最后的分号去

掉，这样程序中就出现了一个语法错误；重新编译连接工程，可以发现编译信息窗口出现

发现错误的提示；双击红色错误提示，CCS 自动转到程序中出错的地方；将语句修改正确 
(将语句末尾的分号加上)；重新编译；注意，重新编译时修改过的文件被 CCS 自动保存。 
(4)修改工程文件的设置 
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                       图 3.2.1.5 修改工程文件 
 

通过以上设置操作，重新编译后，程序中的用户堆栈的尺寸被设置成 1024 个字。 
6．基本调试功能 

(1)下载程序：执行 File Load Program ,在随后打开的对话框中选择刚刚建立的

C:\ICETEK\F2812\DSP281x_examples\Lab0101-UseCCS\Debug\volume.out 文件。 
(2)设置软件调试断点：在项目浏览窗口中，双击 volume.c 激活这个文件，移动光标到 main()

行上，单击鼠标右键选择 Toggle Breakpoint 或按 F9 设置断点(另外，双击此行左边的灰

色控制条也可以设置或删除断点标记)。 
(3)利用断点调试程序：选 Debug Run 或按 F5 运行程序，程序会自动停在 main()函数上。 
①按 F10 执行到 write_buffer()函数。 
②再按 F11，程序将转到 write_buffer 函数中运行。 
③此时，为了返回主函数，按 shift-F11 完成 write_buffer 函数的执行。 
④再次执行到 write_buffer 一行，按 F10 执行程序，对比与 F11 执行的不同。 

提示：在执行 C 语言的程序时，为了快速的运行到主函数调试自己的代码，可以使用

Debug Go main 命令，上述实验中的使用的是较为繁琐的一种方法。 
7．使用观察窗口 

(1)执行 View Watch Window 打开观察窗口。 
(2)在 volume.c 中，用鼠标双击一个变量(比如 num)，再单击鼠标右键，选择“Quick Watch”， 

CCS 将打开 Quick Watch 窗口并显示选中的变量。 
(3)在 volume.c 中，选中变量 num，单击鼠标右键，选择“Add to Watch Window”，CCS 将

把变量添加到观察窗口并显示选中的变量值。 
(4)在观察窗口中双击变量，则弹出修改变量窗口。此时，可以在这个窗口中改变变量的值。 
(5)把 str 变量加到观察窗口中,点击变量左边的”+”,观察窗口可以展开结构变量,并且显示结

构变量的每个元素的值。 
 

①选择菜单 

②选择菜

单项

③单击此卡片

④输入参数 

⑤单击完

成设置
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(6)把 str 变量加到观察窗口中；执行程序进入 write_buffer 函数，此时 num 变量超出了作

用范围，可以利用 Call Stack 窗口察看在其他函数中的变量： 
①选择菜单 View Call Stack 打开堆栈窗口。 
②双击堆栈窗口的 main()选项,此时可以察看 num 变量的值。 

8．文件输入/输出 
下面介绍如何从 PC 机上加载数据到 DSP 上。用于利用已知的数据流测试算法。 
在完成下面的操作以前，先介绍 Code Composer Studio 的 Probe（探针）断点，这种断点

允许用户在指定位置提取/注入数据。Probe 断点可以设置在程序的任何位置，.当程序运行到

Probe 断点时，与 Probe 断点相关的事件将会被触发，当事件结束后，程序会继续执行。在

这一节里，Probe 断点触发的事件是：从 PC 机存储的数据文件中的一段数据加载到 DSP 的

缓冲区中。 
(1)在真实的系统中，read_signals 函数用于读取 A/D 模块的数据并放到 DSP 缓冲区中。在

这里，代替 A/D 模块完成这个工作的是 Probe 断点。当执行到函数 read_signals 时，Probe
断点完成这个工作。 

①在程序行 read_signals(input);上单击鼠标右键选择“Toggle breakpoint”，设置软件断点。 
②再在同一行上单击鼠标右键，选择“Toggle Probe Point”，设置 Probe 断点。 

(2)执行以下操作 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
图 3.2.1.6 设置 file io 文件 

 
此时,已经配置好了 Probe 断点和与之关联的事件.进一步的结果在下面实验中显示。 

9．图形功能简介 
下面我们使用 CCS 的图形功能检验上一节的结果。首先进行下面设置操作： 

 

①选择菜单 

②选择菜单项

③单击选择数据文件：

C:\ICETEK\F2812 
\DSP281x_examples\Lab01
01-UseCCS\sine2.dat

④输入放 
置地址 

⑤输入读取

数据个数 

⑥单击复 
选此框

⑦单击设置

断点关联

⑧单击选中此项

⑩单击

此按钮 

⑨单击并选

择 sine2 dat
最后,单击此按

钮结束设置

最后,单击此

按钮结束设置
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图 3.2.1.7  设置图形显示功能 
 

-在弹出的图形窗口中单击鼠标右键，选择“Clear Display”。 
-按 Alt+F5 运行程序.观察 input 窗口的内容。 

10．选择菜单 File→workspace→save workspacs As…，输入文件名 SY.wks 。 
11．退出 CCS 。请参看本书第三部分、第一章、六。 
 

五．实验结果 
通过对工程文件“volume”的编译、执行后得到结果的图形显示如下： 
 

 
 

图 3.2.1.8 结果显示 
 
六.问题与思考 

①选择   
菜单 

②选择此

菜单项 

③修改 
名称 

④输入数据

起始地址 

 
 
⑤输入数

据个数 

⑥修改数

据类型 
⑦单击按钮

完成设置 
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实验 1.2：编写一个以 C 语言为基础的 DSP 程序 

 
一．实验目的 

1．学习用标准 C 语言编制程序；了解常用的 C 语言程序设计方法和组成部分。 

2．学习编制连接命令文件，并用来控制代码的连接。 

3．学会建立和改变 map 文件，以及利用它观察 DSP 内存使用情况的方法。 

4．熟悉使用软件仿真方式调试程序。 

 

二．实验设备 
PC 兼容机一台，操作系统为 Windows2000(或 Windows98，WindowsXP，以下默认为

Windows2000)，安装 Code Composer Studio 3.3 软件。 

 

三．实验原理 
1． 标准 C 语言程序 

CCS 支持使用标准 C 语言开发 DSP 应用程序。当使用标准 C 语言编制的程序时，其

源程序文件名的后缀应为.c(如：volume.c)。 

CCS 在编译标准 C 语言程序时，首先将其编译成相应汇编语言程序，再进一步编译成

目标 DSP 的可执行代码。最后生成的是 coff 格式的可下载到 DSP 中运行的文件，其文件

名后缀为.out。 

由于使用 C 语言编制程序，其中调用的标准 C 的库函数由专门的库提供，在编译连接

时编译系统还负责构建 C 运行环境。所以用户工程中需要注明使用 C 的支持库。 

2． 命令文件的作用 

命令文件(文件名后缀为 cmd)为链接程序提供程序和数据在具体 DSP 硬件中的位置分

配信息。通过编制命令文件，我们可以将某些特定的数据或程序按照我们的意图放置在

DSP 所管理的内存中。命令文件也为链接程序提供了 DSP 外扩存储器的描述。在程序中

使用 CMD 文件描述硬件存储区，可以只说明使用部分，但只要是说明的，必须和硬件匹

配，也就是只要说明的存储区必须是存在的和可用的。 

3． 内存映射(map)文件的作用 

一般地，我们设计、开发的 DSP 程序在调试好后，要固化到系统的 ROM 中。为了更

精确地使用 ROM 空间，我们就需要知道程序的大小和位置，通过建立目标程序的 map 文

件可以了解 DSP 代码的确切信息。当需要更改程序和数据的大小和位置时，就要适当修改

cmd 文件和源程序，再重新生成 map 文件来观察结果。另外，通过观察 map 文件，可以

掌握 DSP 存储器的使用和利用情况，以便进行存储器方面的优化工作。 
4．程序设计要求 
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程序框图： 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

四．实验步骤 
1．实验准备 

设置软件仿真模式，参看：第三部分、四、1。 
2．建立新的工程文件 

(1)双击桌面上图标， 
启动 Code Composer Studio 3.3。 
 
 
(2)进行以下设置： 

 
 

 
 

 
 

图 3.2.1.9 建立 CProgram.pjt 
 

数值运算

开设三个整

型变量 x,y,z

赋初值： 
x=1,y=2

计算 x+y

输出结果到 z

循环

①菜单项 
选择 

 

④点击完成

设置 

②输入 
工程名 

 

③点击选取目录 
C:\ICETEK\F2812 

\DSP281x_examples\Lab010
2-CProgram 
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3．编辑输入源程序 
(1)C 语言程序 

-先新建源程序窗口： 
-输入源程序： 
 

int x,y,z; 
main() 
{ 
 x=1; y=2; 
 while ( 1 ) 
{ 
 z=x+y; 
} 
} 

 

 
 

 
图 3.2.1.10 新建源文件 
 

 
-保存源程序为 CProgram.c： 

 

 
 
 
 
 
                                 图 3.2.1.11 保存为 c 文件 
 
 

(2)连接命令文件 
 

① 选择  
菜单项 
 

③输入 
文件名 

 

②选择存储目录为 
C:\ICETEK\F2812 
\DSP281x_examples\Lab010
2-CProgram 

④单击按 
钮保存 
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-如同第(1)步操作，建立空的源程序窗口。 
-输入连接命令文件内容： 

-l rts2800.lib 
-stack 400h 
-heap 100 
MEMORY 
{ 
   PAGE 0 : PROG(R)     : origin = 0x3E8000, length = 0x10000 
   PAGE 0 : BOOT(R)     : origin = 0x3FF000, length = 0xFC0    
   PAGE 0 : RESET(R)    : origin = 0x3FFFC0, length = 0x2 
   PAGE 0 : VECTORS(R)  : origin = 0x3FFFC2, length = 0x3E 
 
   PAGE 1 : M0RAM(RW)   : origin = 0x000000, length = 0x400 
   PAGE 1 : M1RAM(RW)   : origin = 0x000400, length = 0x400 
   PAGE 1 : L0L1RAM(RW) : origin = 0x008000, length = 0x2000 
   PAGE 1 : H0RAM(RW)   : origin = 0x3F8000, length = 0x2000 
} 
  
SECTIONS 
{ 
   /* 22-bit program sections */ 
   .reset   : > RESET,   PAGE = 0 
    vectors : > VECTORS, PAGE = 0 
   .pinit   : > PROG,    PAGE = 0 
  
  .cinit   : > PROG,    PAGE = 0 

 
   .text    : > PROG,    PAGE = 0 
 
   /* 16-Bit data sections */ 
   .const   : > L0L1RAM, PAGE = 1 
   .bss     : > L0L1RAM, PAGE = 1 
   .stack   : > M1RAM, PAGE = 1 
   .sysmem  : > M0RAM, PAGE = 1 
 
   /* 32-bit data sections */ 
   .ebss    : > H0RAM, PAGE = 1 
   .econst  : > H0RAM, PAGE = 1 
   .esysmem : > H0RAM, PAGE = 1 
}-l rts2800.lib 

-如同第(1)步操作，将文件存为：
C:\ICETEK\F2812\DSP281x_examples\Lab0102-CProgram \CProgram.cmd 

(3) 将上述编译的源程序加入工程 CProgram.pjt，具体操作可请参考实验一、四、4、(2)。 
4．编译源文件、下载可执行程序 

(1) 单击菜单“Project”、“Rebuild All”。 
(2) 执行 File Load Program ，在随后打开的对话框中选择刚刚建立的

C:\ICETEK\F2812\Lab0102-CProgram\debug\CProgram.out 文件。完成后，系统自动

打开一个反汇编窗口“Disassembly”，并在其中指示程序的入口地址为“_c_int00”。 
 
5．打开观察窗口 
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开启 CPU 寄存器观察窗口：单击菜单 View->Registers->Core。 
6．观察程序运行结果 

这时，在“Disassembly”代表程序运行位置的绿色箭头指向程序的入口地址，程序将

从此开始执行。 
(1) 选择菜单中 Debug->Go Main，CCS 自动打开 CProgram.c，程序会停在用户主程序入口

main 上，这从反汇编窗口和 CProgram.c 窗口中的指示箭头位置可以看出。 
(2) 在内存观察窗口中观察变量的值： 

选择“View”菜单中“Memory…”项，在“Memroy Window Options”窗口中的“Adress”
项中输入&x，单击“OK”完成设置；“Memory”窗口中 x 的当前取值显示在第 1 个

地址的后。 
(3) 将变量 x、y、z 分别加入观察窗口： 

在源程序中双击变量名，再单击鼠标右键，选择“Add to Watch Window”。这时，这 3 
个变量还未作初始化。 

(4) 单步运行 2 次，在观察窗中观察到变量 x、y 被赋值。变化的值被显示成红色。同时在

“Memory”窗口中也能观察到 x 和 y 值的改变。 
(5) 再单步运行，可观察到 z 的值被计算出来。双击观察窗口中变量 x、y 在“Value”栏中

的取值并修改成其他取值，单步运行后观察结果。 
(6) 双击观察窗口中变量 x、y 在“Value”栏中的取值，并修改成 0；选择菜单 Debug->Restart，

返回程序起点。 
(7) 重新单步运行程序，观察在 CPU 寄存器窗口中，各寄存器使用情况，观察哪个寄存器

参与了运算。 
7．内存映像文件 
(1) 选择菜单 Project->Build Options…，启动“Build Options”工程设置对话框。 
(2) 单击“Linker”属性页，在“Map Filename”项中观察生成的 map 文件名和路径。 
(3) 单击“取消”退出。 
8．对照观察 map 文件和 cmd 文件的内容 
(1) 选择菜单 File->Open…，将找到

C:\ICETEK\F2812\DSP281x_examples\Lab0102-CProgram \Debug 目录，将文件类型改

为“Memory Map Files”，选择 CProgram.map 文件、打开。 
(2) 打开 CProgram.cmd 文件。 
(3) 程序的入口地址：map 文件中“ENTRY POINT SYMBOL”中说明了程序入口地址

(_c_int00)。 
(4) 内存使用情况： 

-map 文件中“MEMORY CONFIGURATION”标明了程序占用 RAM 的使用情况，共

占用 aaH 个存储单元。 
-观察 map 文件中的“SECTION ALLOCATION MAP”段，可以看出 CProgram.obj 的
入口地址为 0x3e801e，这也是 main 函数的入口地址。 
-用户堆栈段从 400H 开始，程序运行到 main 函数中后，变量 x、y、z 均开设在栈中。 
-还能看出程序运行都需要调用 rts2800.lib 中的哪些模块。 

9．改变内存分配 
修改 cmd 文件中的 
PAGE 0 : PROG(R)     : origin = 0x3E8000, length = 0x10000  

改为 
PAGE 0 : PROG(R)     : origin = 0x3E9000, length = 0x10000  

 
重新编译工程，观察 map 文件中有何变化。 
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10．退出 CCS 
请参看本书第三部分、第一章、六。 

 
五．实验结果 

通过实验可以发现，修改 cmd 文件可以安排程序和数据在 DSP 内存资源中的分配和位置；

map 文件中描述了程序和数据所占用的实际尺寸和地址。 
C 语言编制的程序，在经过编译器编译后，需要连接若干 C 标准程序辅助运行。以下是运

行流程： 
1．程序入口为_c_int00，执行标准 C 库中的程序，负责初始化 C 环境、申请堆栈、初始化

有初始值的变量等。 
2．程序最终转到用户编制的主函数运行。 
3．程序在主函数中的无限循环中持续运行。 

 
六．问题与思考 

请修改程序完成计算 sin(2.3π)+cos(1.7π)的值。 
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实验 1.3：编写一个以汇编(ASM)语言为基础的 DSP 程序 

 
一. 实验目的 

1．学习用汇编语言编制程序；了解汇编语言程序与 C 语言程序的区别和在设置上的不同。 
2．了解 TMS320C28x 汇编语言程序结果和一些简单的汇编语句用法。 
3．学习在 CCS 环境中调试汇编代码。 

 
二. 实验设备 

PC 兼容机一台，操作系统为 Windows2000(或 Windows98，WindowsXP，以下默认为

Windows2000)，安装 Code Composer Studio 3.3 软件。 
 

三. 实验原理 
1． 汇编语言程序 

汇编语言程序除了程序中必须使用汇编语句之外，其编译选项的设置与 C 语言编制的

程序也稍有不同。其区别为： 
(1)汇编语言程序在执行时直接从用户指定入口开始，常见的入口标号为“start”，而 C 语

言程序在执行时，先要调用 C 标准库中的初始化程序(入口标号为“_c_init00”)，完成

设置之后，才转入用户的主程序 main()运行。 
(2)由于 CCS 的代码链接器默认支持 C 语言，在编制汇编语言程序时，需要设置链接参数，

选择非自动初始化，注明汇编程序的入口地址。 
2．程序设计要求 

程序框图： 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

四．实验步骤 
1．实验准备 

设置软件仿真模式，参看：第三部分、四、1。 

数值运算 

开设三个整

型变量 x,y,z

赋初值： 
x=1,y=2 

计算 x+y 

输出结果到 z

循环 
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2．建立新的工程文件 
(1)双击桌面上图标， 
启动 Code Composer Studio 3.3。 

(2)进行以下设置： 
 
 

 

 
 

图 3.2.1.12  建立 TASM.pjt。 
 

1． 设置工程文件 
 
 

                      
                           

图 3.2.1.13  设置工程文件 

①菜单项 
选择 

②输入工程

名 TASM 

③点击选取目录 
C:\ICETEK\F2812 
\DSP281x_examples\lab01
03-Asm 

④点击完成

设置 

(1).先选择

这一项 

(2).选择 no 
Autoinitiali
zation 一项 

(3).输入程

序入口地

址：start

(4).点击 
确定。 
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4．编辑输入源程序 
(1)汇编语言程序 
 

- 
 
 

图 3.2.1.14  新建源文件 
 

先新建源程序窗口： 
-输入源程序： 
    .global start 
     
start: 
    MOV      @AR1,#9000 ;给 ar1 寄存器赋值 
LOOP: 
    ADDB      SP,#3      ;此时 sp 指针为 403h 地址 
    MOV      *-SP[1],#10  ;把立即数 10 放到 402 地址上 
    MOV      *-SP[2],#1   ;把立即数 1 放到 401 地址上 
    MOV      AL,*-SP[2]  ;把 401 地址上数据读出放到 AL 寄存器中 
    ADD      AL,*-SP[1]  ;把 401 和 402 地址中数据做加法运算，把结果放到 AL 寄

存器中 
    MOV      *-SP[3],AL  ;把 AL 中值放到 400h 地址中 
    nop                   ;空指令 
    nop 
    SUBB      SP,#3      ;设置 sp 指针为 400h 地址 
    BANZ    LOOP,AR1--  ;有条件跳转，只要 ar1 中的值不为 0 
.end      
注意：在输入汇编语言源程序时，除了标号以外的程序行必须以一个空格或退格字符开始。 
 
-保存源程序为 TASM.asm。 

(2)连接命令文件 
-如同第(1)步操作，建立空的源程序窗口。 
-输入连接命令文件内容： 
-stack 400h 
-heap 100 
MEMORY 
{ 
   PAGE 0 : PROG(R)     : origin = 0x80000, length = 0x10000 
   PAGE 0 : BOOT(R)     : origin = 0x3FF000, length = 0xFC0    
   PAGE 0 : RESET(R)    : origin = 0x3FFFC0, length = 0x2 
   PAGE 0 : VECTORS(R)  : origin = 0x3FFFC2, length = 0x3E 

②选择 
菜单项 ①选择菜单
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   PAGE 1 : M0RAM(RW)   : origin = 0x000000, length = 0x400 
   

 PAGE 1 : M1RAM(RW)   : origin = 0x000400, length = 0x400 
   PAGE 1 : L0L1RAM(RW) : origin = 0x008000, length = 0x2000 
   PAGE 1 : H0RAM(RW)   : origin = 0x3F8000, length = 0x2000 
} 
  
SECTIONS 
{ 
   /* 22-bit program sections */ 
   .reset   : > RESET,   PAGE = 0 
    vectors : > VECTORS, PAGE = 0 
   .pinit   : > PROG,    PAGE = 0 
   .cinit   : > PROG,    PAGE = 0 
   .text    : > PROG,    PAGE = 0 
 
   /* 16-Bit data sections */ 
   .const   : > L0L1RAM, PAGE = 1 
   .bss     : > L0L1RAM, PAGE = 1 
   .stack   : > M1RAM, PAGE = 1 
   .sysmem  : > M0RAM, PAGE = 1 
 
   /* 32-bit data sections */ 
   .ebss    : > H0RAM, PAGE = 1 
   .econst  : > H0RAM, PAGE = 1 
   .esysmem : > H0RAM, PAGE = 1 
} 
-将文件存为 C:\ICETEK\F2812\DSP281x_examples\lab0103-Asm\TASM.cmd 

(3)将上述编译的源程序加入工程 TASM.pjt，具体操作可请参考实验一、四、4、(2)。 
  注意：默认新建工程为 c 语言的环境，由于本实验的主程序为汇编语言，所以我们要 

把它设置为汇编模式才能正常工作。在前面设置工程文件步骤中有说明。 

 

5．编译源文件、下载可执行程序 
(1)选择菜单 Project->Rebuild All。 
(2)执行 File Load Program，在随后打开的对话框中选择刚刚建立的

C:\ICETEK\F2812\DSP281x_examples\lab0103-Asm\debug\TASM.out 文件。完成后，系统

自动打开 TASM.asm 源程序窗口，并在其中指示程序的入口地址为标号“start”后的语

句。 
6．打开观察窗口 
(1)选择菜单 View->Disassembly。注意程序运行指针停留的位置。 
(2)开启 CPU 寄存器观察窗口：单击菜单 View->Registers-> core。请看 PC 指针取值与当前

程序运行地址对应。此处为 0x80000。 
(3)单击菜单 View->Registers->Pseudo。请看 AL 寄存器，此时应为 0。如果 AL 寄存器的值

不为 0，请点击 Debug->Reset  Cpu, 对 2812 芯片进行复位。 
(4)开启内存观察窗口： 

选择“View”菜单中“Memory…”项，在“Memroy Window Options”窗口中的“Adress” 
项中输入 0x400，单击“OK”完成设置。 

7．观察程序运行结果 
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(1)单步运行 1 次（按 F10 快捷键即可），在观察窗中观察到 AR1 寄存器被赋值 0x9000。 
 
(2)再单步运行 3 次，将看到内存窗口中 0x402 被赋值 0x10，0x401 地址被赋值 0x1。 
(3)再单步运行 3 次，可观察 0x400 地址中的值变为 0xb，此数据就是把 0x402 和 0x401 地

址中数据相加得到的。 
可以修改下面两句语句的立即数值，重新编译，然后单步运行观察结果。 

MOV      *-SP[1],#10 ;把立即数 10 放到 402 地址上 
    MOV      *-SP[2],#1  ;把立即数 1 放到 401 地址上 

8．对照观察 map 文件和 cmd 文件的内容 
(1)选择菜单 File->Open…，将找到 

C:\ICETEK\F2812\DSP281x_examples\lab0103-Asm\Debug 目录，将文件类型改为

“Memory Map Files”，选择 TASM.map 文件、打开。 
(2)打开 TASM.cmd 文件。 
()程序的入口地址：map 文件中“ENTRY POINT SYMBOL”中说明了程序入口地址(start)。 
(4)内存使用情况： 

-map 文件中“MEMORY CONFIGURATION”标明了程序占用 RAM 的使用情况，共占

用 fH 个存储单元。比较一下，这比用 C 编制的程序占用的要小得多。 
-观察 map 文件中的“SECTION ALLOCATION MAP”段，可以看出 TASM.obj 的入口

地址为 80000H，这也是程序的入口地址。 
9．退出 CCS 

请参看本书第三部分、第一章、六。 
 

五．实验结果 
汇编语言程序可以从指定位置开始运行，但汇编程序需要完成对运行环境的初始化工作。

实验中的程序有堆栈操作，所以初始化堆栈指针，这在编制大型应用程序中是必须要的功能。 
 

六．问题与思考 
请修改程序完成 0f000h+0e000h 的计算。 
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实验 1.4：编写一个汇编和 C 混合的 DSP 程序 

 
一.实验目的 

1.在了解纯 C 语言程序工程和汇编语言程序工程结构的基础上，学习在 C 工程中加入汇编

编程的混合编程方法。 
2.了解混合编程的注意事项。 
3.理解混合编程的必要性和在什么情况下要采用混合编程。 

 
二.实验设备 

计算机，ICETEK-F2812-A 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 系统板+相关连

线及电源）。 
 

三.实验原理 
1. 使用 C 语言开发应用程序的优缺点 

*优点： 
-易于开发和维护。由于用 C 语言书写接近自然语言，其可读性强、利于理解，在编

制、修改、实现算法方面比用汇编语言开发容易。 
-可移植性强。 
-不容易发生流水线冲突。编译器能提供完善的解决流水线冲突的结果。 
-有大量现存的算法可利用。 
-适用于人机界面的开发。 

*缺点： 
-代码量大。 
-程序效率较低。 
-优化代码存在一定困难。 

综上所述，我们一般用 C 语言设计应用程序的总体框架、解决人机接口和对速度效率要

求不太高的复杂算法。 
2. 使用汇编语言开发应用程序的优缺点 

*优点： 
-更能发挥系统特点。由于汇编语言掌控系统硬件的能力强于 C 语言，设计出来的程

序更加贴近硬件特性，往往能将硬件效能发挥到极致。 
-代码精练，效率高。用汇编语言设计的程序，代码短、不容易产生冗余。 
-代码量小。 

*缺点： 
-可读性差。不利于复杂算法的开发和实现。 
-可移植性差。 
-容易产生流水线冲突。由于排除冲突需要靠人来辅助完成，这要求编程人员有较为

丰富的开发经验和对硬件工作机制的深刻理解。 
3. 如何混合编程 

(1)混合工程：在工程中可以同时包含 C 语言程序和汇编语言程序，无需更改编译选项。一

般地，我们使用 C 程序为主，加入汇编语言程序模块。 
(2)使用模块技术：在应用程序中划分出比较清晰的模块，不同模块可采用不同语言设计。

强调效率和速度的模块采用汇编设计。尽量少用汇编语言设计程序。 
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(3)如何找出需要用汇编程序设计的模块： 

-用 C 语言完成设计后，运用 CCS 的软件仿真功能，充分测试程序，找到程序运行中的

瓶颈(速度方面的和空间方面的)。 
-再使用分块仿真技术尽可能缩小模块。 
-找到的模块单独写成子程序，存入独立的文件中。 
-由于 CCS 编译器能产生 C 语言程序到汇编程序的中间文件，观察需要优化的模块的汇

编结果，进行人工优化。 
-最后运用人工优化后形成的汇编程序模块，代替原来需要优化的 C 语言模块，进行编

译。 
-程序中可使用内嵌汇编。比如：asm(“ MOV T1, *SP(#1)”); 编译器可直接使用内嵌的汇

编语句生成最终代码。但需要语句中双引号中为合法的汇编语句，比如要以空格开头等

等。 
4．何时使用混合编程技术 

-当程序中需要操作与硬件密切相关的设备，而用 C 语言较难实现时。比如：在中断程

序设计时需要设置中断向量表，向量表中空间有限用 C 语言语句有困难，且需向量表

要在内存中精确定位，这时可将设置中断向量表的部分用汇编语言代替。 
-当需要绕开 C 编译器的规定，进行特殊操作时。比如：C 语言规定，程序不能访问程

序代码区，而系统功能需要进行类似访问时可采用限制较小的汇编语言程序设计。 
-当需要提高模块的效率(包括空间上和时间上两方面的)，而 C 语言程序无法达到要求时。 

5．使用混合编程时的注意事项 
-在汇编程序中使用其他 C 语言模块中定义的变量或函数名称时，需要在引用的名称前

加一下划线。如：C 中定义的变量为 x，在汇编中引用时要用_x。 
-汇编语言写的子程序需要符合 C 语言的调用规则，尤其是在默认的辅助寄存器使用上

和栈的使用上要求兼容。 
-在汇编语言模块中，需要编程者自己消除流水线冲突。 
-在使用内嵌汇编技术时，需要考虑以下内容： 
a. 要非常小心地处理，以免破坏 C 语言操作环境。编译器在遇到内嵌汇编语句时，不会 

对其中的汇编语句进行分析处理。 
b.避免从内嵌汇编语句跳转到 C 语言模块中，那将极容易造成寄存器使用上的混乱，从

而产生难以预料的结果。 
c.不要在内嵌汇编语句中改变 C 语言模块中变量的值，但可以安全地读取它们的值。 
d.在汇编程序中不要使用内嵌汇编。 

6．实验程序解释 
实验程序提供了一个使用 C 与汇编程序混合编程的实例，是一个用汇编语言模块优化

自己编制的应用程序的实例。 
首先用户拿到的是一个纯用 C 语言开发的工程，再根据假设，需要将其中一个模块改

造成用汇编语言模块优化的模块。通过实验过程，用户可充分了解混合编程可以采取的步

骤和方法。 
 

四.实验步骤 
1．实验准备 

-设置软件仿真模式，参看：第三部分、四、1。 
-启动 CCS，参看：第三部分、五、1。 

2．打开工程、浏览程序内容、编译生成和下载可执行代码、 
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(1)打开工程：选择菜单 Project->Open…，选择打开工程文件

C:\ICETEK\F2812\DSP281x_examples\lab0104-CAsm\CASM.pjt 
(2)展开工程管理窗口中 CASM 工程，双击 Source 下的 CProgram.c 项，打开 CProgram.c
源程序窗口。可以看到，程序完成了一个简单的运算，它先开设了三个全局变量 x、y、
z，然后分别给 x 和 y 赋初值，再在循环中计算 x+y，结果赋值给 z。 

(3)编译并下载程序： 
 
 
 
 

 

 
                  

图 3.2.1.15 设置自动下载 out 文件 
 

此设置完成在每次编译完成后将程序自动下载到 DSP 上。 
选择菜单 Project->Build All，编译、连接和下载程序。 

(4)运行程序，观察结果：在程序中有“在此加软件断点”注释的语句上加软件断点；将变

量 z 加入变量观察窗口（watch window）；运行程序到断点，观察变量 z 的结果值。 
3．修改程序 
(1)修改算法部分成单独子程序：我们假设在循环中进行的运算是需要用汇编语言程序模块

优化的部分。首先将“z=x+y;”语句修改成“z=add(x,y);”，在程序头上，变量定义之前

加上一行“int add(int a,int b);”，在程序末尾，添加如下子程序。 
int add(int a,int b) 
{ 
 return(a+b); 
} 

如此，将算法搬移到一个 C 语言的子程序模块中实现。 
修改完成后，可以编译、下载、运行到断点，观察运行结果，判断是否子程序能完全与

原程序一样完成算法。 

①选择

菜单项

②单击

此属性

③加复

选标记

④结束

设置
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(2)将子程序移入 add.c：打开一个新的空的源文件窗口，将 main 函数后的子程序复制到窗

口中；注释 main 函数后面的子程序(在子程序前一行加“/*”，在子程序结尾行后加“*/”)；
将新窗口中的内容保存为文件 add.c。 

(3)将 add.c 加入工程，编译、下载、运行，检查结果，保证运算无误。 
(4)选择菜单 Project->Build Options…，进行如下设置： 
 

 
 
图 3.2.1.16 参数设置 
 

(5)重新编译工程；打开 C:\ICETEK\F2812\DSP281x_examples\lab0104-CAsm\add.asm；在其

中的“.line 2”行、“.line3”行、“.line 4”行头上分别加分号，即注释这 3 个语句。 
(6)将工程中的 add.c 换成 add.asm：在工程管理窗口中用鼠标右键单击 add.c，选择“Remove 

from Project”；用鼠标右键单击 CASM.pjt，选择“Add Files to Project…”，选择

C:\ICETEK\F2812\DSP281x_examples\lab0104-CAsm\add.asm。 
(7)重新编译、下载、运行程序并观察结果。由于 add.asm 是 CCS 编译器从 add.c 编译得来

的，下面要做的就是手工调整 add.asm 中的汇编代码，从而实现优化处理。 
4．退出 CCS 

请参看本书第三部分、第一章、六。 
 

五．实验结果 
使用混合程序编程，在可以完全实现原来算法的同时，可以优化关键的算法模块。 
 

六．问题与思考 

①选择此

项 

②增加复

选标记

③设置完

成退出
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二．基于 DSP 芯片的实验 

 
实验 2.1： DSP 数据存取实验 

 
一.实验目的 

1.了解 TMS320F2812A 的内部存储器空间的分配及指令寻址方式。 
2.了解 ICETEK–F2812-A 评估板扩展存储器空间寻址方法，及其应用。 
3.了解 ICETEK-F2812-A 实验箱扩展存储器空间寻址方法，及其应用。 
4.学习用 Code Composer Studio 修改、填充 DSP 内存单元的方法。 
5.学习操作 TMS32028xx 内存空间的指令。 

 
二.实验设备 

计算机，ICETEK–F2812-A 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 评估板+相关

连线及电源）。 
 

三.实验原理 
TMS32028xx DSP 内部存储器资源介绍： 
TMS32028xx 系列 DSP 基于增强的哈佛结构，可以通过三组并行总线访问多个存储空间。

它们分别是：程序地址总线（PAB）、数据读地址总线（DRAB）和数据写地址总线（DWAB）。
由于总线工作是独立的，所以可以同时访问程序和数据空间。 

TMS32028xx系列DSP的地址映象请参考 ICETEK–F2812-A评估板硬件使用指导部分 I－4
页的介绍。 

 
四.实验步骤 

1．实验准备 
连接实验设备：请参看本书第三部分、第一章、二。 
关闭实验箱上扩展模块和信号源电源开关。 

2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 
请参看本书第三部分、第一章、四、2。 

3．启动 Code Composer Studio 3.3 
请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

4．打开工程文件 
工程文件为： 
C:\ICETEK\F2812\DSP281x_examples\ Lab0201-Memory\Memory.pjt 

5．编译、下载程序。 
6．程序区的观察和修改 
(1)运行到 main 函数入口：选择菜单 Debug->Go Main，当程序运行并停止在 main 函数入

口时，展开“Disassembly”反汇编窗口，发现 main 函数入口地址为 81000H，也就是

说从此地址开始存放主函数的程序代码。 
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(2)显示程序区： 
 

 
               

图 3.2.2.1  显示程序区 
(3)修改程序区的存储单元 

程序区单元的内容由 CCS 的下载功能填充，但也能用手动方式修改；双击“Code”
窗口地址“0x81000:”后的第一个数，显示“Edit Memory”窗口，在“Data”中输入 0x20，
修改 page：为 program，单击“Done”按钮，观察“Code”窗口中相应地址的数据被修

改，同时在反汇编窗口中的反汇编语句也发生了变化，当前语句被改成了“TRAP #0”。
将地址 0x81000 上的数据改回 0xfe08，程序又恢复成原样。 

(4)观察修改数据区 
① 显示数据存储区： 

 
 

 
 
图 3.2.2.2  显示数据存储器 

①选择 
菜单项 

②修改窗 
口名称 ③输入十六

进制地址 

④修改打开

程序空间 

⑤完成设置

①选择 
菜单项 

②修改窗 
口名称 ③输入十六

进制地址 

④修改打开

数据空间 

⑤完成设置
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同样请打开窗口 Data1，起始地址在 0x80100。 

②修改数据单元：数据单元可以单个进行修改，只需双击想要改变的数据单元即可，如

同第(3)步中修改程序区单元的操作相同。 
③填充数据单元： 
 
 
 
 

 
 
 
 
 
 
 
 
 

                       
图 3.2.2.3  观察 DATA 数据 
 
 

观察“Data”窗口中的变化。请同样将 0x80100 开始的头 16 个单元的值用 0 填充。 
7．运行程序观察结果 

(1)打开 Memory.c，在有注释的行上加软件断点。 
(2)按“F5”键运行到各断点，注意观察窗口“Data”和“Data1”中的变化，体会用程序

修改数据区语句的方法。 
8．退出 CCS 

请参看本书第三部分、第一章、六。 
 

五.实验结果 
实验程序运行之后，位于数据区地址 80000H 开始的 16 个单元的数值被复制到了数据区

80100H 开始的 16 个单元中。 
*通过改写内存单元的方式，我们可以手工设置 DSP 的一些状态位，从而改变 DSP 工作

的状态。 
 

六.问题与思考 

①选择 
菜单项 

②输入十六

进制地址 

③输入填

充个数 16 ④输入所

填数字 

⑤完成 
设置 
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三．基于 DSP 系统的实验 
 

实验 3.1：指示灯实验 
 

一．实验目的 
1．了解 ICETEK–F2812-A 评估板在 TMS320F2812DSP 外部扩展存储空间上的扩展。 
2．了解 ICETEK–F2812-A 评估板上指示灯扩展原理。 
2． 学习在 C 语言中使用扩展的控制寄存器的方法。 

 
二．实验设备 

计算机，ICETEK-F2812-A 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 系统板+相关连

线及电源）。 
 

三．实验原理 
1．TMS320F2812DSP 的存储器扩展接口 

存储器扩展接口是 DSP 扩展片外资源的主要接口，它提供了一组控制信号和地址、数

据线，可以扩展各类存储器和存储器、寄存器映射的外设。 
-ICETEK–F2812-A评估板在扩展接口上除了扩展了片外 SRAM 外，还扩展了指示灯、

DIP 开关和 D/A 设备。具体扩展地址如下： 
C0002-C0003h： D/A 转换控制寄存器 
C0001h： 板上 DIP 开关控制寄存器 
C0000h： 板上指示灯控制寄存器 
详细说明见第一部分 表 1.7。 
-与 ICETEK–F2812-A评估板连接的 ICETEK-CTR显示控制模块也使用扩展空间控制

主要设备： 
108000-108004h： 读-键盘扫描值，写-液晶控制寄存器 
108002-108002h： 液晶辅助控制寄存器 
108003-108004h： 液晶显示数据寄存器 
 

2．指示灯扩展原理 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
                             

 图 3.2.3.1  指示灯扩展原理 
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3．实验程序流程图 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
四．实验步骤 

1．实验准备 
连接实验设备：请参看本书第三部分、第一章、二。 
关闭实验箱上扩展模块和信号源电源开关。 

2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 
请参看本书第三部分、第一章、四、2。 

3．启动 Code Composer Studio 3.3 
请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

4．打开工程文件 
工程文件为：C:\ICETEK\F2812\DSP281x_examples\Lab0301-LED\LED.pjt 
打开源程序 LED.c 阅读程序，理解程序内容。 

5．编译、下载程序。 
6．运行程序，观察结果。 
7．退出 CCS 

请参看本书第三部分、第一章、六。 
 

五．实验结果 
*可知：映射在扩展存储器空间地址上的指示灯寄存器在设置时是低 4位有效的，数据的

最低位对应指示灯 D1，次低位对应 D2，...依次类推。 

 

六．问题与思考 
ICETEK–F2812-A 评估板上的指示灯控制寄存器是可读可写的，请问用什么办法可以回

读指示灯状态？ 
 
 

 

开始 

初始化 DSP 时钟 

反向顺序送控制字并延时  

正向顺序送控制字并延时  
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实验 3.2：拨码开关控制实验 

 
一．实验目的 

1．了解 ICETEK–F2812-A 评估板在 TMS320F2812DSP 外部扩展存储空间上的扩展。 
2．了解 ICETEK–F2812-A 评估板上拨码开关扩展原理。 
3．熟悉在 C 语言中使用扩展的控制寄存器的方法。 

二．实验设备 
计算机，ICETEK-F2812-A 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 系统板+相关连

线及电源）。 
三．实验原理 

1．TMS320F2812DSP 的存储器扩展接口 
存储器扩展接口是 DSP 扩展片外资源的主要接口，它提供了一组控制信号和地址、数

据线，可以扩展各类存储器和存储器、寄存器映射的外设。 
-ICETEK–F2812-A 评估板在扩展接口上除了扩展了片外 SRAM 外，还扩展了指示灯、DIP
开关和 D/A 设备。具体扩展地址如下： 

C0002-C0003h： D/A 转换控制寄存器 
C0001h： 板上 DIP 开关控制寄存器 
C0000h： 板上指示灯控制寄存器 
详细说明见表 1.7。 
-与 ICETEK–F2812-A评估板连接的 ICETEK-CTR显示控制模块也使用扩展空间控制主要设

备： 
108000-108004h： 读-键盘扫描值，写-液晶控制寄存器 
108002-108002h： 液晶辅助控制寄存器 
108003-108004h： 液晶显示数据寄存器 
 
 

2．拨码开关扩展原理 
 

  
 

图 3.2.3.2 拨码开关扩展原理 
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3．实验程序流程图 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
四．实验步骤 

1．实验准备 
连接实验设备：请参看本书第三部分、第一章、二。 
关闭实验箱上扩展模块和信号源电源开关。 

2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 
请参看本书第三部分、第一章、四、2。 

3．启动 Code Composer Studio 3.3 
请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

4．打开工程文件 
工程文件为：C:\ICETEK\F2812\DSP281x_examples\Lab0302-DIP\DIP.pjt 
打开源程序 DIP.c 阅读程序，理解程序内容。 

5．编译、下载程序。 
6．运行程序，观察结果。 
7．拨动拨码开关的各位，观察指示灯 DS1-DS4 的显示。 
8．退出 CCS 

请参看本书第三部分、第一章、六。 
 
五．实验结果 

*可知：映射在扩展存储器空间地址上的拨码开关控制寄存器在回读时是低 4 位有效的，

数据的最低位对应拨码开关 1，次低位对应 2，...依次类推。 
 
六．问题与思考 

开始 

初始化 DSP 时钟 

读取拨码开关控制寄存器

并送指示灯控制寄存器 
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实验 3.3：DSP 的定时器 

 
一．实验目的 

1．通过实验熟悉 F2812A 的定时器； 

2．掌握 F2812A 定时器的控制方法； 

3．掌握 F2812A 的中断结构和对中断的处理流程； 

4．学会 C 语言中断程序设计，以及运用中断程序控制程序流程。 

 

二．实验设备 

计算机，ICETEK-F2812-A 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 系统板+相关连

线及电源）。 

 

三．实验原理 

1．通用定时器介绍及其控制方法（详见 spru078a.pdf） 

TMS320F2812A 内部有三个 32 位通用定时器（TIMER0/1/2），定时器 1 和 2 被保留给

实时操作系统（DSPBIOS）用，只有定时器 0 可以提供给用户使用。 

2．中断响应过程（详见 spru078a.pdf） 

    a．接受中断请求。必须由软件中断（从程序代码）或硬件中断（从一个引脚或一个基

于芯片的设备）提出请求去暂停当前主程序的执行。 

    b．响应中断。必须能够响应中断请求。如果中断是可屏蔽的，则必须满足一定的条件，

按照一定的顺序去执行。而对于非可屏蔽中断和软件中断，会立即作出响应。 

    c．准备执行中断服务程序并保存寄存器的值。 

    d．执行中断服务子程序。调用相应得中断服务程序 ISR，进入预先规定的向量地址，并

且执行已写好的 ISR。 

3．中断类别 

可屏蔽中断：这些中断可以用软件加以屏蔽或解除屏蔽。 

不可屏蔽中断：这些中断不能够被屏蔽，将立即响应该类中断并转入相应的子程序去执 

行。所有软件调用的中断都属于该类中断。 

4．中断的优先级 

如果多个中断被同时激发，将按照他们的中断优先级来提供服务。中断优先级是芯片

内部已定义好的，不可修改。
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4．实验程序流程图 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5．实验程序分析 
本实验设计的程序是在上实验 3.1 基础上修改得来，由于实验 3.1 控制指示灯闪烁的延

时控制是用循环计算方法得到的，延时不精确也不均匀，采用中断方式可以实现指示灯的定

时闪烁，时间更加准确。 
 
四．实验步骤 

1．实验准备 
连接实验设备：请参看本书第三部分、第一章、二。 
关闭实验箱上扩展模块和信号源电源开关。 

2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 
请参看本书第三部分、第一章、四、2。 

3．启动 Code Composer Studio 3.3 
请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

4．打开工程文件 
打开菜单“Project”的“Open”项；选择

C:\ICETEK\F2812\DSP281x_examples\Lab0303-Timer 目录中的“Timer.pjt”。 
在项目浏览器中，双击 time.c，激活 time.c 文件，浏览该文件的内容，理解各语句作

用。 
5．编译、下载程序。 
6．运行程序，观察结果。 

开始 

初始化 DSP 时钟 

初始化中断向量 

等待中断产生 

初始化定时器 

改变指示灯状态 

中断服务开始 

中断服务结束 
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7．改变“CpuTimer0Regs.PRD.all  = 0xffff;”函数里的值; 重复步骤 5，6 观察实验现象。 
8．退出 CCS 

请参看本书第三部分、第一章、六。 
 
五．实验结果 

-指示灯在定时器的定时中断中按照设计定时闪烁。 
-使用定时器和中断服务程序可以完成许多需要定时完成的任务，比如 DSP 定时启动 A/D
转换，日常生活中的计时器计数、空调的定时启动和关闭等。 
-在调试程序时，有时需要指示程序工作的状态，可以利用指示灯的闪烁来达到，指示灯灵

活的闪烁方式可表达多种状态信息。 
 

六．问题与思考 
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实验 3.4：外中断 

 
实验 3.4.1：外中断(V60 版) 

 
 
一．实验目的 

1．通过实验熟悉 F2812A 的中断响应过程。 
2．学会 C 语言中断程序设计，以及运用中断程序控制程序流程。 

 
二．实验设备 

计算机，ICETEK-F2812-A 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 系统板+相关连

线及电源）。 
 

三．实验原理 
1．中断及中断处理过程（详见 spru078a.pdf） 
(1)中断简介 

中断是一种由硬件或软件驱动的信号，DSP 在接到此信号时，将当前程序悬挂起来，

转向去执行另外一个任务，我们称为中断服务程序(ISR)。TMS320f28x  DSP 可支持 32 个

ISR，可由硬件或软件触发。 
所有 C28x 中断，可以分成可屏蔽中断和不可屏蔽中断两种，软件中断是不可屏蔽的。 

(2)DSP 处理中断的步骤 
①接收中断请求。请求由软件或硬件发出。 
②响应中断请求。对于可屏蔽中断，需要满足若干条件，才发生响应；而对于不可屏蔽

中断，则立即响应。 
③准备执行中断服务程序。 

-完成当前正在执行的指令；将进入流水线但还未解码的指令清除。 
-自动保存若干寄存器的值到数据堆栈和系统堆栈。 
-取得用户定义的中断向量表中当前中断向量，中断向量指向中断服务程序入口。 

④执行中断服务程序。中断服务程序包含中断返回指令，这样返回时可以出栈以前保存

的关键寄存器数据，从而恢复中断服务程序执行前的现场。 
(3)外中断 

TMS320f2812 可以响应两个外中断。 
2．ICETEK-CTR 板的键盘接口 

显示/控制模块 ICETEK-CTR 通过接口 P8 连接小键盘，接收小键盘传送的扫描码，并在

每个扫描码结束后保存，同时向 DSP 的 XINT2 发送中断信号；当 DSP 读键盘时将扫描码送

到数据总线上。小键盘上每次按下一个键将产生 2 个扫描码、2 次中断。 
3．程序编制 

由一个不含中断处理程序的工程通过改写加入中断处理程序部分大致需要如下操作(假
设使用 INT2)： 

(1)编制中断服务程序：可以用C语言程序实现(参见实验程序)，编写单独的一个函数XINT， 
此函数使用 interrupt 修饰，没有参数和返回值。 

(2)构造中断向量表：程序中“InitPieVectTable();”是初始化向量表， 
“PieVectTable.XINT2 = &XINT2_isr;”把中断服务程序和向量表该中断对应起来。 

(3)主程序中进行初始化设置：使能中断，清中断等。 
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4．实验程序流程图 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

四．实验步骤 
1．实验准备 
(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)将 ICETEK-CTR 板的供电电源开关拨动到“开”的位置。 
2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 

请参看本书第三部分、第一章、四、2。 
3．启动 Code Composer Studio 3.3：请参看本书第三部分、第一章、五、2。 

     选择菜单 Debug→Reset CPU。 
4．打开工程文件 

工程目录：C:\ICETEK\F2812\DSP281x_examples\Lab0304-Xint\V60\xint.pjt 
浏览 xint.c 文件的内容，理解各语句作用。 

5．编译、下载程序。 
6．运行程序，观察结果。 

运行程序，按一下小键盘上任意一个键，注意观察评估板上指示灯闪烁情况。 
7．观察中断函数的执行 

选择“Debug”菜单中“Halt”暂停运行程序，在 XINT2 中断程序中的语句上加软件断

点，重新运行程序(选择“Debug”菜单中“Run”)，观察何时程序停留在断点上。 
8．退出 CCS：请参看本书第三部分、第一章、六。 

 
五．实验结果 

通过实验可以发现，每次按下键盘均会发生两次中断，当按下键不放时会产生连续的中断；

只有在外中断发生时，xint2 中断函数才会被执行。 
 

六．问题与思考 
请修改程序完成按键中断控制的指示灯依次逐一点亮功能。

开始

初始化：DSP 时钟、 
ICETEK-CTR

初始化中断控制寄存器

等待中断产生 

改变指示灯状态 

中断服务开始 

中断服务结束 
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实验 3.4.2：外中断(V61 版) 

 
一．实验目的 

1．通过实验熟悉 F2812A 的中断响应过程。 
2．学会 C 语言中断程序设计，以及运用中断程序控制程序流程。 

 
二．实验设备 

计算机，ICETEK-F2812-EDU 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 系统板+相
关连线及电源）。 

 
三．实验原理 

1．中断及中断处理过程（详见 spru078a.pdf） 
(1)中断简介 

中断是一种由硬件或软件驱动的信号，DSP 在接到此信号时，将当前程序悬挂起来，

转向去执行另外一个任务，我们称为中断服务程序(ISR)。TMS320f28x  DSP 可支持 32 个

ISR，可由硬件或软件触发。 
所有 C28x 中断，可以分成可屏蔽中断和不可屏蔽中断两种，软件中断是不可屏蔽的。 

(2)DSP 处理中断的步骤 
①接收中断请求。请求由软件或硬件发出。 
②响应中断请求。对于可屏蔽中断，需要满足若干条件，才发生响应；而对于不可屏蔽

中断，则立即响应。 
③准备执行中断服务程序。 

-完成当前正在执行的指令；将进入流水线但还未解码的指令清除。 
-自动保存若干寄存器的值到数据堆栈和系统堆栈。 
-取得用户定义的中断向量表中当前中断向量，中断向量指向中断服务程序入口。 

④执行中断服务程序。中断服务程序包含中断返回指令，这样返回时可以出栈以前保存

的关键寄存器数据，从而恢复中断服务程序执行前的现场。 
(3)外中断 

TMS320f2812 可以响应两个外中断。 
2．ICETEK-CTR 板的键盘接口 

显示/控制模块 ICETEK-CTR 通过连接键盘，接收键盘传送的扫描码，并在每个扫描码

结束后保存，同时向 DSP 的 XINT2 发送中断信号；当 DSP 读键盘时将扫描码送到数据总线

上。键盘上每次按下一个键将产生 2 个扫描码、2 次中断。 
3．程序编制 

由一个不含中断处理程序的工程通过改写加入中断处理程序部分大致需要如下操作(假
设使用 INT2)： 

(1)编制中断服务程序：可以用C语言程序实现(参见实验程序)，编写单独的一个函数XINT， 
此函数使用 interrupt 修饰，没有参数和返回值。 

(2)构造中断向量表：程序中“InitPieVectTable();”是初始化向量表， 
“PieVectTable.XINT2 = &XINT2_isr;”把中断服务程序和向量表该中断对应起来。 

(3)主程序中进行初始化设置：使能中断，清中断等。 
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4．实验程序流程图 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

四．实验步骤 
1．实验准备 
(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)将 ICETEK-CTR 板的供电电源开关拨动到“开”的位置。开关位置请参见第二部分、

第一章、五、“扩展模块电源开关及其指示灯”。 
2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 

请参看本书第三部分、第一章、四、2。 
3．启动 Code Composer Studio 3.3：请参看本书第三部分、第一章、五、2。 

     选择菜单 Debug→Reset CPU。 
4．打开工程文件 

工程目录：C:\ICETEK\F2812 \DSP281x_examples\Lab0304-Xint\V61\xint.pjt 
浏览 xint.c 文件的内容，理解各语句作用。 

5．编译、下载程序。 
6．运行程序，观察结果。 

运行程序，按一下键盘上任意一个键，注意观察评估板上指示灯闪烁情况。 
7．观察中断函数的执行 

选择“Debug”菜单中“Halt”暂停运行程序，在 XINT2 中断程序中的语句上加软件断

点，重新运行程序(选择“Debug”菜单中“Run”)，观察何时程序停留在断点上。 
8．退出 CCS：请参看本书第三部分、第一章、六。 

 
五．实验结果 

通过实验可以发现，每次按下键盘均会发生两次中断，当按下键不放时会产生连续的中断；

只有在外中断发生时，xint2 中断函数才会被执行。 
 

六．问题与思考 
请修改程序完成按键中断控制的指示灯依次逐一点亮功能。

开始

初始化：DSP 时钟、 
ICETEK-CTR

初始化中断控制寄存器

等待中断产生 

改变指示灯状态 

中断服务开始 

中断服务结束 
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实验 3.4.3：外中断(V80 版) 

 
一．实验目的 

1．通过实验熟悉 F2812A 的中断响应过程。 
2．学会 C 语言中断程序设计，以及运用中断程序控制程序流程。 

 
二．实验设备 

计算机，ICETEK-F2812-EDU 实验箱（或 ICETEK 仿真器+ICETEK-F2812-A 系统板+相关

连线及电源）。 
 

三．实验原理 
1．中断及中断处理过程（详见 spru078a.pdf） 
(1)中断简介 

中断是一种由硬件或软件驱动的信号，DSP 在接到此信号时，将当前程序悬挂起来，

转向去执行另外一个任务，我们称为中断服务程序(ISR)。TMS320f28x  DSP 可支持 32 个

ISR，可由硬件或软件触发。 
所有 C28x 中断，可以分成可屏蔽中断和不可屏蔽中断两种，软件中断是不可屏蔽的。 

(2)DSP 处理中断的步骤 
①接收中断请求。请求由软件或硬件发出。 
②响应中断请求。对于可屏蔽中断，需要满足若干条件，才发生响应；而对于不可屏蔽

中断，则立即响应。 
③准备执行中断服务程序。 

-完成当前正在执行的指令；将进入流水线但还未解码的指令清除。 
-自动保存若干寄存器的值到数据堆栈和系统堆栈。 
-取得用户定义的中断向量表中当前中断向量，中断向量指向中断服务程序入口。 

④执行中断服务程序。中断服务程序包含中断返回指令，这样返回时可以出栈以前保存

的关键寄存器数据，从而恢复中断服务程序执行前的现场。 
(3)外中断 

TMS320f2812 可以响应两个外中断。 
 
2．ICETEK-CTR 板的键盘接口 
 
3．程序编制 

由一个不含中断处理程序的工程通过改写加入中断处理程序部分大致需要如下操作(假
设使用 INT2)： 

(1)编制中断服务程序：可以用C语言程序实现(参见实验程序)，编写单独的一个函数XINT， 
此函数使用 interrupt 修饰，没有参数和返回值。 

(2)构造中断向量表：程序中“InitPieVectTable();”是初始化向量表， 
“PieVectTable.XINT2 = &XINT2_isr;”把中断服务程序和向量表该中断对应起来。 

(3)主程序中进行初始化设置：使能中断，清中断等。 



   REALTIME—DSP 系列应用丛书 

 
 
地址：北京市海淀区知春路 108 号豪景大厦 A 座 18 层                     http://www.realtimedsp.com.cn 
电话：010-62105690(中继)/91-97                                         传真：010-62105699   

80 

4．实验程序流程图 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

四．实验步骤 
1．实验准备 
(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)将 ICETEK-CTR 板的供电电源开关拨动到“开”的位置。 
 
2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 

请参看本书第三部分、第一章、四、2。 
 
3．启动 Code Composer Studio 3.3：请参看本书第三部分、第一章、五、2。 

     选择菜单 Debug→Reset CPU。 
 
4．打开工程文件 

工程目录：C:\ICETEK\F2812\DSP281x_examples\Lab0304-Xint\V80\xint.pjt 
浏览 xint.c 文件的内容，理解各语句作用。 

5．编译、下载程序。 
 
6．运行程序，观察结果。 

运行程序，按一下小键盘上任意一个键，注意观察评估板上指示灯闪烁情况。 
 
7．观察中断函数的执行 

选择“Debug”菜单中“Halt”暂停运行程序，在 XINT2 中断程序中的语句上加软件断

点，重新运行程序(选择“Debug”菜单中“Run”)，观察何时程序停留在断点上。 
 
8．退出 CCS：请参看本书第三部分、第一章、六。 

 
五．实验结果 

通过实验可以发现，每次按下键盘均会发生两次中断，当按下键不放时会产生连续的中断；

只有在外中断发生时，xint2 中断函数才会被执行。 
 

六．问题与思考 
请修改程序完成按键中断控制的指示灯依次逐一点亮功能。 
 

开始

初始化：DSP 时钟、 
ICETEK-CTR

初始化中断控制寄存器

等待中断产生 

改变指示灯状态 

中断服务开始 

中断服务结束 
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实验 3.5：单路，多路模数转换（AD） 

 
一．实验目的 

1．通过实验熟悉 F2812A 的定时器。 
2．掌握 F2812A 片内 AD 的控制方法。 

 
二．实验设备 

计算机，ICETEK-F2812-A 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 系统板+相关连

线及电源）。 
 

三．实验原理 
1．TMS320F2812A 芯片自带模数转换模块特性 

- 12 位模数转换模块 ADC，快速转换时间运行在 25mhz，ADC 时钟或 12.5MSPS。 
-16 个模拟输入通道（AIN0—AIN15）。 
-内置双采样-保持器 
-采样幅度：0-3v，切记输入 ad 的信号不要超过这个范围，否则会烧坏 2812 芯片的。 

2．模数模块介绍 
  ADC 模块有 16 个通道，可配置为两个独立的 8 通道模块以方便为事件管理器 A 和 B

服务。两个独立的 8 通道模块可以级连组成 16 通道模块。虽然有多个输入通道和两个序

列器，但在 ADC 内部只有一个转换器，同一时刻只有 1 路 ad 进行转换数据。  
3．模数转换的程序控制 

模数转换相对于计算机来说是一个较为缓慢的过程。一般采用中断方式启动转换或保

存结果，这样在 CPU 忙于其他工作时可以少占用处理时间。设计转换程序应首先考虑处

理过程如何与模数转换的时间相匹配，根据实际需要选择适当的触发转换的手段，也要能

及时地保存结果。 
关于 TMS320F2812A DSP 芯片内的 A/D 转换器的详细结构和控制方法，请参见文档

spru060a.pdf。 
4．实验程序流程图 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

开始 

初始化 CPU 时钟、AD
采样时钟 

启动 AD0 和 AD1 通道采集 

中断中对 AD0 和 AD1 
通道采集数据依次存入 
缓冲区 Voltage1Voltage2 
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四．实验步骤 

1．实验准备 
(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)准备信号源进行 AD 输入。 
①取出 2 根实验箱附带的信号线(如右图，两端均为双声道语音插头)。 
②用 1根信号线连接实验箱左侧信号源的波形输出A端口和“A/D输入”

模块的“ADCIN0”插座注意插头要插牢、到底。这样，信号源波形输出 A 的输出波形

即可送到 ICETEK–F2812-A 板的 AD 输入通道 0。 
③用 1 根信号线连接实验箱左侧信号源的波形输出 B 端口和“A/D 输入”模块的

“ADCIN1”插座注意插头要插牢、到底。这样，信号源波形输出 B 的输出波形即可送

到 ICETEK–F2812-A 板的 AD 输入通道 1。 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
图 3.2.3.3 

④设置波形输出 A： 
- 向内侧按波形频率选择旋钮，直到标有正弦波的指示灯点亮。 

        - 上下调节波形频率选择旋钮，直到标有 100-1KHz 的指示灯点亮。 
        - 调节幅值调整旋钮，将波形输出 A 的幅值调到最大。 

⑤设置波形输出 B： 
- 向内侧按波形频率选择旋钮，直到标有三角波的指示灯点亮。 

        - 上下调节波形频率选择旋钮，直到标有 100-1KHz 的指示灯点亮。 
        - 调节幅值调整旋钮，将波形输出 B 的幅值调到最大。 

2．设置 Code Composer Studio 3.3 在硬件仿真（Emulator）方式下运行 

正弦波 

1K-10KHz 

正弦波

1K-10KHz 

幅值调整 

波形频率选

波形输出 A 

幅值调整 

波形输出 B 

波形频率选择 
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请参看本书第三部分、第一章、四、2。 
3．启动 Code Composer Studio 3.3 

请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

4．打开工程文件 
-工程目录：C:\ICETEK\F2812\DSP281x_examples\Lab0305-AD\ ADC.pjt。 
-在项目浏览器中，双击 adc.c，打开 adc.c 文件，浏览该文件内容，理解各语句作用。 

5．编译、下载程序。 
6．打开观察窗口 
 

-选择菜单“View”、“Graph”、“Time/Frequency…”做如下设置，然后单击“OK”按钮； 
 

 
 

图 3.2.3.4  观察窗口设置 1 
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-选择菜单“View”、“Graph”、“Time/Frequency…”做如下设置，然后单击“OK”按钮； 

 

 
 

图 3.2.3.4  观察窗口设置 2 
 
 
 

-在弹出的图形窗口中单击鼠标右键，选择“Clear Display”。 
通过设置，我们打开了两个图形窗口观察两个通道模数转换的结果。 

7. 设置信号源 
由于模数输入信号未经任何转换就进入 DSP，所以必须保证输入的模拟信号的幅度

在 0-3V 之间。必须用示波器检测信号范围，保证最小值 0V 最大值 3 V，否则容易损坏

DSP 芯片的模数采集模块。 
8. 运行程序观察结果 

-单击“Debug”菜单，“Run”项，运行程序； 
-停止运行，观察“ADCIN0”、“ADCIN1”窗口中的图形显示； 
-适当改变信号源，按 F5 健再次运行，停止后观察图形窗口中的显示。注意：输入信号

的频率不能大于 10KHz，否则会引起混叠失真，而无法观察到波形，如果有兴趣，可

以试着做一下，观察采样失真后的图形。 
9．选择菜单 File→workspace→save workspacs As…，输入文件名 SY.wks 。 

10．退出 CCS 
请参看本书第三部分、第一章、六。 

 
五．实验结果 

 
-用实验中的设置，我们可以看到结果为：  
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图 3.2.3.5  结果输出 

 
 

六．问题与思考 
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实验 3.6：单路，多路数模转换（DA） 

 
一. 实验目的 

1．了解数模转换的基本操作； 
2．了解 ICETEK–F2812-A 评估板扩展数模转换方式； 
3．掌握数模转换程序设计方法。 
 

二. 实验设备 
计算机，示波器，ICETEK-F2812-A 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 系

统板+相关连线及电源）。 
 

三. 实验原理 
1．数模转换操作 

利用专用的数模转换芯片，可以实现将数字信号转换成模拟量输出的功能。在

ICETEK–F2812-A 评估板上，使用的是 DAC7528 数模芯片，它可以实现同时转换 2 路模

拟信号数出，并有 8 位精度，转换时间 10m/s。其控制方式较为简单：首先将需要转换的

数值通过数据总线传送到 DAC7528 上相应寄存器，再发送转换信号，经过一个时间延迟，

转换后的模拟量就从 DAC7528 输出引脚输出。 
2．DAC7528 与 TMS320F2812A 的连接 

由于 TMS320F2812A DSP 没有数模转换输出设备，采用外扩数模转换芯片的方法。

在 ICETEK–F2812-A 评估板上选用的是 DAC7528。DAC7528 的转换寄存器被映射到

C0003-C0007h（ 详细说明见第一部分 表 1.7）。在 DAC7528 的输出端，为了增加输出功

率，经过一级运放再输出到板上插座上。 
 

*硬件原理图 
 
 
 
                             

   
   

 
                                             输出波形 
 
            P2 

 
 
 
 
 
 
 

 
 
图 3.2.3.6  硬件原理图 
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F2812 

                  E   M   I   F 
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DAC 

数字信号输入

模拟信号输出 
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3．实验程序流程图 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

四. 实验步骤 
1．实验准备 

连接实验设备：请参看本书第三部分、第一章、二。 
2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator) 

方式下运行 
请参看本书第三部分、第一章、四、2。 

3．启动 Code Composer Studio 3.3 
请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

4．打开工程文件 
工程目录：C:\ICETEK\F2812\DSP281x_examples\lab0306-Dac\ dac.pjt。 
浏览 dac.c 文件的内容，理解各语句作用。 

5．编译、下载程序。 
6．运行程序，观察结果。 

用信号线从实验箱底板上右侧“D/A 输出”的两个插座引线到示波器。也可以用控制

模块右侧的 DAOUT1－DAOUT2 测试勾连接示波器。 

单击“Debug”菜单，“Run”项，运行程序；观察示波器上的波形。 

7．退出 CCS 
请参看本书第三部分、第一章、六。 

 
五．实验结果 

两路输出均为 0—5V，示波器显示波形为三角波。 

 

六．问题与思考 
程序采用计算法输出波形，这样做的缺点是速度慢，波形的 

形状有运算失真；优点是占用存储空间很少。请考虑使用别的方法产生同样波形输出（例如查

表法）。 

DSP 初始化

产生每一个通路

的三角波

进行数模转换

结束 

波形输出

开始 
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实验 3.7：自启动（自举） 

 
一. 实验目的 

1．了解 TMS320F2812A DSP 芯片的微处理器工作方式；  
2．了解 TMS320F2812A DSP 芯片的自启动方式； 
3．学习了解 TMS320F2812A DSP 片内 Flash 的特点； 
4．掌握 TMS320F2812A DSP 片内 Flash 的烧写过程； 
5．学会使用 TMS320F2812A DSP 片内 Flash 特有的加密、解密方式； 
6．学习自启动程序的设计。 
 

二. 实验设备 
计算机，ICETEK-F2812-A 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 系统板+相关连

线及电源）。 
 

三. 实验原理 
1．MP/MC 方式 

TMS320F2812A DSP 芯片有两种工作方式，一种为微控制器（MC）方式，一种为微

处理器方式（MP）。 
2．TMS320F2812A DSP 片内 Flash 的特点 

-TMS320F2812A DSP 片内 Flash 的容量为 128K 字，从 0x3D8000 开始编址； 
-由于采用了特殊设计，其读写速度较快，一般快于片外存储器的读写速度，所以可采

用程序直接在 Flash 上运行的自启动方式； 
-TMS320F2812A DSP 片内 Flash 采用特有的加密、解密方式来保护用户开发的程序代

码；加密的秘钥长度为 128 位，在 Flash 地址 0x3F7FF8 开始存放；如果此地址开始的

连续 8 个字不全为 0 或 FFFFh，则进入加密模式；在加密模式中，如果需要读写 Flash
区需要将密钥写入数据区特定位置，如密钥与原先烧制的不符，则拒绝 Flash 的读写、

擦除等操作。 
3．自启动程序编制要点 

由于 DSP 工作在 MC 方式下与工作在 MP 方式时程序启动的地址是不相同的，所以程

序的位置基本上需要调整。首先在 MP 方式下把被烧到 FLASH 中运行程序调通，然后在

程序中增加一个 CodeStartBranch.asm 的文件，同是修改程序运行空间到 FLASH 的空间中，

然后编译生成.OUT 文件，再把这个文件通过 TOOL 菜单下的烧写插件烧到 FLASH 中。 
注意：参考 spra958f.PDF 文件。（WWW.TI.COM 下载此文件） 
 

四. 实验步骤 
1．实验准备 

连接实验设备：请参看本书第三部分、第一章、二。 
2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 

请参看本书第三部分、第一章、四、2。 
3．启动 Code Composer Studio 3.3 

请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

4．打开工程文件 
工程目录：C:\ICETEK\F2812\DSP281x_examples\lab0307-bootloader。 
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浏览 boot.c 文件的内容，理解各语句作用。 

5．编译程序。 
6．单击 Tools 菜单，查看“F28xx On-chip Flash Programmer”选项，这就是烧写 flash 的

插件。 
7．将程序写入 Flash 

-启动烧写插件：单击菜单“Tools”、“F28xx On-chip Flash Programmer” 
 

 
                              

图 3.2.3.7  flash 烧写界面 
 
 

8．退出 CCS。 
请参看本书第三部分、第一章、六。 

9．测试自启动 
将实验箱电源关闭；拔掉仿真电缆（黑色的），让仿真器和计算机脱开；重新打开实验

箱电源；观察板上指示灯闪烁；表明烧入 Flash 的程序正在运行；按一下板上复位按钮，

程序将从新运行。 
实验现象是拨动拨码开关，控制四个发光二极管亮或灭。 
 

五. 实验结果 
在脱离计算机和仿真器的情况下，自启动程序正常工作。 
 

六. 问题与思考 
试选择其他功能的程序烧写 Flash 后验证自举功能 

 
 
 

1．指定要烧写 
  文件的路径 

2．点击后开 
 始烧写 flash 
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实验 3.8：异步串口通信 

 
一. 实验目的 

1．了解 ICETEK–F2812-A 评估板上扩展标准 RS-232 串行通信接口的原理和方法。 
2．学会对串行通信芯片的配置编程。 
3．学习设计异步通信程序。 

二. 实验设备 
计算机，ICETEK-F2812-A 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 系统板+相关 

连线及电源）。 
三. 实验原理 

1．异步串行通信原理（见 spru051a.pdf） 
2．ICETEK–F2812-A 评估板异步串口设计 

在板上加上 Max232 部分即可。驱动电路主要完成将输出的 0-3.3V 电平转换成异步串

口电平的工作，转换电平的工作由 MAX232 芯片完成。 
3．串行通信接口设置 

*串行通信接口波特率计算 
内部生成的串行时钟是由低速的外部时钟 LSPCLK 频率和波特率选择寄存器决定。对

于一个给定的设备时钟，SCI 通过波特率选择器的 16 位值从 64k 开始的不同串行时钟频率

中选择一个时钟。 
表 3.2.3.1 

理想的波特率 BRR 值 
2400 7A0H 
4800 3D0H 
9600 1E7H 
19200 F3H 
38400 79H 

 
4．实验程序流程图： 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

四. 实验步骤 

开始

初始化：DSP 时钟

初始化：SCI 各控制寄存器

串口是否有输入
信息？ 

发送启动信息到串口

将接收到的信息回发

否

是
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1．实验准备 
(1)连接实验设备：请参看本书第三部分、 

第一章、二。 
(2)连接串口接线： 
注意连接前需要将实验箱和计算机的电源关闭。 
用随实验箱附带的串口线(两端均为 9 孔 
“D”形插头)连接计算机 com1 或 com2 插座和 ICETEK–F2812-A 评估板上标准 
RS-232 插座。 

2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 
请参看本书第三部分、第一章、四、2。 

3．启动 Code Composer Studio 3.3 
请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

4．打开工程文件 
工程目录： C:\ICETEK\F2812\DSP281x_examples\lab0308-sci 
浏览 sci.c 文件的内容，理解各语句作用。 

5．编译、下载程序。 
6．打开串口调试助手 

利用桌面上 “我的电脑” ，找到 C:\ICETEK\F2812\DSP281x _examples\lab0308-sci
目录中的程序“串口调试助手 V2.0B.exe”，双击它启动；设置“串口调试助手”的串行端

口为实际连接的计算机 COM 端口，设置波特率为 9600，设置传输方式为 8位、无校验、1

个停止位。 

7．运行程序观察结果 
运行程序后，切换窗口到“串口调试助手”；在“串口调试助手”的接收窗口中可看到 

DSP 通过 SCI 发送来的“Hello PC!,Over|”字样；在“发送的字符/数据”栏中输入一些

要发送到 DSP 的字符串，以“.”字符结尾；然后单击“手动发送”按钮；DSP 在接收到

PC 机的信息后会自动进行回答。  

8．结束程序运行，退出 CCS。 
请参看本书第三部分、第一章、六。 

 
五. 实验结果 

通过 DSP 传送到 PC 机上的信息，可以看出：串口正确工作。 
 

六. 问题与思考 
请考虑用中断方式设计程序完成异步串行通信。 
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实验 3.9：WM 输出实验 

 
一．实验目的 

1. 了解 TMS320F2812A DSP 片内事件管理器模块的脉宽调制电路 PWM 的特性参数； 
2. 掌握 PWM 电路的控制方法； 
3. 学会用程序控制产生不同占空比的 PWM 波形。 
 

二．实验设备 
计算机，示波器，ICETEK–F2812-A 实验设备一套。 
 

三．实验原理 
1．脉宽调制电路 PWM 的特性 

每个事件管理器模块（TMS320F2812A DSP 片内有两个）可同时产生多达 8 路的

PWM 波形输出。由 3 个带可编程死区控制的比较单元产生独立的 3 对（即 6 个输出），

以及由通用定时器比较产生的 2 个独立的 PWM 输出。 
PWM 的特性如下： 
-16 位寄存器； 
-有从 0 到 16μs 的可编程死区发生器控制 PWM 输出对； 
-最小的死区宽度为 1 个 CPU 时钟周期； 
-对 PWM 频率的变动可根据需要改变 PWM 的载波频率； 
-在每个 PWM 周期内和以后可根据需要改变 PWM 脉冲的宽度； 
-外部可屏蔽的功率驱动保护中断； 
-脉冲形式发生器电路，用于可编程对称、非对称以及 4 个空间矢量 PWM 波形产生； 
-自动重装载的比较和周期存器使 CPU 的负荷最小。 

2．PWM 电路的设置 
在电机控制和运动控制的应用中，PWM 电路被设计为减少产生 PWM 波形的 CPU

开销和减少用户的工作量。与比较单元相关的 PWM 电路其 PWM 波形的产生由以下器

存器控制：对于 EVA 模块，T1CON、COMCONA、ACTRA 和 DBTCONA；对于 EVB
模块，T3CON、COMCONB、ACTRB 和 DBTCONB。 

产生 PWM 的器存器设置： 
-设置和装载 ACTRx 寄存器； 
-如果使能死区，则设置和装载 DBTCONx 寄存器； 
-设置和装载 T1PR 或 T3PR 寄存器，即规定 PWM 波形的周期； 
-初始化 CMPRX 寄存器； 
-设置和装载 COMCONx 寄存器； 
-设置和装载 T1CON 或 T3CON 寄存器，来启动比较操作； 
-更新 CMPRx 寄存器的值，使输出的 PWM 波形的占空比发生变化。 

 
四．实验步骤 

1．实验准备 
连接实验设备：请参看本书第三部分、第一章、二。 
关闭实验箱上扩展模块和信号源电源开关。 

2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 
请参看本书第三部分、第一章、四、2。 
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3．启动 Code Composer Studio 3.3 

请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

4．打开工程文件 
打开菜单“Project”的“Open”项；选择 C:\ICETEK\F2812\DSP281x_examples\lab0309-pwm
目录中的“pwm.pjt”。 
在项目浏览器中，双击 pwm.c，激活 pwm.c 文件，浏览该文件的内容，理解各语句作用。 

5．编译、下载程序。 
6．连接示波器 

连接示波器探头的地线与实验箱右侧的测试点的 DGND 相连，红表笔与测试点

PWM1~4 相连。 
注意：如果使用的是 2812 单板，请连接 P1 扩展口上的 PWM 输出引脚做测量。 

（具体位置参考 ICETEK　F2812-A 评估板原理图。） 
7．运行并观察结果 

-单击“Debug”菜单，“Run”项，运行程序； 
-观察示波器上的波形。 

8． 结束运行退出 Code Composer studio。 
 
五.实验结果 

通过示波器可观察到不同占空比的 PWM 输出波形，其载波频率、占空比与程序中对控制 
寄存器的设置相关。 

 
六.问题与思考 

试设计四路（PWM1,PWM2,PWM3,PWM4）输出，载波频率为 8ms，波形关系如下（一个

周期）： 
 
 
 
                                                      PWM1 
 
 
 
                                                         PWM2 

 
 
 
                                                             PWM3 
  
     
                                                             PWM4 

 
                 1ms 

8ms 
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实验 3.10：CAN 接口通讯自检测 

 
一.实验目的 

1． 了解 TMS320F2812A DSP 片内 CAN 模块的控制； 
2． 掌握 CAN 电路的控制方法； 
3． 学会用程序控制 CAN 接口传输发送数据，并从 CAN 邮箱中检测数据的正确性。 
 

二.实验设备 
计算机，ICETEK–F2812-A 实验设备一套，或 ICETEK–F2812-A 评估板一块。 
 

三.实验原理 
1.CAN 模块的特性（见 spru074a.pdf 文档） 

       与 CAN(2.0B)协议完全兼容； 
       支持高达 1Mbps 的传输速率； 
       具有 32 个邮箱，每个邮箱都具有以下特性： 
          *可配置为接收或发送 
          *可用标准的或扩展的标识符进行配置 
          *具有可编程的接收过滤屏蔽 
          *支持数据桢和远程桢 
          *支持 0-8 字节的数据 
          *在接收和发送的信息中使用一个 32 位的时间标志 
          *阻止旧消息被新消息覆盖的保护措施 
          *允许对发送消息优先级的动态编程 
          *使用一种具有两个中断级别的可编程中断方案 
          *对发送和接收的超时现象使用一种可编程的中断操作 
       低功耗模式； 
       总线活动的可编程唤醒； 
       远端请求消息的自动应答； 
       某桢在缺少仲裁和发送错误下的自动重传； 
       由一个特殊消息（与 16 号邮箱关联）同步的 32 位时间标志计数器； 
       自检模式。 

 
四.实验步骤 

1．实验准备 
连接实验设备：请参看本书第三部分、第一章、二。 
关闭实验箱上扩展模块和信号源电源开关。 

2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 
请参看本书第三部分、第一章、四、2。 

3．启动 Code Composer Studio 3.3 
请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

4．打开工程文件 
打开菜单“Project”的“Open”项；选择

C:\ICETEK\F2812\DSP281x_examples\Lab0310-Can-Self-Test 目录中的 
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“BACK2bak.pjt”。 
在项目浏览器中，双击 Back2bak.c，激活 Back2bak.c 文件，浏览该文件的内容，理

解各语句作用。 
5．编译、下载程序。 
6．打开菜单“file”的“workspace”中的“load workspace”项；选择

C:\ICETEK\F2812\DSP281x_examples\Lab0310-Can-Self-Test\can.wks 
7．运行并观察结果 

-单击“Debug”菜单，“Run”项，运行程序； 
-等程序停止运行后，观察 CAN 邮箱中显示的数据，查看右下脚的 errorcount 变量值， 
如果邮箱的数据传输没有任何错误，这个值应为 0。 
查看 CAN 邮箱中显示数据可以点 GEL 菜单下的“watch ecan register”，它可以显示所

有的 CAN 邮箱寄存器的值。 
8． 结束运行退出 Code Composer studio。 

 
五.实验结果 

这个程序主要完成的 CAN 接口的邮箱 1-16 号发送给 CAN 接口的邮箱 17-32 号，并检查发 
送接收到的数据是否正确，如有错误将给 errorcount 变量值加 1。 

 
六.问题与思考 
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四．DSP 实现外部控制实验 

 
实验 4.1：通用输入输出管脚应用 

 
实验 4.1.1：通用输入输出管脚应用(V60 版) 

 
一．实验目的 

通过实验学习使用 2812  DSP 的通用输入/输出管脚直接控制外围设备的方法，了解发光

二极管的控制编程方法。 
 

二．实验设备 
计算机，ICETEK-F2812-EDU 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 系统板+相

关连线及电源）。 
 

三．实验原理 
1．TMS320f2812 的通用输入/输出管脚 

TMS320f2812 DSP 有最多 56 个专门的通用输入输出管脚。这些通用输入输出管脚通

过专用寄存器可以由软件控制，比如指定输入或输出，输出值等。 
2．ICETEK-CTR 指示灯的控制 

-GPIO 与被控指示灯的连接 
通过 ICETEK–F2812-A 评估板的扩展插座，通用输出/控制模块 ICETEK-CTR 板直

接连接了板上的一个指示灯和 DSP 的一个通用输入/输出管脚。这个管脚属于 pwm12，可

以设置成通用输入/输出管脚使用。扩展原理如图： 
 

 
 
                           图 3.2.4.1  发光二极管设计原理 
 

-GPIO 控制指示灯 
如图原理，如果要点亮发光二极管，需要在 GPIO1 上输出低电平，如果输出高电平则

指示灯熄灭。 
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如果定时使 GPIO1 上的输出改变，指示灯将会闪烁。 
-受控指示灯 

 
ICETEK-CTR 板上只有一个指示灯可单独受 DSP 的 GPIO 控制，它是交通灯模块“北”

侧的红色指示灯。 
3．实验程序流程图 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

四．实验步骤 
1．实验准备 
(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)将 ICETEK-CTR 板的供电电源开关拨动到“开”的位置。 
2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 

请参看本书第三部分、第一章、四、2。 
3．启动 Code Composer Studio 3.3 

请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

4．打开工程文件 
工程目录：C:\ICETEK\F2812\DSP281x_examples\lab0401-Iopin\V60 
浏览 iopin.c 文件的内容，理解各语句作用。 

5．编译、下载程序。 
6．运行程序观察结果 
7．结束程序运行，退出 CCS。 

请参看本书第三部分、第一章、六。 
 

五．实验结果与分析 
可以观察到位于“交通灯”模块的“北”侧红色发光二极管定时闪烁。 
 

六. 问题与思考 

开始

初始化：DSP 时钟、ICETEK-CTR

设置 PWM12 成 GPIO

选通指示灯“北”侧红色指示灯

适当延时

翻转 PWM12 状态
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实验 4.1.2：通用输入输出管脚应用(V61 版) 

 
 

一．实验目的 
通过实验学习使用 2812  DSP 的通用输入/输出管脚直接控制外围设备的方法，了解发光

二极管的控制编程方法。 
 

二．实验设备 
计算机，ICETEK-F2812-A 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 系统板+相关连

线及电源）。 
 

三．实验原理 
1．TMS320f2812 的通用输入/输出管脚 

TMS320f2812 DSP 有最多 56 个专门的通用输入输出管脚。这些通用输入输出管脚通

过专用寄存器可以由软件控制，比如指定输入或输出，输出值等。 
2．ICETEK-CTR 指示灯的控制 

-GPIO 与被控指示灯的连接 
通过 ICETEK–F2812-A 评估板的扩展插座，通用输出/控制模块 ICETEK-CTR 板直

接连接了板上的一个指示灯和 DSP 的一个通用输入/输出管脚。这个管脚属于 pwm12，可

以设置成通用输入/输出管脚使用。扩展原理如图： 
 

 
 
                           图 3.2.4.2 发光二极管设计原理 
 

-GPIO 控制指示灯 
如图原理，如果要点亮发光二极管，需要在 GPIO1 上输出低电平，如果输出高电平则

指示灯熄灭。 
如果定时使 GPIO1 上的输出改变，指示灯将会闪烁。 
-受控指示灯 

 
ICETEK-CTR 板上只有一个指示灯可单独受 DSP 的 GPIO 控制，它是交通灯模块“北”
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侧的红色指示灯。 
3．实验程序流程图 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

四．实验步骤 
1．实验准备 
(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)将 ICETEK-CTR 板的供电电源开关拨动到“开”的位置。 
2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 

请参看本书第三部分、第一章、四、2。 
3．启动 Code Composer Studio 3.3 

请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

4．打开工程文件 
工程目录：C:\ICETEK\F2812\DSP281x_examples\lab0401-Iopin\V61 
浏览 iopin.c 文件的内容，理解各语句作用。 

5．编译、下载程序。 
6．运行程序观察结果 
7．结束程序运行，退出 CCS。 

请参看本书第三部分、第一章、六。 
 

五．实验结果与分析 
可以观察到位于“交通灯”模块的“北”侧红色发光二极管定时闪烁。 
 

六. 问题与思考 
 
 
 
 

开始

初始化：DSP 时钟、ICETEK-CTR

设置 PWM12 成 GPIO

选通指示灯“北”侧红色指示灯

适当延时

翻转 PWM12 状态
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实验 4.1.3：通用输入输出管脚应用(V80 版) 

 
一．实验目的 

通过实验学习使用 2812  DSP 的通用输入/输出管脚直接控制外围设备的方法，了解发光

二极管的控制编程方法。 
 

二．实验设备 
计算机，ICETEK-F2812-EDU 实验箱（或 ICETEK 仿真器+ICETEK-F2812-A 系统板+相关

连线及电源）。 
 

三．实验原理 
1．TMS320f2812 的通用输入/输出管脚 

TMS320f2812 DSP 有最多 56 个专门的通用输入输出管脚。这些通用输入输出管脚通

过专用寄存器可以由软件控制，比如指定输入或输出，输出值等。 
 
2．ICETEK-CTR 指示灯的控制 

-GPIO 与被控指示灯的连接 
通过 ICETEK-F2812-A 评估板的扩展插座，通用输出/控制模块 ICETEK-CTR 板直接

连接了板上的一个指示灯和 DSP 的一个通用输入/输出管脚。这个管脚属于 pwm12，可以

设置成通用输入/输出管脚使用。扩展原理如图： 
 

 
 
                           图 3.2.4.3 发光二极管设计原理 
 

-GPIO 控制指示灯 
如图原理，如果要点亮发光二极管，需要在 GPIO1 上输出低电平，如果输出高电平则

指示灯熄灭。 
如果定时使 GPIO1 上的输出改变，指示灯将会闪烁。 
-受控指示灯 
ICETEK-CTR 板上只有一个指示灯可单独受 DSP 的 GPIO 控制，它是指示灯 led4。 
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3．实验程序流程图 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

四．实验步骤 
1．实验准备 
(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)将 ICETEK-CTR 板的供电电源开关拨动到“开”的位置。 
2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 

请参看本书第三部分、第一章、四、2。 
3．启动 Code Composer Studio 3.3 

请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

4．打开工程文件 
工程目录：C:\ICETEK\F2812\DSP281x_examples\lab0401-Iopin\V80 
浏览 iopin.c 文件的内容，理解各语句作用。 

5．编译、下载程序。 
6．运行程序观察结果 
7．结束程序运行，退出 CCS。 

请参看本书第三部分、第一章、六。 
 

五．实验结果与分析 
可以观察到位于左上脚的 LED4 定时闪烁。 
 

六. 问题与思考 
 

开始

初始化：DSP 时钟、ICETEK-CTR

设置 PWM12 成 GPIO

选通指示灯 LED4

适当延时

翻转 PWM12 状态
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实验 4.2：外设控制实验—发光二极管阵列显示实验 

 
实验 4.2.1：外设控制实验—发光二极管阵列显示实验（V60 版） 

 
一．实验目的 

通过实验学习使用 2812A DSP 的扩展端口控制外围设备的方法，了解发光二极管阵列的控

制编程方法。 
 

二．实验设备 
计算机，ICETEK-F2812-A 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 系统板+相关连

线及电源）。 
 

三．实验原理 
1．EMIF 接口 
TMS320F2812DSP 的扩展存储器接口(EMIF)用来与大多数外围设备进行连接，典型应用 

如连接片外扩展存储器等。这一接口提供地址连线、数据连线和一组控制线。ICETEK–F2812-A
将这些扩展线引到了板上的扩展插座上供扩展使用。 

2．发光二极管显示阵列的显示是由扩展端口控制，扩展在 EMIF 接口的两个寄存器提供 
具体控制。 

原理图如下： 

 
                            

图 3.2.4.4  发光二极管点阵设计原理 
 

3．显示原理 
DSP 须将显示的图形按列的顺序存储起来(8×8 点阵，8 个字节，高位在下方，低位在上 

方)，然后定时刷新控制显示。具体方法是，将以下控制字按先后顺序、每两个为一组发送到端

口 0x602802，发送完毕后，隔不太长的时间(以人眼观察不闪烁的时间间隔)再发送一遍。由于

位值为“0”时点亮，所以需要将显示的数据取反。 
0x01,第 8 列数据取反，0x02,第 7 列数据取反， 
0x04,第 6 列数据取反，0x08,第 5 列数据取反， 
0x10,第 4 列数据取反，0x20,第 3 列数据取反， 



         瑞泰创新—ICETEK-F2812-A 教学系统软件实验指导 

 
 
地址：北京市海淀区知春路 108 号豪景大厦 A 座 18 层                    http://www.realtimedsp.com.cn 
电话：010-62105690(中继)/91-97                                      传真：010-62105699   

103 

0x40,第 2 列数据取反，0x80,第 1 列数据取反， 
 
4．实验程序流程图 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

四．实验步骤 
1．实验准备 
(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)将 ICETEK-CTR 板的供电电源开关拨动到“开”的位置。 
2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 

请参看本书第三部分、第一章、四、2。 
3．启动 Code Composer Studio 3.3 

请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

4．打开工程文件 
工程目录 C:\ICETEK\F2812\DSP281x_examples\lab0402-Ledarray\V60 
浏览 ledarray.c 文件的内容，理解各语句作用。 
5．编译、下载程序。 
6．运行程序观察结果 
7．结束程序运行，退出 CCS。 

请参看本书第三部分、第一章、六。 
 

五．实验结果与分析 
实验结果：可以观察到发光二极管阵列显示从 0 到 9 的计数。 
分析：本程序使用循环延时的方法，如果想实现较为精确的定时，可使用通用计时器，在

通用计时器中断中取得延时，改变显示内容。另外本程序中 DSP 一直在做刷新显示的工作，

如果使用通用计时器定时刷新显示，将能减少 DSP 用于显示的操作。适当更新显示可取得动

画效果。 
 

六. 问题与思考 
试设计用定时器定时刷新的程序，并显示秒计数的最低位。 

 

开始 

初始化：DSP 时钟 

初始化 ICETEK-CTR 

选通发光二极管显示阵列 

由 0 到 9 循环计数 

送相应点阵刷新显示 
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实验 4.2.2：外设控制实验—发光二极管阵列显示实验（V61 版） 

 
 

一．实验目的 
通过实验学习使用 2812A DSP 的扩展端口控制外围设备的方法，了解发光二极管的控制编

程方法。 
 

二．实验设备 
计算机，ICETEK-F2812-EDU 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 系统板+相

关连线及电源）。 
 

三．实验原理 
发光二极管的控制方法可参见第二部分、第二章、二、2。 

 
实验程序流程图 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

四．实验步骤 
1．实验准备 
(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)将 ICETEK-CTR 板的供电电源开关拨动到“开”的位置。 
2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 

请参看本书第三部分、第一章、四、2。 
3．启动 Code Composer Studio 3.3 

请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

4．打开工程文件 
工程目录 C:\ICETEK\F2812\DSP281x_examples\lab0402-Ledarray\V61 
浏览 ledarray.c 文件的内容，理解各语句作用。 
5．编译、下载程序。 
6．运行程序观察结果 

开始 

初始化：DSP 时钟 

初始化 ICETEK-CTR 

选通发光二极管 

按顺序点亮发光二极管 

延时 
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7．结束程序运行，退出 CCS。 
请参看本书第三部分、第一章、六。 

 
五．实验结果与分析 

实验结果：可以观察到发光二极管循环显示。 
分析：本程序使用循环延时的方法，如果想实现较为精确的定时，可使用通用计时器，在

通用计时器中断中取得延时，改变显示内容。 
 

六. 问题与思考 
试设计用定时器定时刷新的程序，并显示秒计数的最低位。 
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实验 4.3：液晶显示器控制显示 

 
实验 4.3.1：液晶显示器控制显示(V60 版) 

 
一．实验目的 

通过实验学习使用 2812ADSP 的扩展 I/O 端口控制外围设备的方法，了解液晶显示器的显

示控制原理及编程方法。 
 

二．实验设备 
计算机，ICETEK-F2812-EDU 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 系统板+相

关连线及电源）。 
 

三．实验原理 
1．EMIF 接口 
TMS320F2812DSP 的扩展存储器接口(EMIF)用来与大多数外围设备进行连接，典型应用如 

连接片外扩展存储器等。这一接口提供地址连线、数据连线和一组控制线。ICETEK–F2812-A
将这些扩展线引到了板上的扩展插座上供扩展使用。 

2．液晶显示模块的访问、控制是由 2812ADSP 对扩展接口的操作完成。 
控制口的寻址：命令控制接口的地址为 0x108001，数据控制接口的地址为 0x108003 和 

0x108004，辅助控制接口的地址为 0x108002。 
3．显示控制方法： 
-液晶显示模块中有两片显示缓冲存储器，分别对应屏幕显示的象素，向其中写入数值将改 

变显示，写入“1”则显示一点，写入“0”则不显示。其地址与象素的对应方式如下： 
表 3.2.4.1 

左侧显示内存 右侧显示内存 

Y= 0 1 ··· 62 63 0 1 ··· 62 63 行号 

 DB0 DB0 DB0 DBO DBO DBO DBO DBO DBO DBO 0 

 ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ 

X=0 DB7 DB7 DB7 DB7 DB7 DB7 DB7 DB7 DB7 DB7 7 

 DB0 DB0 DB0 DB0 DB0 DB0 DB0 DB0 DB0 DB0 8 

↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ 

 DB7 DB7 DB7 DB7 DB7 DB7 DB7 DB7 DB7 DB7 55 

X=7 DB0 DBO DBO DBO DBO DBO DBO DBO DBO DBO 56 

 ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ 

 DB7 DB7 DB7 DB7 DB7 DB7 DB7 DB7 DB7 DB7 63 

 
-发送控制命令：向液晶显示模块发送控制命令的方法是通过向命令控制接口写入命令控

制字，然后再向辅助控制接口写入 0。下面给出的是基本命令字、解释和 C 语言控制语

句举例： 
.显示开关：0x3f 打开显示；0x3e 关闭显示； 
.设置显示起始行：0x0c0+起始行取值，其中起始行取值为 0 至 63； 
.设置操作页：0x0b8+页号，其中页号取值为 0-7； 
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.设置操作列：0x40+列号，其中列号为取值为 0-63； 
-写显示数据：在使用命令控制字选择操作位置(页数、列数)之后，可以将待显示的数据 
写入液晶显示模块的缓存。将数据发送到相应数据控制 I/O 接口即可。 

4．液晶显示器与 DSP 的连接： 
 

 
 
图 3.2.4.5 cd 设计原理 
 

5．数据信号的传送 
由于液晶显示模块相对运行在 150MHz 主频下的 DSP 属于较为慢速设备，连接时需要

考虑数据线上信号的等待问题； 
电平转换：由于 DSP 为 3.3V 设备，而液晶显示模块属于 5V 设备，所以在连接控制

线、数据线时需要加电平隔离和转换设备，如：ICETEK-CTR 板上使用了 74LS245。 
6．实验程序流程图 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
四．实验步骤 

开始 

初始化 DSP 时钟 

初始化 CTR 

清屏，设置显示位置 

由 0 到 9 循环显示数字 
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1．实验准备 
(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)将 ICETEK-CTR 板的供电电源开关拨动到“开”的位置。 
2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 

请参看本书第三部分、第一章、四、2。 
3．启动 Code Composer Studio 3.3 

请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

4．打开工程文件 
工程目录：C:\ICETEK\F2812 \DSP281x_examples\lab0403-lcd\V60 
浏览 LCD.c 文件的内容，理解各语句作用。 

5．编译、下载程序。 
6．运行程序观察结果 
7．将内层循环中的“CTRLCDLCR=( nBW==0 )?(ledkey[nCount][i]):(~ledkey[nCount][i]);”语句 

改为“CTRLCDRCR=( nBW==0 )?(ledkey[nCount][i]):(~ledkey[nCount][i]);”，重复步骤 5-6，
实现在屏幕右侧显示。 

8．更改程序中对页、列的设置，实现不同位置的显示。 
9．自己设计一些控制语句，实现不同显示效果。 

10．结束程序运行，退出 CCS。 
请参看本书第三部分、第一章、六。 

 
五．实验结果与分析 

实验结果：可以观察到液晶显示从 0 到 9 的计数。 
分析：灵活使用控制字，可以实现复杂多变的显示。当使用点阵图形显示时需要在 DSP

内存中建立图形存储缓冲；适当更新显示可取得动画效果。在实际生活中观察点阵显示的霓虹

灯广告、交通指示牌、报站牌等领会这种控制的具体应用。 
 

六．问题与思考 
试设计程序在液晶显示屏上显示计时时钟，精确到秒，形式为“时时：分分：秒秒”。 
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实验 4.3.2：液晶显示器控制显示(V61 版) 

 
一．实验目的 

通过实验学习使用 2812ADSP 的扩展 I/O 端口控制外围设备的方法，了解液晶显示器的显

示控制原理及编程方法。 
 

二．实验设备 
计算机，ICETEK-F2812-A 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 系统板+相关连

线及电源）。 
 

三．实验原理 
1．EMIF 接口 
TMS320F2812DSP 的扩展存储器接口(EMIF)用来与大多数外围设备进行连接，典型应用如 

连接片外扩展存储器等。这一接口提供地址连线、数据连线和一组控制线。ICETEK–F2812-A
将这些扩展线引到了板上的扩展插座上供扩展使用。 

2．液晶显示模块的访问、控制是由 2812ADSP 对扩展接口的操作完成。 
控制口的寻址：命令控制接口的地址为 0x108001，数据控制接口的地址为 0x108003 和 

0x108004，辅助控制接口的地址为 0x108002。 
3．显示控制方法： 
-液晶显示模块中有两片显示缓冲存储器，分别对应屏幕显示的象素，向其中写入数值将改 

变显示，写入“1”则显示一点，写入“0”则不显示。其地址与象素的对应方式如下： 
表 3.2.4.2 

左侧显示内存 右侧显示内存 

Y= 0 1 ··· 62 63 0 1 ··· 62 63 行号 

 DB0 DB0 DB0 DBO DBO DBO DBO DBO DBO DBO 0 

 ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ 

X=0 DB7 DB7 DB7 DB7 DB7 DB7 DB7 DB7 DB7 DB7 7 

 DB0 DB0 DB0 DB0 DB0 DB0 DB0 DB0 DB0 DB0 8 

↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ 

 DB7 DB7 DB7 DB7 DB7 DB7 DB7 DB7 DB7 DB7 55 

X=7 DB0 DBO DBO DBO DBO DBO DBO DBO DBO DBO 56 

 ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ 

 DB7 DB7 DB7 DB7 DB7 DB7 DB7 DB7 DB7 DB7 63 

 
-发送控制命令：向液晶显示模块发送控制命令的方法是通过向命令控制接口写入命令控

制字，然后再向辅助控制接口写入 0。下面给出的是基本命令字、解释和 C 语言控制语

句举例： 
.显示开关：0x3f 打开显示；0x3e 关闭显示； 
.设置显示起始行：0x0c0+起始行取值，其中起始行取值为 0 至 63； 
.设置操作页：0x0b8+页号，其中页号取值为 0-7； 
.设置操作列：0x40+列号，其中列号为取值为 0-63； 

-写显示数据：在使用命令控制字选择操作位置(页数、列数)之后，可以将待显示的数据 
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写入液晶显示模块的缓存。将数据发送到相应数据控制 I/O 接口即可。 
4．液晶显示器与 DSP 的连接： 

 

 
 
图 3.2.4.6 cd 设计原理 

5．数据信号的传送 
由于液晶显示模块相对运行在 150MHz 主频下的 DSP 属于较为慢速设备，连接时需要

考虑数据线上信号的等待问题； 
电平转换：由于 DSP 为 3.3V 设备，而液晶显示模块属于 5V 设备，所以在连接控制

线、数据线时需要加电平隔离和转换设备，如：ICETEK-CTR 板上使用了 74LS245。 
6．实验程序流程图 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
四．实验步骤 

1．实验准备 
(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)将 ICETEK-CTR 板的供电电源开关拨动到“开”的位置。 

开始 

初始化 DSP 时钟 

初始化 CTR 

清屏，设置显示位置 

由 0 到 9 循环显示数字 
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2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 
请参看本书第三部分、第一章、四、2。 

3．启动 Code Composer Studio 3.3 
请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

4．打开工程文件 
工程目录：C:\ICETEK\F2812\DSP281x_examples\lab0403-lcd\V61 
浏览 LCD.c 文件的内容，理解各语句作用。 

5．编译、下载程序。 
6．运行程序观察结果 
7．将内层循环中的“CTRLCDLCR=( nBW==0 )?(ledkey[nCount][i]):(~ledkey[nCount][i]);”语句 

改为“CTRLCDRCR=( nBW==0 )?(ledkey[nCount][i]):(~ledkey[nCount][i]);”，重复步骤 5-6，
实现在屏幕右侧显示。 

8．更改程序中对页、列的设置，实现不同位置的显示。 
9．自己设计一些控制语句，实现不同显示效果。 

10．结束程序运行，退出 CCS。 
请参看本书第三部分、第一章、六。 

 
五．实验结果与分析 

实验结果：可以观察到液晶显示从 0 到 9 的计数。 
分析：灵活使用控制字，可以实现复杂多变的显示。当使用点阵图形显示时需要在 DSP

内存中建立图形存储缓冲；适当更新显示可取得动画效果。在实际生活中观察点阵显示的霓虹

灯广告、交通指示牌、报站牌等领会这种控制的具体应用。 
 

六．问题与思考 
试设计程序在液晶显示屏上显示计时时钟，精确到秒，形式为“时时：分分：秒秒”。 
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实验 4.3.3：液晶显示器控制显示(V80 版) 

 
一．实验目的 

通过实验学习使用 2812ADSP 的扩展 I/O 端口控制外围设备的方法，了解液晶显示器的显

示控制原理及编程方法。 
 

二．实验设备 
计算机，ICETEK-F2812-EDU 实验箱（或 ICETEK 仿真器+ICETEK-F2812-A 系统板+相关

连线及电源）。 
 

三．实验原理 
1．扩展 IO 接口： 

ICETEK-F2812-A 是一块以 TMS320F2812DSP 为核心的 DSP 扩展评估板，它通过扩展接

口与实验箱的显示/控制模块连接，可以控制其各种外围设备。 
 
2．液晶显示模块的访问、控制是由 F2812  DSP 对扩展接口的操作完成。 

控制口的寻址：液晶屏幕指令寄存器 LCDCOMMAND 的地址为 Port8001，液晶屏幕参数

寄存器 LCDDATA 的地址为 Port8002，液晶屏幕状态字寄存器 LCDSTATUS 的地址为

Port8000。这几个寄存器的地址和说明请参考第二部分、第二章、五。 
 
3．显示控制方法： 

本实验中使用已写好的库函数对液晶屏幕进行操作。需要在工程文件中加入库 lcd.lib 以

及头文件 lcd.h。 
下面给出 lcd.lib 的控制液晶屏幕的接口函数及其功能描述： 

      LCDSetOrigin(int nX,int nY)： 重新设定新原点的位置，nX，nY 为新原点的坐标。初始

时默认原点为（0，0），即屏幕左下角。 
      LCDSetScreenBuffer(unsigned int *_pScreenBuffer)：设置屏幕缓冲区指针，缓冲区为

30*128 字，所有向屏幕进行的写操作都要先把数据写到缓冲区内，缓冲区位置需要在编程时

预先设定，通常开辟一个长度为 30*128 的一维数组。 
     LCDTurnOn()：   打开显示器  
     LCDTurnOff()：   关闭显示器  
     LCDCLS()：     清屏幕  
     LCDSetDelay(unsigned int nDelay) ：设置液晶读写反应时间,参数:DSP 主频 8MHz 时取 0， 
                                    160MHz 时取 1  
     _Delay(unsigned int nTime) ：延时函数  
     LCDRefreshScreen()：      用缓冲区中的数据刷新屏幕        
     LCDPutPixel(int x,int y,unsigned int color) ：写点到屏幕，输入参数坐标值和颜色，颜色 0

消点,1 画点,2 异或画点  
     LCDGraph(struct struLCDGraph *Gstru) ：按照定义的参数（在结构中）绘制图形  
     LCDWriteBytes(unsigned int *pData,int x,int y,unsigned color) ：屏幕写字符 8x8  
     LCDPutCString(unsigned int *pData,int x,int y,unsigned int nCharNumber,unsigned color) ： 

屏幕写中文字符串，*pData 为输入字符串在内存中的起始地址，x, y 为字符串左上角的 
坐标，nCharNumber 为显示的中文字数，color 为颜色。 

void LCDDrawLine(int x1,int y1,int x2,int y2,unsigned color)：在屏幕上画线段，x1, y1 为
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线段起点坐标，x2, y2 为线段终点坐标。 
关于显示字符串 LCDPutCString (unsigned int *pData,int x,int y,unsigned int 

nCharNumber,unsigned color)函数，输入的字符串数据可由字模提取插件生成，字模提取插件的

地址为 C:\ICETEK-VC5416ar-AG-EDULab\lab0403-lcd\ZI_MO.EXE。其使用步骤如下： 
1) 双击 ZI_MO.EXE 的图标，在左下角的汉字输入区键入想要生成的字符串。 
2) 点击上排中部的预览键，将字符串显示到中间部分的模拟显示区。 
3) 在上排横，纵，倒三个选项中只选择“纵”选项。 
4) 选择上下镜像选项使字符串上下颠倒。 
5) 选择生成 C51 格式的点阵数据，此时左下角的点阵数据生成区会生成 8 位宽的数据点   

阵。 
6) 将生成的 8 位数据点阵每前后相邻的两个数据和并成一个 16 位的数据，然后制作成  

数组，将其相关参数传递给 LCDPutCString 函数，即可在屏幕上显示字符串。 
 

 
 

图 3.2.4.7 
说  明： 

在进行屏幕显示时应遵循以下步骤： 
1) 调用 LCDTurnOff()函数关屏幕  
2) 调用 LCDSetScreenBuffer(unsigned int *_pScreenBuffer)函数确定屏幕缓冲区位置并清   

缓冲区 
3) 调用 LCDSetDelay(unsigned int nDelay)函数设置液晶读写反映时间 
4) 调用 LCDTurnOn()函数打开显示屏 

上下镜像 纵

点阵数据生成区 

模拟显示区 

汉字输入区 

C51 格式的点阵数据 
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5) 调用 LCDCLS()函数清屏幕 
6) 调用各种屏幕画图函数 
7) 结束程序，退出主循环依次调用函数 LCDCLS()，LCDTurnOff()，LCDSetDelay(0)，     
exit(0)关闭屏。 

 
4．液晶显示器与 DSP 的连接： 
 
 

 
图 3.2.4.8 

 
5．数据信号的传送： 

由于液晶显示模块相对运行在高主频下的 DSP 属于较为慢速设备，连接时需要考虑数据

线上信号的等待问题； 
电平转换：由于 DSP 为 3.3V 设备，而液晶显示模块属于 5V 设备，所以在连接控制线、

数据线时需要加电平隔离和转换设备，如：ICETEK-CTR 板上使用了 74LS245。 
 
 

6. 实验程序流程图 
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四．实验步骤 

1．实验准备 
(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)将 ICETEK-CTR 板的供电电源开关拨动到“开”的位置。 
 
2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 

请参看本书第三部分、第一章、四、2。 
 
3．启动 Code Composer Studio 3.3 

请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

 

初始化 DSP 

初始化液晶显示屏幕 

调用生成字符串函数在屏幕写字 

调用写点函数在屏幕画线 

调用写字符函数显示数字 0 至 9 

开始 

调用画线函数在屏幕画移动方框 

是否结 
束循环 

关屏幕，退出程序

结束 
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4．打开工程文件 
工程目录：C:\ICETEK\F2812\DSP281x_examples\lab0403-Lcd\V80 
浏览 LCD.c 文件的内容，理解各语句作用。 

 
5．编译、下载程序。 
 
6．运行程序观察结果 
 
7．更改程序中对页、列的设置，实现不同位置的显示。 
 
8．自己设计一些控制语句，实现不同显示效果。 
 
9．结束程序运行，退出 CCS。 

请参看本书第三部分、第一章、六。 
 

五．实验结果与分析 
验结果：屏幕左上角会显示教学实验箱 5 个中文字符，左下角会化出一条斜线，然后先显

示数字从 0 到 9 再从 9 到 0，最后会移动显示一个边长为 10 的正方形。 
 
六．问题与思考 

试设计程序在液晶显示屏上显示计时时钟，精确到秒，形式为“时时：分分：秒秒”。 
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实验 4.4： 键盘输入 

 
实验 4.4.1： 键盘输入(V60 版) 

 
一．实验目的 

通过实验学习使用 2812DSP 的扩展端口接收外围设备信息的方法，了解键盘的使用原理及

编程方法。 
 

二．实验设备 
计算机，ICETEK-F2812-A 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 系统板+相关连

线及电源）。 
 

三．实验原理 
1．EMIF 接口 

TMS320F2812DSP 的扩展存储器接口(EMIF)用来与大多数外围设备进行连接，典型应用

如连接片外扩展存储器等。这一接口提供地址连线、数据连线和一组控制线。ICETEK–

F2812-A 将这些扩展线引到了板上的扩展插座上供扩展使用。 
2．键盘连接原理 
 

 
图 3.2.4.9  盘设计原理 
 

 
3．键盘的扫描码由 DSP 的扩展地址 0x108001 给出，当有键盘输入时，读此端口得到扫描码，

当无键被按下时读此端口的结果为 0。各按键的扫描码排列如下所示（scancode.h）。 
#define SCANCODE_0 0x70 
#define SCANCODE_1 0x69 
#define SCANCODE_2 0x72 
#define SCANCODE_3 0x7A 
#define SCANCODE_4 0x6B 
#define SCANCODE_5 0x73 
#define SCANCODE_6 0x74 
#define SCANCODE_7 0x6C 
#define SCANCODE_8 0x75 
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#define SCANCODE_9 0x7D 
#define SCANCODE_Del 0x49 
 
#define SCANCODE_Enter 0x5A 
#define SCANCODE_Plus 0x79 
#define SCANCODE_Minus 0x7B 
#define SCANCODE_Mult 0x7C 
define SCANCODE_Divid 0x4A 
#define SCANCODE_Num 0x77 
 

4．实验程序流程图 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
                                                             
 
 
                  
四．实验步骤 

1．实验准备 
(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)连接实验箱附带的键盘的 PS2 插头到 ICETEK-CTR 的“键盘接口”P8。 
(3)将 ICETEK-CTR 板的供电电源开关拨动到“开”的位置。 

2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 
请参看本书第三部分、第一章、四、2。 

3．启动 Code Composer Studio 3.3 
请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

开始 

初始化：DSP 时钟、ICETEK-CTR 

选通发光二极管显示阵列 

有键盘输入？ 

显示字符 

否

是 

输入回车键？ 

否 

是

将扫描码转换成字符 

关闭打开的
ICETEK-CTR 

设备 

开始 
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4．打开工程文件 

工程目录：C:\ICETEK\F2812\DSP281x_examples\lab0403-Lcd\V60 
浏览 key.c 文件的内容，理解各语句作用。。 

5．编译并下载程序 
6．运行程序观察结果 
运行程序后，按小键盘上的数字键，可以看到发光二极管显示阵列上显示相应的数字。 

7.退出程序 

在小键盘上按“Enter”键，程序会退出并停止运行。 

8．结束程序运行，退出 CCS。 
请参看本书第三部分、第一章、六。 
 

五．实验结果 
实验结果：可以观察到发光二极管阵列显示键盘输入字符。 
分析：在程序中加入分支语句实现对不同键盘输入值的处理或支持控制型按键；修改程序

中键值查找表可实现按键的重新布局或修改。 
 

六．问题与思考 
-试将小键盘的其他按键都通过点阵显示出来。
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实验 4.4.2： 键盘输入(V61 版) 

 
一．实验目的 

通过实验学习使用 2812DSP 的扩展端口接收外围设备信息的方法，了解键盘的使用原理及

编程方法。 
 

二．实验设备 
计算机，ICETEK-F2812-EDU 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 系统板+相

关连线及电源）。 
 

三．实验原理 
1．EMIF 接口 

TMS320F2812DSP 的扩展存储器接口(EMIF)用来与大多数外围设备进行连接，典型应用

如连接片外扩展存储器等。这一接口提供地址连线、数据连线和一组控制线。ICETEK–

F2812-A 将这些扩展线引到了板上的扩展插座上供扩展使用。 
2．键盘连接原理 
键盘的扫描码由 DSP 的扩展地址 0x108001 给出，当有键盘输入时，读此端口得到扫描码，

当无键被按下时读此端口的结果为 0。 
9 个按键分别回读回 1-9 这九个数字。 

3．实验程序流程图 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
                                                             
 

开始 

初始化：DSP 时钟、ICETEK-CTR 

选通发光二极管显示阵列 

有键盘输入？ 

根据数字点灯 

否

是 

输入 9 键？ 

否 

是

判断是否是 1-8 数字 

关闭打开的
ICETEK-CTR 

设备 

开始 
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四．实验步骤 

1．实验准备 
(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)将 ICETEK-CTR 板的供电电源开关拨动到“开”的位置。 

2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 
请参看本书第三部分、第一章、四、2。 

3．启动 Code Composer Studio 3.3 
请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

4．打开工程文件 
工程目录：C:\ICETEK\F2812\DSP281x_examples\lab0403-Lcd\V61 
浏览 key.c 文件的内容，理解各语句作用。。 

5．编译并下载程序 
6．运行程序观察结果 
运行程序后，按键盘上的数字键，可以看到发光二极管上对应的灯会亮。 

7.退出程序 

在键盘上按“9”键，程序会退出并停止运行。 

8．结束程序运行，退出 CCS。 
请参看本书第三部分、第一章、六。 
 

五．实验结果 
实验结果：可以观察到发光二极管根据键盘上数字键是否被按下而亮或灭。 

 
六．问题与思考 

-试将键盘的按键通过 LCD 显示出来。 
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实验 4.4.3： 键盘输入(V80 版) 

 
一．实验目的 

通过实验学习使用 2812DSP 的扩展端口接收外围设备信息的方法，了解键盘的使用原理及

编程方法。 
 

二．实验设备 
计算机，ICETEK-F2812-EDU 实验箱（或 ICETEK 仿真器+ICETEK-F2812-A 系统板+相关

连线及电源）。 
 

三．实验原理 
1．扩展 IO 接口： 

ICETEK-F2812 是一块以 TMS320F2812DSP 为核心的 DSP 扩展评估板，它通过扩展 IO
接口与实验箱的显示/控制模块连接，可以控制其各种外围设备，也可以接收外设发送的

各种数据、信息。 
 
2．键盘控制方法：键盘接收寄存器 MCTRKEY 地址由 0x108005 给出，键盘清除寄存器

CTRCLKEY 地址由 0x108006 给出。使能液晶模块后，每当有键盘按下，MCTRKEY 中

的相应位就会置 1，向 CTRCLKEY 中写入 0 会将 MCTRKEY 清零。 
 
3．实验程序流程图：  

四．实验步骤 

开始 

初始化液晶屏幕 

读键盘接收寄 
存器并清键盘 

是否有键

盘输入 

将相应指示

灯置位 
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1．实验准备 
(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)将 ICETEK-CTR 板的供电电源开关拨动到“开”的位置。 

 
2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 

请参看本书第三部分、第一章、四、2。 
 
3．启动 Code Composer Studio 3.3 

请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

 
4．打开工程文件 

工程目录：C:\ICETEK\F2812\DSP281x_examples\lab0403-Lcd\V80 
浏览 key.c 文件的内容，理解各语句作用。。 

 
5．编译并下载程序 
 
6．运行程序观察结果 
运行程序后，按下键盘 K1-K8 的任意键，指示灯 led4-led11 中会有一个相应的指示灯点亮。 

 
7．结束程序运行，退出 CCS。 
请参看本书第三部分、第一章、六。 
 

五．实验结果 
实验结果：可以观察到指示灯 led4-led11 受键盘控制点亮熄灭。 
分析：在程序中加入分支语句实现对不同键盘输入值的处理或支持控制型按键。 

 
六．问题与思考 
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实验 4.5：外设控制实验—音频信号发生实验 

 
实验 4.5.1：外设控制实验—音频信号发生实验(V60 版) 

 
一．实验目的 

通过实验学习使用 2812DSP 的扩展端口控制外围设备信息的方法，掌握使用 2812DSP 通 
用计时器的控制原理及中断服务程序的编程方法；了解蜂鸣器发声原理和音乐发生方法。 
二．实验设备 

计算机，ICETEK-F2812-A 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 系统板+相关连

线及电源）。 
三．实验原理 

1．EMIF 接口 
TMS320F2812DSP 的扩展存储器接口(EMIF)用来与大多数外围设备进行连接，典型应用

如连接片外扩展存储器等。这一接口提供地址连线、数据连线和一组控制线。ICETEK–

F2812-A 将这些扩展线引到了板上的扩展插座上供扩展使用。 
2．蜂鸣器由 DSP 上 PWM2 设置为通用 I/O 管脚输出控制，可将此管脚上的频率输出转换成

声音输出。 
控制的方法是使用 DSP 通用定时器设置 PWM2 管脚以一定的频率改变高低状态，输出

方波。对于通用定时器周期寄存器的设置，计数值为所需频率计数值的二分之一。 
 
音乐的频率(C 调)： 

   C   D  E   F   G   A   B    ^C 
   1   2   3   4   5    6   7    ^1 

C: 264, 297, 330,352, 396,  440,495,  528 
 

4． 蜂鸣器的连接：由于选用的蜂鸣器所需电流较小，所以采用将 DSP 通用 I/O 引脚直接

驱动的方式。 
 

 
                               

图 3.2.4.10  蜂鸣器设计原理 
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4．实验程序流程图 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
四．实验步骤 

1．实验准备 
(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)连接实验箱附带的键盘的 PS2 插头到 ICETEK-CTR 的“键盘接口”P8。 
(3)将 ICETEK-CTR 板的供电电源开关拨动到“开”的位置。 

    注意：要把 CTR 扩展模块上的“功能选择”中的 1 设置为 on 状态。 

2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 
请参看本书第三部分、第一章、四、2。 

3．启动 Code Composer Studio 3.3 
请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

4．打开工程文件 
工程目录：C:\ICETEK\F2812\DSP281x_examples\lab0405-Speaker\V60 
浏览 sperker.c 文件的内容，理解各语句作用。 

5．编译并下载程序 
6．运行程序观察结果 
7．将语句“delay(music[nCount][1]);”改为“delay(music[nCount][1]/2);”，重复步骤 5-6，体

会音乐的节奏快了一倍。 
8．结束程序运行，退出 CCS。 

按小键盘上“Enter”键，停止程序。退出，请参看本书第三部分、第一章、六。 
五．实验结果 

实验结果：可以听到蜂鸣器发出的音乐声。 
分析：程序中使用循环延时的方法掌握节拍，可考虑使用定时器计数改变音符，更复杂的

方法可以产生语音效果。 
六．问题与思考 

结合键盘控制程序，设计一个按键“弹琴”的程序。

开始

初始化：DSP 时钟、ICETEK-CTR 

选通蜂鸣器 

设置 PWM2 控制寄存器输出

初始化中断向量和定时器 

初始化音长，音高等参数 

根据预定的数据切换音符 

中断服务程序开始 

改变 PWM2 引脚的状态 
（通过不同的定时器周期设置产

生不同频率） 

中断服务程序结束
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实验 4.5.2：外设控制实验—音频信号发生实验(V61 版) 

 
一．实验目的 

通过实验学习使用 2812DSP 的扩展端口控制外围设备信息的方法，掌握使用 2812DSP 通 
用计时器的控制原理及中断服务程序的编程方法；了解蜂鸣器发声原理和音乐发生方法。 

 
二．实验设备 

计算机，ICETEK-F2812-EDU 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 系统板+相
关连线及电源）。 

 
三．实验原理 

1．EMIF 接口 
TMS320F2812DSP 的扩展存储器接口(EMIF)用来与大多数外围设备进行连接，典型应用

如连接片外扩展存储器等。这一接口提供地址连线、数据连线和一组控制线。ICETEK–

F2812-A 将这些扩展线引到了板上的扩展插座上供扩展使用。 
2．蜂鸣器由 DSP 上 PWM2 设置为通用 I/O 管脚输出控制，可将此管脚上的频率输出转换成

声音输出。 
控制的方法是使用 DSP 通用定时器设置 PWM2 管脚以一定的频率改变高低状态，输出

方波。对于通用定时器周期寄存器的设置，计数值为所需频率计数值的二分之一。 
 
音乐的频率(C 调)： 

   C   D  E   F   G   A   B    ^C 
   1   2   3   4   5    6   7    ^1 

C: 264, 297, 330,352, 396,  440,495,  528 
 
3．蜂鸣器的连接：由于选用的蜂鸣器所需电流较小，所以采用将 DSP 通用 I/O 引脚直接驱

动的方式。 
 

 
                               

图 3.2.4.11  蜂鸣器设计原理 
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4．实验程序流程图 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
四．实验步骤 

1．实验准备 
(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)将 ICETEK-CTR 板的供电电源开关拨动到“开”的位置。 

    注意:只有 2812 的实验箱须在扩展模块上的“JP1”跳线设置为 2，3连接方式，其他系列

dsp 板卡须设置为 1，2 连接状态。 

2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 
请参看本书第三部分、第一章、四、2。 

3．启动 Code Composer Studio 3.3 
请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

4．打开工程文件 
工程目录：C:\ICETEK\F2812\DSP281x_examples\lab0405-Speaker\V61 
浏览 sperker.c 文件的内容，理解各语句作用。 

5．编译并下载程序 
6．运行程序观察结果 
7．将语句“delay(music[nCount][1]);”改为“delay(music[nCount][1]/2);”，重复步骤 5-6，体

会音乐的节奏快了一倍。 
8．结束程序运行，退出 CCS。 

按键盘上“9”键，停止程序。退出，请参看本书第三部分、第一章、六。 
 

五．实验结果 
实验结果：可以听到蜂鸣器发出的音乐声。 
分析：程序中使用循环延时的方法掌握节拍，可考虑使用定时器计数改变音符，更复杂的

方法可以产生语音效果。 
 

六．问题与思考 
结合键盘控制程序，设计一个按键“弹琴”的程序。 

开始

初始化：DSP 时钟、ICETEK-CTR 

选通蜂鸣器 

设置 PWM2 控制寄存器输出

初始化中断向量和定时器 

初始化音长，音高等参数 

根据预定的数据切换音符 

中断服务程序开始 

改变 PWM2 引脚的状态 
（通过不同的定时器周期设置产

生不同频率） 

中断服务程序结束
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实验 4.5.3：外设控制实验—音频信号发生实验(V80 版) 

 
一．实验目的 

通过实验学习使用 2812DSP 的扩展端口控制外围设备信息的方法，掌握使用 2812DSP 通 
用计时器的控制原理及中断服务程序的编程方法；了解蜂鸣器发声原理和音乐发生方法。 

 
二．实验设备 

计算机，ICETEK-F2812-EDU 实验箱（或 ICETEK 仿真器+ICETEK-F2812-A 系统板+相关

连线及电源）。 
 

三．实验原理 
1．EMIF 接口 

TMS320F2812DSP 的扩展存储器接口(EMIF)用来与大多数外围设备进行连接，典型应用

如连接片外扩展存储器等。这一接口提供地址连线、数据连线和一组控制线。

ICETEK-F2812-A 将这些扩展线引到了板上的扩展插座上供扩展使用。 
 
2．蜂鸣器由 DSP 上 PWM2 设置为通用 I/O 管脚输出控制，可将此管脚上的频率输出转换成

声音输出。 
控制的方法是使用 DSP 通用定时器设置 PWM2 管脚以一定的频率改变高低状态，输出

方波。对于通用定时器周期寄存器的设置，计数值为所需频率计数值的二分之一。 
 
音乐的频率(C 调)： 

   C   D  E   F   G   A   B    ^C 
   1   2   3   4   5    6   7    ^1 

C: 264, 297, 330,352, 396,  440,495,  528 
 
3．蜂鸣器的连接：由于选用的蜂鸣器所需电流较小，所以采用将 DSP 通用 I/O 引脚直接驱

动的方式。 
 

 
                               

图 3.2.4.12 蜂鸣器设计原理 
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4．实验程序流程图 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
四．实验步骤 

1．实验准备 
(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)将 ICETEK-CTR 板的供电电源开关拨动到“开”的位置。 
注意：将 CTR 控制模块中的 S1 的拨码开关的 1 设置为 on 

 
2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 

请参看本书第三部分、第一章、四、2。 
 
3．启动 Code Composer Studio 3.3 

请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

 
4．打开工程文件 

工程目录：C:\ICETEK\F2812\DSP281x_examples\lab0405-Speaker\V80 
浏览 sperker.c 文件的内容，理解各语句作用。 

 
5．编译并下载程序 
 
6．运行程序观察结果 
 
7．将语句“delay(music[nCount][1]);”改为“delay(music[nCount][1]/2);”，重复步骤 5-6，体

会音乐的节奏快了一倍。 
 

五．实验结果 
实验结果：可以听到蜂鸣器发出的音乐声。 
分析：程序中使用循环延时的方法掌握节拍，可考虑使用定时器计数改变音符，更复杂的

方法可以产生语音效果。 
 

六．问题与思考 
结合键盘控制程序，设计一个按键“弹琴”的程序。 
 

开始

初始化：DSP 时钟、ICETEK-CTR 

选通蜂鸣器 

设置 PWM2 控制寄存器输出

初始化中断向量和定时器 

初始化音长，音高等参数 

根据预定的数据切换音符 

中断服务程序开始 

改变 PWM2 引脚的状态 
（通过不同的定时器周期设置产

生不同频率） 

中断服务程序结束
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实验 4.6：直流电机控制实验 
 

实验 4.6.1：直流电机控制实验(V60 版) 
 

一．实验目的 
1． 学习用 C 语言编制中断程序，控制 F2812 DSP 通用 I/O 管脚产生不同占空比的 PWM 信

号。 

2．学习 F2812DSP 的通用 I/O 管脚的控制方法。 

3．学习直流电机的控制原理和控制方法。 

 

二．实验设备 
计算机，ICETEK-F2812-A 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 系统板+相关连

线及电源）。 

 

三．实验原理 
1．TMS320F2812DSP 的 McBSP 引脚 

通过设置 PWM11 和 PWM5 的工作方式和状态，可以实现将它们当成通用 I/O 引脚使用。 

2．直流电机控制 

直流电动机是最早出现的电动机，也是最早能实现调速的电动机。近年来，直流电动机

的结构和控制方式都发生了很大的变化。随着计算机进入控制领域，以及新型的电力电子功

率元器件的不断出现，使采用全控型的开关功率元件进行脉宽调制(Puls Width Modulation，

简称 PWM)控制方式已成为绝对主流。 

PWM 调压调速原理 

直流电动机转速 n 的表达式为： 

Φ
−

=
K

IRUn  

 

其中，U 为电枢端电压；I 为电枢电流；R 为电枢电路总电阻；Φ为每极磁通量；K 为 

电动机结构参数。 

所以直流电动机的转速控制方法可分为两类：对励磁磁通进行控制的励磁控制法和对电

枢电压进行控制的电枢控制法。其中励磁控制法在低速时受磁极饱和的限制，在高速时受换

向火花和换向器结构强度的限制，并且励磁线圈电感较大，动态响应较差，所以这种控制方

法用得很少。现在，大多数应用场合都使用电枢控制法。绝大多数直流电机采用开关驱动方

式。开关驱动方式是使半导体功率器件工作在开关状态，通过脉宽调制 PWM 来控制电动机
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电枢电压，实现调速。 
 
 

 

 
 
                             图 3.2.4.13  直流电机设计原理 
 

上图是利用开关管对直流电动机进行 PWM 调速控制的原理图和输入输出电压波形。图中，

当开关管 MOSFET 的栅极输入高电平时，开关管导通，直流电动机电枢绕组两端有电压 Us。
t1 秒后，栅极输入变为低电平，开关管截止，电动机电枢两端电压为 0。t2 秒后，栅极输入重

新变为高电平，开关管的动作重复前面的过程。这样，对应着输入的电平高低，直流电动机电

枢绕组两端的电压波形如图中所示。电动机的电枢绕组两端的电压平均值 Uo 为 
 

SS
S

O UU
T
t

tt
Ut

U α==
+

+
= 1

21

1 0
    式中α为占空比，α=t1/T 

 
占空比α表示了在一个周期 T 里，开关管导通的时间与周期的比值。α的变化范围为 0

≤α≤1。由此式可知，当电源电压 Us 不变的情况下，电枢的端电压的平均值 Uo 取决于占

空比α的大小，改变α值就可以改变端电压的平均值，从而达到调速的目的，这就是 PWM
调速原理。 

PWM 调速方法： 
在 PWM 调速时，占空比α是一个重要参数。以下 3 种方法都可以改变占空比的值： 
(1)定宽调频法：这种方法是保持 t1 不变，只改变 t2，这样使周期 T(或频率)也随之改变。 
(2)调宽调频法：这种方法是保持 t2 不变，只改变 t1，这样使周期 T(或频率)也随之改变。 
(3)定频调宽法：这种方法是使周期 T(或频率)保持不变，而改变 t1 和 t2。 
前两种方法由于在调速时改变了控制脉冲的周期(或频率)，当控制脉冲的频率与系统的 
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固有频率接近时，将会引起震荡，因此这两种方法用得很少。目前，在直流电动机的控制中，

主要使用定频调宽法。 
3．ICETEK-CTR 直流电机模块 

原理图 
ICETEK-CTR 即显示/控制模块上直流电机部分的原理图见下图。 

 

 
 

图 3.2.4.14  ICETEK-CTR 直流电机模块 
 

图中 PWM 输入对应 ICETEK–F2812-A 评估板上 P4 外扩插座第 26 引脚的 PWM11 信

号，DSP 将在此引脚上给出 PWM 信号用来控制直流电机的转速；图中的 DIR 输入对应

ICETEK–F2812-A 评估板上 P1 外扩插座第 6 引脚的 P4 信号，DSP 将在此引脚上给出高电

平或低电平来控制直流电机的方向。从 DSP 输出的 PWM 信号和转向信号先经过 2 个与门和

1 个非门再与各个开关管的栅极相连。 

控制原理 

当电动机要求正转时，PWM11 给出高电平信号，该信号分成 3 路：第 1 路接与门 Y1

的输入端，使与门 Y1 的输出由 PWM 决定，所以开关管 V1 栅极受 PWM 控制；第 2 路直接

与开关管 V4 的栅极相连，使 V4 导通；第 3 路经非门 F1 连接到与门 Y2 的输入端，使与门

Y2 输出为 0，这样使开关管 V3 截止；从非门 F1 输出的另一路与开关管 V2 的栅极相连，其

低电平信号也使 V2 截止。 

同样，当电动机要求反转时，PWM5 给出低电平信号，经过 2 个与门和 1 个非门组成的

逻辑电路后，使开关管 V3 受 PWM 信号控制，V2 导通，V1、V4 全部截止。 

4．程序编制 

程序中采用定时器中断产生固定频率的 PWM 波，在每个中断中根据当前占空比判断应

输出波形的高低电平。 

主程序用轮询方式读入键盘输入，得到转速和方向控制命令。 
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在改变电机方向时为减少电压和电流的波动采用先减速再反转的控制顺序。 

  5．实验程序流程图 
 
 
 
 
 
                                             
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
                          否 
 

 
 
 
                          是 
 
 
 
 

 

 
 
 
 
 
 
 
 

开始 

初始化：DSP 时钟 

初始化中断寄存器、定时器 

初始化 ICETEK-CTR，直流电机使能

初始化 PWM11 和 PWM5 输出控制） 

改变 PWM5 状态 

键盘输入“Enter”? 

键盘检测 

如输入 0-5 则根据输入调整占空比 

中断服务程序开始 

比较计数器与占空比的

当前值设置 PWM11 引脚

的状态 

中断服务程序结束 

计数器加 1，从 0-99 

键盘输入方向? 
退出 

关闭 ICETEK-CTR 使用设备 

是 

否 



   REALTIME—DSP 系列应用丛书 

 
 
地址：北京市海淀区知春路 108 号豪景大厦 A 座 18 层                     http://www.realtimedsp.com.cn 
电话：010-62105690(中继)/91-97                                         传真：010-62105699   

134 

 
四．实验步骤 

1．实验准备 
(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)连接实验箱附带的键盘的 PS2 插头到 ICETEK-CTR 的“键盘接口”P8。 
(3)将 ICETEK-CTR 板的供电电源开关拨动到“开”的位置。 

注意：要把 CTR 扩展模块上的“功能选择”中的 1 设置为 on 状态。 

2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 
请参看本书第三部分、第一章、四、2。 

3．启动 Code Composer Studio 3.3 
请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

4．打开工程文件 
工程目录：C:\ICETEK\F2812\DSP281x_examples\lab0406-Dcmotor\V60 
浏览 dcmotor.c 文件的内容，理解各语句作用。 

5．编译并下载程序 
6．运行并观察程序运行结果 

开始运行程序后，电机以中等速度转动(占空比=60，转速=2)。 
在小键盘上按数字‘1’～‘5’键将分别控制电机从低速到高速转动(转速=1～5)。 
在小键盘上按‘+’或‘-’键切换电机的转动方向。 

如果程序退出或中断时电机不停转动，可以将控制 ICETEK-CTR 模块的电源开关关

闭再开启一次。 
有时键盘控制不是非常灵敏，这是因为程序采用了轮询方式读键盘输入的结果，可

以多按几次按键。 
7．结束程序运行 

在小键盘上按‘Enter’键停止电机转动并退出程序。 
8．退出 CCS。 

请参看本书第三部分、第一章、六。 
 

五．实验结果 
通过实验可以发现，直流电机受控改变转速和方向。 

 
六．问题与思考 

电动机是一个电磁干扰源。电动机的启停还会影响电网电压的波动，它周围的电器开关也

会引发火花干扰。因此，除了采用必要的隔离、屏蔽和电路板合理布线等措施外，看门狗的功

能就会显得格外重要。看门狗在工作时不断地监视程序运行的情况，一旦程序“跑飞”，会立

刻使 DSP 复位。
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实验 4.6.2：直流电机控制实验(V61 版) 

 
一．实验目的 

1．学习用 C 语言编制中断程序，控制 F2812 DSP 通用 I/O 管脚产生不同占空比的 PWM 信

号。 

2．学习 F2812DSP 的通用 I/O 管脚的控制方法。 

3．学习直流电机的控制原理和控制方法。 

 

二．实验设备 
计算机，ICETEK-F2812-EDU 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 系统板+相

关连线及电源）。 

 

三．实验原理 
1．TMS320F2812DSP 的 McBSP 引脚 

通过设置 PWM11 和 PWM5 的工作方式和状态，可以实现将它们当成通用 I/O 引脚使用。 

2．直流电机控制 

直流电动机是最早出现的电动机，也是最早能实现调速的电动机。近年来，直流电动机

的结构和控制方式都发生了很大的变化。随着计算机进入控制领域，以及新型的电力电子功

率元器件的不断出现，使采用全控型的开关功率元件进行脉宽调制(Puls Width Modulation，

简称 PWM)控制方式已成为绝对主流。 

PWM 调压调速原理 

直流电动机转速 n 的表达式为： 

Φ
−

=
K

IRUn  

 

其中，U 为电枢端电压；I 为电枢电流；R 为电枢电路总电阻；Φ为每极磁通量；K 为 

电动机结构参数。 

所以直流电动机的转速控制方法可分为两类：对励磁磁通进行控制的励磁控制法和对电

枢电压进行控制的电枢控制法。其中励磁控制法在低速时受磁极饱和的限制，在高速时受换

向火花和换向器结构强度的限制，并且励磁线圈电感较大，动态响应较差，所以这种控制方

法用得很少。现在，大多数应用场合都使用电枢控制法。绝大多数直流电机采用开关驱动方

式。开关驱动方式是使半导体功率器件工作在开关状态，通过脉宽调制 PWM 来控制电动机

电枢电压，实现调速。 
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                             图 3.2.4.15 直流电机设计原理 
 

上图是利用开关管对直流电动机进行 PWM 调速控制的原理图和输入输出电压波形。图中，

当开关管 MOSFET 的栅极输入高电平时，开关管导通，直流电动机电枢绕组两端有电压 Us。
t1 秒后，栅极输入变为低电平，开关管截止，电动机电枢两端电压为 0。t2 秒后，栅极输入重

新变为高电平，开关管的动作重复前面的过程。这样，对应着输入的电平高低，直流电动机电

枢绕组两端的电压波形如图中所示。电动机的电枢绕组两端的电压平均值 Uo 为 
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    式中α为占空比，α=t1/T 

 
占空比α表示了在一个周期 T 里，开关管导通的时间与周期的比值。α的变化范围为 0

≤α≤1。由此式可知，当电源电压 Us 不变的情况下，电枢的端电压的平均值 Uo 取决于占

空比α的大小，改变α值就可以改变端电压的平均值，从而达到调速的目的，这就是 PWM
调速原理。 

PWM 调速方法： 
在 PWM 调速时，占空比α是一个重要参数。以下 3 种方法都可以改变占空比的值： 
(1)定宽调频法：这种方法是保持 t1 不变，只改变 t2，这样使周期 T(或频率)也随之改变。 
(2)调宽调频法：这种方法是保持 t2 不变，只改变 t1，这样使周期 T(或频率)也随之改变。 
(3)定频调宽法：这种方法是使周期 T(或频率)保持不变，而改变 t1 和 t2。 
前两种方法由于在调速时改变了控制脉冲的周期(或频率)，当控制脉冲的频率与系统的 

固有频率接近时，将会引起震荡，因此这两种方法用得很少。目前，在直流电动机的控制中，

主要使用定频调宽法。 
3．ICETEK-CTR 直流电机模块 
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原理图 
ICETEK-CTR 即显示/控制模块上直流电机部分的原理图见下图。 

 

 
 

图 3.2.4.16  ICETEK-CTR 直流电机模块 
 

图中 PWM 输入对应 ICETEK–F2812-A 评估板上 P4 外扩插座第 26 引脚的 PWM11 信

号，DSP 将在此引脚上给出 PWM 信号用来控制直流电机的转速；图中的 DIR 输入对应

ICETEK–F2812-A 评估板上 P1 外扩插座第 6 引脚的 P4 信号，DSP 将在此引脚上给出高电

平或低电平来控制直流电机的方向。从 DSP 输出的 PWM 信号和转向信号先经过 2 个与门和

1 个非门再与各个开关管的栅极相连。 

控制原理 

当电动机要求正转时，PWM11 给出高电平信号，该信号分成 3 路：第 1 路接与门 Y1

的输入端，使与门 Y1 的输出由 PWM 决定，所以开关管 V1 栅极受 PWM 控制；第 2 路直接

与开关管 V4 的栅极相连，使 V4 导通；第 3 路经非门 F1 连接到与门 Y2 的输入端，使与门

Y2 输出为 0，这样使开关管 V3 截止；从非门 F1 输出的另一路与开关管 V2 的栅极相连，其

低电平信号也使 V2 截止。 

同样，当电动机要求反转时，PWM5 给出低电平信号，经过 2 个与门和 1 个非门组成的

逻辑电路后，使开关管 V3 受 PWM 信号控制，V2 导通，V1、V4 全部截止。 

4．程序编制 

程序中采用定时器中断产生固定频率的 PWM 波，在每个中断中根据当前占空比判断应

输出波形的高低电平。 

主程序用轮询方式读入键盘输入，得到转速和方向控制命令。 

在改变电机方向时为减少电压和电流的波动采用先减速再反转的控制顺序。 

  5．实验程序流程图 
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开始 

初始化：DSP 时钟 

初始化中断寄存器、定时器 

初始化 ICETEK-CTR，直流电机使能

初始化 PWM11 和 PWM5 输出控制） 

改变 PWM5 状态 

键盘输入“9”? 

键盘检测 

如输入 1-6 则根据输入调整占空比 

中断服务程序开始 

比较计数器与占空比的

当前值设置 PWM11 引脚

的状态 

中断服务程序结束 

计数器加 1，从 0-99 

键盘输入 7 或 8 改变方向? 

退出 

关闭 ICETEK-CTR 使用设备 

是 

否 
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四．实验步骤 

1．实验准备 
(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)将 ICETEK-CTR 板的供电电源开关拨动到“开”的位置。 

注意:只有 2812 的实验箱须在扩展模块上的“JP1”跳线设置为 2，3 连接方式，其他

系列 dsp 板卡须设置为 1，2 连接状态。 

2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 
请参看本书第三部分、第一章、四、2。 

3．启动 Code Composer Studio 3.3 
请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

4．打开工程文件 
工程目录：C:\ICETEK\F2812\DSP281x_examples\lab0406-Dcmotor\V61 
浏览 dcmotor.c 文件的内容，理解各语句作用。 

5．编译并下载程序 
6．运行并观察程序运行结果 

开始运行程序后，电机以中等速度转动(占空比=60，转速=2)。 
在键盘上按数字‘1’～‘6’键将分别控制电机从低速到高速转动(转速=1～5)。 
在键盘上按‘7’或‘8’键切换电机的转动方向。 

如果程序退出或中断时电机不停转动，可以将控制 ICETEK-CTR 模块的电源开关关

闭再开启一次。 
有时键盘控制不是非常灵敏，这是因为程序采用了轮询方式读键盘输入的结果，可

以多按几次按键。 
7．结束程序运行 

在键盘上按‘9’键停止电机转动并退出程序。 
8．退出 CCS。 

请参看本书第三部分、第一章、六。 
 

五．实验结果 
通过实验可以发现，直流电机受控改变转速和方向。 

 
六．问题与思考 

电动机是一个电磁干扰源。电动机的启停还会影响电网电压的波动，它周围的电器开关也

会引发火花干扰。因此，除了采用必要的隔离、屏蔽和电路板合理布线等措施外，看门狗的功

能就会显得格外重要。看门狗在工作时不断地监视程序运行的情况，一旦程序“跑飞”，会立

刻使 DSP 复位。 
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实验 4.7：步进电机控制 

 
实验 4.7.1：步进电机控制(V60 版) 

 
一． 实验目的 

通过实验学习使用 2812DSP 的扩展 I/O 端口控制外围设备信息的方法，掌握使用 2812DSP
通用计时器的控制原理及中断服务程序的编程方法；了解步进电机的控制方法。 

 
二． 实验设备 

计算机，ICETEK-F2812-A 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 系统板+相关连

线及电源）。 
 

三．实验原理 
1．EMIF 接口 

TMS320F2812DSP 的扩展存储器接口(EMIF)用来与大多数外围设备进行连接，典型应用

如连接片外扩展存储器等。这一接口提供地址连线、数据连线和一组控制线。ICETEK–

F2812-A 将这些扩展线引到了板上的扩展插座上供扩展使用。 
2．步进电机是由 DSP 通用 I/O 管脚输出直接控制。步进电机的起动频率大于 500PPS(拍每

秒)，空载运行频率大于 900PPS。 

 
图 3.2.4.17  步进电机设计原理 

 
 

3．实验程序流程图： 
 
 
 
 
 
 
 
 
 
 

中断服务程序开始 

送计数器相应的控制字到步进电机驱动器 

中断服务程序结束

根据标志计数器加 1 或减 1，从 0-7 共 8 拍 
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四. 实验步骤 

1．实验准备 
(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)连接实验箱附带的键盘的 PS2 插头到 ICETEK-CTR 的“键盘接口”P8。 
(3)将 ICETEK-CTR 板的供电电源开关拨动到“开”的位置。 

2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 
请参看本书第三部分、第一章、四、2。 

3．启动 Code Composer Studio 3.3 
请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

4．打开工程文件 
工程目录：C:\ICETEK\F2812\DSP281x_examples\lab0407-SAMotor\V60 
浏览 samotor.c 文件的内容，理解各语句作用。 

5．编译并下载程序 
6．运行程序，观察结果 

开始 

初始化：DSP 时钟 

初始化中断寄存器、定时器 

初始化 ICETEK-CTR，步进电机使能

计数器计数方向，反向送控制字 

键盘输入“Enter”? 

键盘检测

如输入“+”或“-”调整速度 

键盘输入方向? 
退出 

关闭 ICETEK-CTR 使用设备 
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电机转动时按下 ICETEK-CTR 板上连接的小键盘中“4”和“6” 键，控制电机转动方向。 
用“+”和“-”键可微调速度。 

7．停止程序运行并退出 
8．退出 CCS。 

请参看本书第三部分、第一章、六。 
 

五. 实验结果 
实验结果：可以看到显示/控制模块上的电机指针在转动，使用“4”和“6”键可控制其转

动方向。 
分析：使用优化的程序可控制电机更平滑地转动，平滑地改变频率可使马达的摆动减到最

小。 
 

六. 问题与思考 
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实验 4.7.2：步进电机控制(V61 版) 

 
三． 实验目的 

通过实验学习使用 2812DSP 的扩展 I/O 端口控制外围设备信息的方法，掌握使用 2812DSP
通用计时器的控制原理及中断服务程序的编程方法；了解步进电机的控制方法。 

 
四． 实验设备 

计算机，ICETEK-F2812-EDU 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 系统板+相
关连线及电源）。 

 
三．实验原理 

1．EMIF 接口 
TMS320F2812DSP 的扩展存储器接口(EMIF)用来与大多数外围设备进行连接，典型应用

如连接片外扩展存储器等。这一接口提供地址连线、数据连线和一组控制线。ICETEK–

F2812-A 将这些扩展线引到了板上的扩展插座上供扩展使用。 
2．步进电机是由 DSP 通用 I/O 管脚输出直接控制。步进电机的起动频率大于 500PPS(拍每

秒)，空载运行频率大于 900PPS。 

 
图 3.2.4.18  步进电机设计原理 

 
 

3．实验程序流程图： 
 
 
 
 
 
 
 
 
 
 

 
 

中断服务程序开始 

送计数器相应的控制字到步进电机驱动器 

中断服务程序结束

根据标志计数器加 1 或减 1，从 0-7 共 8 拍 
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四. 实验步骤 

1．实验准备 
(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)将 ICETEK-CTR 板的供电电源开关拨动到“开”的位置。 

2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 
请参看本书第三部分、第一章、四、2。 

3．启动 Code Composer Studio 3.3 
请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

4．打开工程文件 
工程目录：C:\ICETEK\F2812\DSP281x_examples\lab0407-SAMotor\V61 
浏览 samotor.c 文件的内容，理解各语句作用。 

5．编译并下载程序 
6．运行程序，观察结果 

 
电机转动时按下 ICETEK-CTR 板上连接的键盘中“4”和“6” 键，控制电机转动方向。 

开始 

初始化：DSP 时钟 

初始化中断寄存器、定时器 

初始化 ICETEK-CTR，步进电机使能

计数器计数方向，反向送控制字 

键盘输入“9”? 

键盘检测

键盘输入 4 或 6 控制方向? 

退出 

关闭 ICETEK-CTR 使用设备 
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用“+”和“-”键可微调速度。 
7．停止程序运行并退出 
8．退出 CCS。 

请参看本书第三部分、第一章、六。 
 

五. 实验结果 
实验结果：可以看到显示/控制模块上的电机指针在转动，使用“4”和“6”键可控制其转

动方向。 
分析：使用优化的程序可控制电机更平滑地转动，平滑地改变频率可使马达的摆动减到最

小。 
 

六. 问题与思考 
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五．DSP 算法实验 

 
实验 5.1：有限冲击响应滤波器（FIR）算法实验 

 
一．实验目的 

1.握用窗函数法设计 FIR 数字滤波器的原理和方法。 
2.熟悉线性相位 FIR 数字滤波器特性。 
3.了解各种窗函数对滤波器特性的影响。 

 
二．实验设备 

PC 兼容机一台，操作系统为 Windows2000(或 Windows98，WindowsXP，以下默认为

Windows2000)，安装 Code Composer Studio 3.3 软件。 
 

三．实验原理 
1．有限冲击响应数字滤波器的基础理论(请参考相关书籍)。 
2．模拟滤波器原理（巴特沃斯滤波器、切比雪夫滤波器、椭圆滤波器、贝塞尔滤波器）。 
3．数字滤波器系数的确定方法。 
4．根据要求设计低通 FIR 滤波器 

要求：通带边缘频率 10kHz，阻带边缘频率 22kHz，阻带衰减 75dB，采样频率 50kHz。 
设计： 

-过渡带宽度=阻带边缘频率-通带边缘频率=22-10=12kHz 
-采样频率： 

f1=通带边缘频率+(过渡带宽度)/2=10000+12000/2=16kHz 
Ω1=2πf1/fs=0.64π 

-理想低通滤波器脉冲响应： 
h1[n]=sin(nΩ1)/n/π=sin(0.64πn)/n/π 

-根据要求，选择布莱克曼窗，窗函数长度为： 
N=5.98fs/过渡带宽度=5.98*50/12=24.9 

-选择 N=25，窗函数为： 
w[n]=0.42+0.5cos(2πn/24)+0.8cos(4πn/24) 

-滤波器脉冲响应为： 
h[n]=h1[n]w[n]       |n|≤12 
h[n]=0              |n|＞12 

-根据上面计算，各式计算出 h[n]，然后将脉冲响应值移位为因果序列。 
-完成的滤波器的差分方程为： 

y[n]=-0.001x[n-2]-0.002x[n-3]-0.002x[n-4]+0.01x[n-5] 
      -0.009x[n-6]-0.018x[n-7]-0.049x[n-8]-0.02x[n-9] 

+0.11x[n-10]+0.28x[n-11]+0.64x[n-12] 
+0.28x[n-13]-0.11x[n-14]-0.02x[n-15] 
+0.049x[n-16]-0.018x[n-17]-0.009x[n-18]+0.01x[n-19] 
-0.002x[n-20]-0.002x[n-21]+0.001x[n-22] 
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5．程序流程图： 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
四．实验步骤 

1．实验准备 
-设置软件仿真模式，参看：第三部分、四、1。 
-启动 CCS，参看：第三部分、五、1。 

2．打开工程，浏览程序：工程目录为 C:\ICETEK\F2812\DSP281x_examples\lab0501-FIR 
3．编译并下载程序 
4．打开观察窗口 

*选择菜单 View->Graph->Time/Frequency…，进行如下设置： 
 

 
 

图 3.2.5.1  观察窗口设置 1 
 

开始 

初始化工作变量 

调用波形发生子程序

产生混叠的波形(高
频+低频) 

调用 FIR 滤波子程 
序计算当前输出 

波形发生 

计算步长 

用标准 C 的 sin 函数

和 cos 函数计算当前

波形值 

返回波形值 

FIR 滤波 

用滤波器系数乘以保

存的 N-1 个输入值和

当前输入值并求和 

返回计算结果 
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*选择菜单 View->Graph->Time/Frequency…，进行如下设置： 
 

 
 

图 3.2.5.2  观察窗口设置 2 
 
 

在弹出的图形窗口中单击鼠标右键，选择“Clear Display”。 
5．设置断点 

在有注释“/* 请在此句上设置软件断点 */”的语句设置软件断点。 
6．运行并观察结果 
⑴选择“Debug”菜单的“RUN”项，或按 F12 键运行程序。 
⑵观察“fin”、“fout”窗口中时域图形；观察滤波效果。 
⑶鼠标右键单击“Input”和“Output”窗口，选择“Properties…”项，设置“Display Type”
为“FFT Magitude”，再单击“OK”按钮结束设置。 

⑷观察“Input”、“Output”窗口中频域图形；理解滤波效果。 
注意：由于实验运算复杂，需要等一会才能看到运行完结果。 

7.退出 CCS 
请参看本书第三部分、第一章、六。 
 

五．实验结果 
输入波形为一个低频率的正弦波与一个高频的正弦波叠加而成。 
通过观察频域和时域图，得知：输入波形中的低频波形通过了滤波器，而高频部分则大部

分被滤除。 
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图 3.2.5.3  结果显示 
 

 
六．问题与思考 

试选用合适的高通滤波参数滤掉实验的输入波形中的低频信号。 
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实验 5.2：无限冲激响应滤波器(IIR)算法 
 
一．实验目的 

1.掌握设计 IIR 数字滤波器的原理和方法。 
2.熟悉 IIR 数字滤波器特性。 
3.了解 IIR 数字滤波器的设计方法。 

 
二．实验设备 

PC 兼容机一台，操作系统为 Windows2000(或 Windows98，WindowsXP，以下默认为

Windows2000)，安装 Code Composer Studio 3.3 软件。 
 

三．实验原理 
1．无限冲激响应数字滤波器的基础理论。 
2．模拟滤波器原理（巴特沃斯滤波器、切比雪夫滤波器、椭圆滤波器、贝塞尔滤波器）。 
3．数字滤波器系数的确定方法。 
4．根据要求设计低通 IIR 滤波器 

要求：低通巴特沃斯滤波器在其通带边缘 1kHz 处的增益为-3dB，12kHz 处的阻带衰减

为 30dB，采样频率 25kHz。设计： 
-确定待求通带边缘频率 fp1Hz、待求阻带边缘频率 fs1Hz 和待求阻带衰减-20logδsdB。 

模拟边缘频率为：fp1=1000Hz，fs1=12000Hz 
阻带边缘衰减为：-20logδs=30dB 

-用Ω=2πf/fs 把由 Hz 表示的待求边缘频率转换成弧度表示的数字频率，得到Ωp1 和Ω

s1。 
Ωp1=2πfp1/fs=2π1000/25000=0.08π弧度 
Ωs1=2πfs1/fs=2π12000/25000=0.96π弧度 

-计算预扭曲模拟频率以避免双线性变换带来的失真。 
由 w=2fs tan(Ω/2)求得 wp1 和 ws1，单位为弧度/秒。 

wp1=2fs tan(Ωp1/2)=6316.5 弧度/秒 
ws1=2fs tan(Ωs1/2)=794727.2 弧度/秒 

-由已给定的阻带衰减-20logδs 确定阻带边缘增益δs。 
因为-20logδs=30，所以 logδs=-30/20，δs=0.03162 

-计算所需滤波器的阶数： 
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因此，一阶巴特沃斯滤波器就足以满足要求。 

 
 
-一阶模拟巴特沃斯滤波器的传输函数为： 
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H(s)=wp1/(s+wp1)=6316.5/(s+6316.5) 
 
由双线性变换定义 s=2fs(z-1)/(z+1)得到数字滤波器的传输函数为： 
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因此，差分方程为：y[n]=0.7757y[n-1]+0.1122x[n]+0.1122x[n-1] 

 
5．程序流程图： 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
四.实验步骤 

1．实验准备 
-设置软件仿真模式，参看：第三部分、四、1。 
-启动 CCS，参看：第三部分、五、1。 

2．打开工程，浏览程序，工程目录为 C:\ICETEK\F2812\DSP281x_examples\lab0502-iir\iir.pjt 
3．编译并下载程序 
4．打开观察窗口：*选择菜单 View->Graph->Time/Frequency…，进行如下设置： 
 
 

 
 

开始 

初始化工作变量 

调用波形发生子程

序产生混叠的波形

(高频+低频) 

调用 IIR 滤波子程序

计算当前输出 

波形发生 

计算步长 

用标准 C 的 sin 函

数和 cos 函数计算

当前波形值 

返回波形值 

IIR 滤波 

用滤波器系数乘以

保存的 N-1 个输入

输出值和当前输入

值并求和 

返回计算结果 
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图 3.2.5.4  观察窗口设置 1 
 
 

*选择菜单 View->Graph->Time/Frequency…，进行如下设置： 

 
 

图 3.2.5.5  观察窗口设置 2 
 
 

5．清除显示：在以上打开的窗口中单击鼠标右键，选择弹出式菜单中“Clear Display”功能。 
6．设置断点：在程序 iir.c 中有注释“/* 请在此句上设置软件断点 */”的语句上设置软件断

点。 
7.运行并观察结果 
⑴选择“Debug”菜单的“RUN”项，或按 F5 键运行程序。 
⑵观察“IIR”窗口中时域图形；观察滤波效果。 

注意：由于实验运算复杂，需要等一会才能看到运行完结果。 
8.退出 CCS 

请参看本书第三部分、第一章、六。 
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五.实验结果 
输入波形为一个低频率的正弦波与一个高频的余弦波叠加而成。如图： 
 

 
 

图 3.2.5.6  结果显示 
 

通过观察频域和时域图，得知：输入波形中的低频波形通过了滤波器，而高频部分则被衰减。 
 

六. 问题与思考 
试微调(±0.0001)改变程序中 fU 的取值，观察步长因子μ在自适应算法中所起的作用。 
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实验 5.3：快速傅立叶变换(FFT)算法 

 
一．实验目的 

1．掌握用窗函数法设计 FFT 快速傅里叶的原理和方法； 
2．熟悉 FFT 快速傅里叶特性； 
3．了解各种窗函数对快速傅里叶特性的影响。 

 
二．实验设备 

PC 兼容机一台，操作系统为 Windows2000(或 Windows98，WindowsXP，以下默认为

Windows2000)，安装 Code Composer Studio 3.3 软件。 
 

三．实验原理 
1．FFT 的原理和参数生成公式 
 

公式（1）FFT 运算公式 
FFT 并不是一种新的变换，它是离散傅立叶变换（DFT）的一种快速算法。由于我们在

计算 DFT 时一次复数乘法需用四次实数乘法和二次实数加法；一次复数加法则需二次实数加

法。每运算一个 X（k）需要 4N 次复数乘法及 2N+2（N-1）=2（2N-1）次实数加法。所以

整个 DFT 运算总共需要 4N^2 次实数乘法和 N*2(2N-1)=2N(2N-1)次实数加法。如此一来，计

算时乘法次数和加法次数都是和 N^2 成正比的，当 N 很大时，运算量是可观的，因而需要

改进对 DFT 的算法减少运算速度。 
根据傅立叶变换的对称性和周期性，我们可以将 DFT 运算中有些项合并。 
我们先设序列长度为 N=2^L，L 为整数。将 N=2^L 的序列 x(n)(n=0,1,……，N-1)，按 N

的奇偶分成两组，也就是说我们将一个 N 点的 DFT 分解成两个 N/2 点的 DFT，他们又从新

组合成一个如下式所表达的 N 点 DFT： 
一般来说，输入被假定为连续的。当输入为纯粹的实数的时候，我们就可以利用左右对 

 
称的特性更好的计算 DFT。 

我们称这样的 RFFT 优化算法是包装算法：首先 2N 点实数的连续输入称为“进包”。其

次 N 点的 FFT 被连续被运行。最后作为结果产生的 N 点的合成输出是“打开”成为最初的与

DFT 相符合的 2N 点输入。 
使用这战略，我们可以划分 FFT 的大小，它有一半花费在包装输入 O（N）的操作和打

开输出上。这样的 RFFT 算法和一般的 FFT 算法同样迅速，计算速度几乎都达到了两次 DFT
的连续输入。下列一部分将描述更多的在 TMS320C54x 上算法和运行的细节。 
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5．程序流程图： 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
四.实验步骤 

1．实验准备 
-设置软件仿真模式，参看：第三部分、四、1。 
-启动 CCS，参看：第三部分、五、1。 

2．打开工程，浏览程序，工程目录为 C:\ICETEK\F2812\DSP281x_examples\lab0503-FFT 
3．编译并下载程序 
4．打开观察窗口： 

选择菜单 View->Graph->Time/Frequency…进行如下图所示设置。 
 

 
 

图 3.2.5.7  观察窗口设置 1 
 

开始 

初始化工作变量 

调用波形发生子程

序产生波形(3 个正

弦波) 

调用 FFT 子程序 
计算功率谱 

波形发生 

计算步长 

用标准 C 的 sin 函数

计算当前波形值

(128 点)

结束 

FFT 

按照编码逆序排列

输入序列 

返回计算结果 

用蝶形算法计算 

计算功率谱 
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选择菜单 View->Graph->Time/Frequency…进行如下图所示设置。 
 

 
 

图 3.2.5.8  观察窗口设置 2 
 

选择菜单 View->Graph->Time/Frequency…进行如下图所示设置。 
 

 
 
图 3.2.5.9  观察窗口设置 3 

 
5．清除显示：在以上打开的窗口中单击鼠标右键，选择弹出式菜单中“Clear Display”功能。 
6．设置断点：在程序 FFT.c 中有注释“break point”的语句上设置软件断点。 
7.运行并观察结果 
⑴选择“Debug”菜单的“Animate”项，或按 F12 键运行程序。 
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⑵观察“FFT”窗口中时域和频域图形。 

注意：由于实验运算复杂，需要等一会才能看到运行完结果。 
8.退出 CCS 

请参看本书第三部分、第一章、六。 
 

五.实验结果 
 

 
                            

图 3.2.5.10  结果显示 
 

通过观察频域和时域图，程序计算出了测试波形的功率谱，与 CCS 计算的 FFT 结果相近。 
 
六.问题与思考 
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实验 5.4：卷积算法实验 

 
一．实验目的 

1．掌握卷积算法的原理和计算方法。 
2．熟悉卷积算法特性。 
3．学习卷积算法的程序实现。 

 
二．实验设备 

PC 兼容机一台，操作系统为 Windows2000(或 Windows98，WindowsXP，以下默认为

Windows2000)，安装 Code Composer Studio 3.3 软件。 
 

三．实验原理 
1．卷积算法基础理论 
★卷积的基本原理和公式 

卷积和: 对离散系统“卷积和”也是求线性时不变系统输出响应（零状态响应）的主要

方法。 

 
卷积和的运算在图形表示上可分为四步： 
1）翻褶  先在哑变量坐标 M 上作出 x(m)和 h(m)，将 m=0 的垂直轴为轴翻褶成 h(-m)。 

2）移位  将 h(-m)移位 n，即得 h(n-m)。当 n 为正整数时，右移 n 位。当 n 为负整数

时，左移 n位。 

3）相乘  再将 h(n-m)和 x(m)的相同 m 值的对应点值相乘。 

4）相加  把以上所有对应点的乘积叠加起来，即得 y(n)值。 

依上法，取 n=…,-2,-1,0,1,2,3,…各值，即可得全部 y(n)值。 
2．源程序及注释 

*程序的自编函数及其功能 
1）processing1(int  *input2, int  *output2) 

       调用形式：processing1(int  *input2, int  *output2) 
       参数解释：intput2、output2 为两个整型指针数组。 

返回值解释：返回了一个“TRUE”，让主函数的 while 循环保持连续。 

功能说明：对输入的 input2 buffer 波形进行截取 m 点，再以零点的 Y轴为对称轴进行 

翻褶，把生成的波形上的各点的值存入以 OUTPUT2 指针开始的一段地址空间中。 
    2）processing2(int  *output2, int  *output3) 
      调用形式：processing2(int  *output2, int  *output3) 
      参数解释：output2、output3 为两个整型指针数组。 
      返回值解释：返回了一个“TREN”，让主函数的 while 循环保持连续。 

功能说明：对输出的 output2  buffer 波形进行作 n 点移位，然后把生 成的波形上的

各点的值存入以 OUTPUT3 指针开始的一段地址空间中。 
    3）processing3(int  *input1,int  *output2,int  *output4) 

 

∑
∞
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调用形式：processing3(int  *input1,int  *output2,int  *output4) 
       参数解释：output2、output4、input1 为三个整型指针数组。 

返回值解释：返回了一个“TRUE”，让主函数的 while 循环保持连续。 

功能说明：对输入的 input2  buffer 波形和输入的 input1  buffer 作卷积和运算，然

把生成的波形上的各点的值存入以 OUTPUT4 指针开始的一段地址空间中。 
    4）processing4(int  *input2,int  *output1) 
       调用形式：processing4(int  *input2,int  *output1) 

参数解释：output1、input2 为两个整型指针数组。 
返回值解释：返回了一个“TRUE”，让主函数的 while 循环保持连续。 

  功能说明：对输入的 input2  buffer 波形截取 m点，然后把生成的 波形上的各点的

值存入以 OUTPUT1 指针开始的一段地址空间中。 
 

*实验程序流程图 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
四.实验步骤 

1．实验准备 
-设置软件仿真模式，参看：第三部分、四、1。 
-启动 CCS，参看：第三部分、五、1。 

2．打开工程，浏览程序：工程目录为 C:\ICETEK\F2812\Lab0504-Convolve 
3．编译并下载程序 

开始 

打印"volume example tarted\n"

执行 dataIO1( )子程序

While(TRUE) 

执行 dataIO2( ) 子程序

执行 processing4（）子程序

执行 processing1( )子程序

执行 processing2( ) 子程序

执行 processing3( ) 子程序

结束 
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4．设置输入数据文件 
 
请在 volume.c 程序中有注释“break point”的两行上设置 probe point 和 break point： 
设置方法是把光标指示到这一行上，按鼠标右键，从显示的菜单上分别选择 probe point 和
break point。 

5．打开观察窗口 
-选择菜单 View->Graph->Time/Frequency…进行如下设置： 
 

 
                               

图 3.2.5.11  观察窗口设置 1 
 

-选择菜单 View->Graph->Time/Frequency…进行如下设置： 
 

 
 

图 3.2.5.12  观察窗口设置 2 
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-选择菜单 View->Graph->Time/Frequency…进行如下设置： 
 

                
 
图 3.2.5.13  观察窗口设置 3 
 

-在弹出的图形窗口中单击鼠标右键，选择“Clear Display”。 
6．设置波形输入文件，请按照如下设置： 

-选择菜单 File->File I/O…，打开“File I/O”窗口；单击“Add File”按钮，在“File Input”
窗口中选择工程目录下的 sine11.dat 文件，单击“打开”按钮；在“Address”项中输入

inp1_buffer，在“Length”项中输入 64，在“Warp Around”项前加上选择标记，单击“Add 
Probe Point”按钮； 
-在“Break/Probe/Profile Points”窗口中单击“Probe Point”列表中的“Convolve.c line62  
No Connection”，再单击“Connect”项尾部的展开按钮，在显示的展开式列表中选择列表

末尾的“FILE IN:D:\..\SIN11.DAT”，单击“Replace”按钮，单击“确定”按钮。 
-在“File I/O”窗口中单击“确定”，完成设置。 
-选择“File”菜单中的“File I/O…”，打开“File I/O”窗口；单击“Add File”按钮，在“File 
Input”窗口中选择工程目录下的 sine11.dat 文件，单击“打开”按钮；在“Address”项中

输入 inp2_buffer，在“Length”项中输入 64，在“Warp Around”项前加上选择标记，单

击“Add Probe Point”按钮； 
-在“Break/Probe/Profile Points”窗口中单击“Probe Point”列表中的“Convolve.c line63  
No Connection”，再单击“Connect”项尾部的展开按钮，在显示的展开式列表中选择列表

末尾的“FILE IN:D:\..\SIN11.DAT”，单击“Replace”按钮，单击“确定”按钮。 
-在“File I/O”窗口中单击“确定”，完成设置。 

7．运行程序，观察结果 
  -在“jishu++;//在此处加断点”上设置 break 断点。 

-按 F5 键运行程序，待程序停留上面那条语句处；观察刚才打开的三个图形窗口，其中显

示 
的是输入和输出的时域波形； 
注意：由于实验运算复杂，需要等一会才能看到运行完结果。 
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8．输入波形文件改成其他波形，如：sin22.dat 等，观察运行结果。在修改输入波形文件时

须首先将原文件删除；在重新运行程序时，先选择菜单“Debug”的“Reset CPU”、“Restart” 
“Go Main”，再选择“Debug”中“Run”或按一下 F5 即可。 

 
五.试验结果 

当输入波形均为 sin11.dat 时，得到的卷积时域图为： 
 

 
图 3.2.5.14  结果显示 

 
六.问题与思考 
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实验 5.5：自适应滤波器算法 

 
一．实验目的 

1．掌握自适应数字滤波器的原理和实现方法。 
2．掌握 LMS 自适应算法及其实现。 
3．了解自适应数字滤波器的程序设计方法。 

 
二．实验设备 

计算机，ICETEK-F2812-A 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 系统板+相关连
线及电源）。 

 
三．实验原理 

1．自适应滤波 
自适应滤波是仅需对当前观察的数据作处理的滤波算法。它能自动调节本身冲激响应的

特性，或者说自动调节数字滤波器的系数，以适应信号变化的特性，从而达到最佳滤波。
由于自适应滤波不需要关于输入信号的先验知识，计算量小，特别适用于实时处理，近年
来得到广泛应用，如用于脑电图和心电图测量、噪声抵消、扩频通信及数字电话等。 
2．自适应滤波原理 

自适应滤波器主要由两部分组成：系数可调的数字滤波器和用来调节或修正滤波器系数
的自适应算法。下图为自适应滤波器原理框图。 
 
         z(n)=s(n)+d(n) 
 
         x(n)                                     －    +     e(n) 
 
 
                                          y(n) 
 
 
 

图 3.2.5.15  自适应滤波器原理框图 
 

图中，自适应滤波器有两个输入端：一个输入端的信号 z(n)含有所要提取的信号 s(n)，
被淹没在噪声 d(n)中，s(n)、d(n)两者不相关，z(n)=s(n)+d(n) 
另一输入端信号为 x(n)，它是 z(n)的一种度量，并以某种方式与噪声 d(n)有关。x(n)被数字滤
波器所处理得到噪声 d(n)的估计值 y(n)，这样就可以从 z(n)中减去 y(n)，得到所要提取的信
号 s(n)的估计值 e(n)，表示为：e(n)=z(n)-y(n)=s(n)+d(n)-y(n) 

显然，自适应滤波器就是一个噪声抵消器。如果得到对淹没信号的噪声的最佳估计，就
能得到所要提取信号的最佳估计。为了得到噪声的最佳估计 y(n)，可以经过适当的自适应算
法，例如用 LMS(最小均方)算法来反馈调整数字滤波器的系数，使得 e(n)中的噪声最小。e(n)
有两种作用：一是得到信号 s(n)的最佳估计；二是用于调整滤波器系数的误差信号。 
自适应滤波器中，数字滤波器的滤波系数是可调的，多数采用 FIR 型数字滤波器，设其单

位脉冲响应为 h(0)，h(1)，…，h(N-1)，那么它在时刻 n 的输出便可写成如下的卷积形式 
 

数字滤波器 

自适应算法 
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为方便起见，上式中的各 h(k)亦被称为权值。根据要求，输出 y(n)和目标信号 d(n)之间

应满足最小均方误差条件，即 
})]()({[)]([ 22 nyndEneE −=                                  (2-2) 
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并把式(2-2)代入，便可得正交条件：E[e(n)x(n-k)]=0，0≤k≤N-1           (2-4) 
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那么式(2-1)便可被写成 

)()()( nxhhnxny TT ==                                      (2-5) 
 
而由式(2-4)给出的正交条件则变为：E{[d(n)-y(n)]x(n)}=0 
把式(2-5)代入上式后，有 

hnxnxEnxndE T )]()([)]()([ =                                 (2-6) 
 
如果令 r=E[d(n)x(n)]， )]()([ nxnxE T

xx =Φ ，那么最佳权向量 

rh xx
1* −Φ=                                                   (2-7) 

 
3．LMS 自适应算法 

由于在应用中必须要知道所求信号和观测信号之间的相关矢量 r。在一般情况下，它很

难从观测信号中估计出来，因此在应用上受到一定限制。为此，Widrow 提出一种非常巧妙

的方法，即最小均方误差(LMS)自适应算法。 
LMS 自适应算法的思路是这样的：假设给出了和原始信号相关的参考信号 d(n)，那么首

先对 FIR 滤波器的权任意设定一组初始值；然后根据滤波器的输出值与参考信号之间的误差

e(n)对权值进行调节，使下一次的输出误差能有所减少；这样重复下去，直到权收敛到最佳

值。 
那么如何根据误差 e(n)来调节滤波器的权值，使其收敛到最佳值呢？首先考察当权向量

h 取一组任意值时由式(2-2)所给出的均方误差特性。利用式(2-6)和(2-7)，该均方误差ξ可写 
 
为 h 的函数，即 

 
})]()({[)]([ 22 nxhndEneE T−==ξ  
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  hnxnxEhhnxndEndE TTT )]()([)]()([2)]([ 2 +−=  

  hhhrndE xx
TT Φ+−= 2)]([ 2                                (3-1) 

 
上式表明均方误差ξ是滤波器权向量的二次函数，因此它在 N+1 维空间中形成一超抛物

面。该超抛物面为下凸形，其最小值在权向量空间的投影即为最佳权向量 *h 。 
在利用估计误差对权值调节过程中，权向量的值随时间变化而改变。设在第 n 和 n+1 时

刻向量 h(n)和 h(n+1)之间存在关系：h(n+1)=h(n)+⊿h                       (3-2) 
其中⊿h 表示对 h(n)的修正值。那么当⊿h 充分小时，利用多变量函数的 Taylor 展开公式可

知对应于第 n 和 n+1 时刻均方误差值ξ(n)和ξ(n+1)有下述关系 
 

n
Thnn ∇Δ+=+ )()1( ξξ                                      (3-3) 
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如果令 
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这样通过选择适当小的正常数因子μ的值，便可以使均方误差ξ(n+1)≤ξ(n)成立。把式

(3-5)代入式(3-2)有 

nnhnh ∇−=+ μ)()1(                                        (3-6) 
 

由于上式中的 n∇− 表示沿误差曲面梯度下降的方向，因此权向量修正的过程，也是使

误差沿着超抛物面最陡梯度不断向最小值逼近的过程，故该算法被称为“最陡梯度下降法”。 
最陡梯度下降法在使用时的不方便之处，就是在每次对权向量的值进行修正时，必须要

求出梯度向量 n∇ 的值，这在实际使用中一般是难以做到的。为对此加以简化，可以采用下

述的近似算法。由式(3-4)和(3-1)可知 
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由于当 h=h(n)时的输入向量为 x(n)，故 )()()()( nxnhndne T−= 。把该式代入上式可得 
 

)]()([2 nxneEn −=∇                                      (3-7) 
 
在实际计算中，由式(3-7)给出的梯度值可用下面的近似值所代替，即 
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)()(2ˆ nxnen −=∇  
因此式(3-6)可被重新写成：h(n+1)=h(n)+2μe(n)x(n)                 (3-8) 
该式给出了一种非常简单的权向量的递推算法，即 Widrow-Hoff LMS 自适应算法。由于这种

自适应滤波方法可以根据信号的变化自动调节权向量以获得最佳输出，因此它对非平稳信号

的滤波也是使用的。 
4．实验程序设计 

实验中采用的自适应滤波器采用 16 阶 FIR 滤波器，采用相同的信号作为参考信号 d(n)
和输入信号 x(n)，并采用上一时刻的误差值来修正本时刻的滤波器系数，2μ取值 0.0005，
对滤波器输出除 128 进行幅度限制。 

 
实验程序流程图： 

    
 
 
 
 
 
 
 
 
 

 
四.实验步骤 

1．实验准备 
-设置软件仿真模式，参看：第三部分、四、1。 
-启动 CCS，参看：第三部分、五、1。 

2.打开工程，浏览程序，工程目录为 C:\ICETEK\F2812\DSP281x_examples\lab0505-FIRLMS 
3.编译并下载程序 
4.打开观察窗口 

*选择菜单 View->Graph->Time/Frequency…进行如下设置： 

 
 

图 3.2.5.16  观察窗口设置 1 

开始 

初始化并产生输入波形 

调用 LMS 算法计算输出 

结束 

LMS 算法 

用当前 FIR 滤波参数滤波 

根据上次误差调整滤波参数 

返回 
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图 3.2.5.17 观察窗口设置 2 
 
 

 
                        

图 3.2.5.18 观察窗口设置 3 
 

 
5.清除显示：在以上打开的窗口中单击鼠标右键，选择弹出式菜单中“Clear Display”功能。 
6.运行并观察结果 

选择“Debug”菜单的“Run”项，或按 F5 键运行程序。当程序运行停止后，观察上述

窗口中的图形显示结果。 
注意：由于实验运算复杂，需要等一会才能看到运行完结果。 

7.选择菜单 File→workspace→save workspacs As…，输入文件名 SY.wks 。 
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8.退出 CCS 

请参看本书第三部分、第一章、六。 
 
五. 实验结果 

实验结果图示如下： 
 
 

 
 

图 3.2.5.19 结果显示 
 

可以看出：输出波形 y(n)在自适应滤波器的调整中逐渐与输入波形 x(n)重合，误差 e(n)逐
渐减小到 0 值附近。自适应滤波器工作正常。 

 
六. 问题与思考 

试微调(±0.0001)改变程序中 fU 的取值，观察步长因子μ在自适应算法中所起的作用。 
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实验 5.6：抽样定理 

 
一．实验目的 

1．熟悉 A/D 转换的基本过程和程序处理过程。 
2．熟悉 FFT 的应用。 
3．掌握抽样定理的内容和其在实际中的运用。 

 
二．实验设备 

计算机，ICETEK-F2812-A 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 系统板+相关连

线及电源）。示波器。 
 

三．实验原理 
1．抽样定理 

在应用 DSP 进行信号处理过程中，经常需要对信号进行采集，而采集工作一般通过 AD
转换器件完成，AD 器件在工作时不可能取得连续的值，只能间隔一段时间进行一次转换，

得到转换结果后再进行下一次转换。这样，对连续变换的信号只能在离散时间点上进行取样，

这也叫抽样过程。 
抽样是在离散时间间隔对连续时间信号(例如模拟信号)的采集，它是实时信号处理中的

基本概念。模拟信号由一些离散时间的值来代表，这些抽样的值等于原始的模拟信号在离散

时间点的取值。 
DSP 器件只能通过抽样的方法得到离散的信号，我们如何对信号进行采样才能获得原有

信号所具备所有频率特征，这是采样定理所涉及的问题。采样定理规定对模拟信号应该以多

大的速率抽样，以保证能够捕捉到包含在信号中的相关信息或者经过抽样后能够保留相关的

信息。 
抽样定理：如果信号的最高频率分量是 maxf ，为了使抽样值能够完整地描述信号，那么

至少应该以 max2 f 的速率进行抽样。即 sF ≥ max2 f ，其中 sF 是抽样频率或抽样率。 
因此，如果模拟信号中的最大频率分量为 4kHz，那么，为了保留或捕捉信号中的所有

信息，应该以 8kHz 或者更高的抽样率进行抽样。小于抽样定理规定的抽样率进行抽样将导

致频谱折叠，或者相频混叠进入到希望的频带内，以至于我们在把抽样的数据转回到模拟信

号时不能恢复出原始信号。 
信号有很多能量常常在感兴趣的最高频率之外或者包含噪声，信号的能量在很宽的频率

范围内是不变的。例如，在电话中感兴趣的最高频率是大约 3.4kHz，而语音信号可能超过

10kHz。因此，如果我们没有将感兴趣的带宽之外的信号和噪声移去，那么将违反抽样定理。

在实际应用中，让信号通过一个模拟抗混叠滤波器，可以达到移去感兴趣频带之外信号的目

的。 
2．AD 原理 

见实验 3.5、三、1。 
3．快速傅立叶变换应用 

通过 FFT 计算，我们能直观地分析信号的频率特征，了解信号中的主要频率分量的频点。 



   REALTIME—DSP 系列应用丛书 

 
 
地址：北京市海淀区知春路 108 号豪景大厦 A 座 18 层                     http://www.realtimedsp.com.cn 
电话：010-62105690(中继)/91-97                                         传真：010-62105699   

170 

 
4．分析及程序设计 

程序流程图： 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
四．实验步骤 

1．实验准备 
(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)准备信号源进行 AD 输入。 
注意：如果使用 2812 单板，请把您的信号源输入端接到 P2 扩展接口上的

ad 输入引脚，把地线接到扩展接口上的 AGND 引脚上。（具体位置参考 ICETEK–

F2812-A 评估板原理图） 

①取出 1 根实验箱附带的信号线(如右图，两端均为单声道语音插头)。 
②用 1 根信号线连接实验箱左侧信号源的波形输出 A 端口和“A/D 输入”模块的

“ADCIN2”插座注意插头要插牢、到底。这样，信号源波形输出 A 的输出波形即可送

到 ICETEK–F2812-A 板的 AD 输入通道 0。 
③-向内侧按波形频率选择旋钮，直到标有正弦波的指示灯点亮。 

        - 上下调节波形频率选择旋钮，直到标有 1K-10KHz 的指示灯点亮。 
        - 调节幅值调整旋钮，将波形输出 A 的幅值调到最大。 

2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 
请参看本书第三部分、第一章、四、2。 

3．启动 Code Composer Studio 3.3 

开始 

初始化： CPU 频率、AD 制寄存器、
ICETEK-CTR 

ADC 忙? 

初始化循环变量(256 次) 

启动转换：通道 0 

读取 AD 转换器状态 

保存结果到 nADC0[0..255] 

循环结束? 

是 

否 

是 

否 
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请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

4．打开工程文件 
工程目录为：C:\ICETEK\F2812\DSP281x_examples\Lab0506-Nyquist 

5．编译、下载程序，选择菜单 Debug->Go Main，使程序运行到 main 函数入口位置。 
6．设置软件断点和观察窗口 

-打开源程序 adc.c，在有注释“break point”的行上加软件断点。 
-选择菜单 View->Graph->Time/Frequency…进行如下设置： 

 
 

 
 
图 3.2.5.20  观察窗口设置 1 

 
7．运行程序，测算 AD 采样频率 

按“F5”键运行，用示波器测试采样频率：示波器探头地线可以连接到“测试点”模块 
的“AGND”上，用示波器探头测量“测试点”模块的“DAOUT1”上。 

调节示波器旋钮，测出方波的频率，这一频率是 AD 采样频率的 1/2，现假设测得的频率 
为 10.75KHz，那么 AD 的采样频率为 21.5KHz。 

选择菜单 Debug->Halt，停止程序运行。将示波器探头改到测试信号源 I 的输出，可以连

接到“测试点”模块的“ADCIN0”上。 
8．打开观察窗口观察波形的频域统计结果 

-选择菜单 View->Graph->Time/Frequency…进行如下设置： 
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图 3.2.5.21  观察窗口设置 2 
 
 
-注意在打开窗口中的横轴单位实际上应该是 kHz。 

9．运行程序观察显示 
-按“F12”运行程序，过一会然后停止运行程序，观察两个窗口中的显示。 
-观察示波器的频率统计，对照“FFT”窗口的尖峰指示(可以用鼠标将光标移动到尖峰位置，

再从状态条读出频率值，如图)，看是否相近。 
 
 

     
             

图 3.2.5.22  查看结果 
 

-顺时针微调信号源 I 的“频率微调”旋钮，使频率增大，观察到“FFT”尖峰向频率高

端(右侧)移动。对照频率测量值和 FFT 计算值。 
10．观察混叠现象 

-将信号源 I“频率微调”旋钮逆时针调到头；“频率选择”旋钮切换到“10kHz-20kHz”

波形的 
能量尖峰 

数据回 
读光标 

状态条， 
当前频率为
1.0918kHz 
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档。 
-顺时针微调信号源 I 的“频率微调”旋钮，使频率增大，对照频率测量值和 FFT 计算值。 

11．选择菜单 File→workspace→save workspacs As…，输入文件名 SY.wks 。 
12．退出 CCS 

请参看本书第三部分、第一章、六。 
 

五．实验结果 
在实验步骤 10 以前，“FFT”窗口峰值频率随频率值的微调增大，但到了步骤 11 中，到达

某个频率后，“FFT”窗口峰值频率不随频率值的微调增大，反而有减小(向左移动)的现象，这

就是信号频率超越了奈奎斯特(Nyquist)频率(也就是采样频率的 1/2)后发生的频率混叠现象。这

时“FFT”窗口的频率计算值已经无法正确得到实际信号的频率值。 
在固定的采样频率 21.5kHz 所能测量的信号最高频率不能高于 10.75kHz。换句话说，要测

量高频率在 10.75kHz 的信号，必须保证采样频率大于 Nyquist 频率=2*10.75kHz 才能得到不失

真的结果。 
 

六．问题与思考 
-
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六．综合实验 

 
实验 6.1：交通灯综合控制 

 
实验 6.1.1：交通灯综合控制(V60 版) 

 
一．实验目的 

1．熟悉使用 ICETEK–F2812-A 评估板控制 ICETEK-CTR 上交通灯的方法。 
2．掌握 TMS320F2812DSP 定时器的使用和编程。 
3．掌握 TMS320F2812DSP 外中断的使用和编程。 
4．学习复杂控制程序设计思路。 

 
二．实验设备 

计算机，ICETEK-F2812-A 实验箱。 
 

三．实验原理 
1．交通灯控制要求 

利用 ICETEK 实验箱提供的设备，设计模拟实际生活中十字路口交通灯控制的程序。

要求如下： 
-交通灯分红黄绿三色，东、南、西、北各一组，用灯光信号实现对交通的控制：绿灯信号

表示通行，黄灯表示警告，红灯禁止通行，灯光闪烁表示信号即将改变。 
-计时显示：8×8 点阵显示两位计数，为倒计时，每秒改变计数显示。 
-正常交通控制信号顺序：正常交通灯信号自动变换 

(1)南北方向绿灯，东西红灯(20 秒)。 
(2)南北方向绿灯闪烁。 
(3)南北方向黄灯。 
(4)南北方向红灯，东西方向黄灯。 
(5)东西方向绿灯(20 秒)。 
(6)东西方向绿灯闪烁。 
(7)东西方向黄灯。 
(8)返回(1)循环控制。 

-紧急情况处理：模仿紧急情况(重要车队通过、急救车通过等)发生时，交通警察手动控制 
(1)当任意方向通行剩余时间多于 10 秒，将时间改成 10 秒。 
(2)正常变换到四面红灯(20 秒)。 
(3)直接返回正常信号顺序的下一个通行信号(跳过闪烁绿灯、黄灯状态)。 

2．交通灯模拟 
利用 ICETEK-CTR 上的一组发光二极管(共 12 只，分为东西南北四组、红黄绿三色)的亮

灭实现交通信号的模拟。 
发光二极管的控制方法可参见第二部分、第二章、二、2。 

3．计时显示 
利用 ICETEK-CTR 上的发光二极管显示阵列模拟显示。 
发光二极管显示阵列的控制方法可参见第二部分、第二章、二、3。 
发光二极管显示阵列的编程可参考实验 4.2 程序。 

4．计时 
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使用 TMS320F2812DSP 片上定时器，定时产生时钟计数，再利用此计数对应具体时间。 
定时器控制及中断编程可参考实验 3.3 程序。 

 
5．紧急情况 

利用 ICETEK-CTR 上键盘产生外中断，中断正常信号顺序，模拟突发情况。 
外中断编程控制可参考实验 3.4 程序。 

6．程序设计 
根据设计要求，由于控制是由不同的各种状态按顺序发生的，我们可以采用状态机制控

制方法来解决此问题。这种方法是：首先列举所有可能发生的状态；然后将这些状态编号，

按顺序产生这些状态；状态延续的时间用程序控制。对于突发情况，可采用在正常顺序的控

制中插入特殊控制序列的方式完成。 
时钟计数：采用 250ms 一次中断进行累加计数。 

表 3.2.6.1 
状态 
编号 信号灯状态 状态定义 保持时间(计数值，起始

时间，结束时间) 
计数 
显示 

1 南北绿灯，东西红灯 statusNSGreenEWRed 20 秒(160，0，159) 20-0 
2 南北绿灯闪烁，东西红灯 statusNSFlashEWRed 6 秒(24，160，183) 0 
3 南北黄灯，东西红灯 statusNSYellowEWRed 4 秒(16，184，199) 20 
4 南北红灯，东西黄灯 statusNSRedEWYellow 4 秒(16，200，215) 20 
5 南北红灯，东西绿灯 statusNSRedEWGreen 20 秒(160，216，375) 20-1 
6 南北红灯，东西绿灯闪烁 statusNSRedEWFlash 6 秒(24，376，399) 0 
7 南北红灯，东西黄灯 statusNSRedEWYellow 4 秒(16，400，415) 20 
8 南北黄灯，东西红灯 statusNSYellowEWRed 4 秒(16，416，431) 20 
* 南北红灯，东西红灯 StatusHold 20 秒(160，0，159) 20-1 
其中，正常顺序每 112 秒(计数值 448)为一个循环，状态“*”为非顺序状态。 
这样，只要根据计数值就可确定当前状态，根据状态再分情况处理。 
对于计数显示，当处于状态 1、5、*中时需要进行倒计时，需要计算在此状态中的计数

值增量，根据增量判断是否更新计数显示。(实验程序流程图见文后) 
 

四．实验步骤 
1．实验准备 

(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)连接实验箱附带的键盘的 PS2 插头到 ICETEK-CTR 的“键盘接口”P8。 
(3)将 ICETEK-CTR 板的供电电源开关拨动到“开”的位置。 

2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 
请参看本书第三部分、第一章、四、2。 

3．启动 Code Composer Studio 3.3 
请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

4．打开工程文件 
工程目录为：C:\ICETEK\F2812\DSP281x_examples\lab0601-TrafficLight\V60 

5．编译并下载程序 
6．运行程序观察结果 

观察交通灯信号是否正常工作。 
7．突发事件控制 

在 ICETEK-CTR 附带的小键盘上按下除“Enter”键外的按键，观察信号是否满足要求。 
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8．结束程序运行退出。 
在 ICETEK-CTR 附带的小键盘上按下“Enter”键。 

9．退出 CCS：请参看本书第三部分、第一章、六。 
 
五．实验结果 

程序可以完成交通灯功能，顺序循环工作。 
在中断信号到来后，进入特殊过程：当前计时如果大于 10 改成 10，否则不变，等待状态

切换；切换后进入四面禁行状态，计数 20 秒后返回断点后的通行(有两方向是绿灯)状态。 
 

六．问题与思考 
请考虑修改此实验程序完成：主路与人行横道可由行人控制的交通信号控制。要求： 

1．平时为主路机动车通行(绿灯)状态，人行横道红灯。 
2．行人需要通过人行横道，按下交通灯控制按钮。 

根据情况处理： 
(1)如果机动车刚刚恢复通行步超过 3 分钟，行人需要等待 3 分钟计时满。 
(2)否则行人等待 1 分钟计时(从按下按钮时起)。 

3．机动车道绿灯闪烁。 
4．机动车道黄灯。 
5．机动车道红灯，人行横道绿灯，并开始计时 1 分钟。 
6．人行横道绿灯闪烁。 
7．人行横道黄灯。 
8．返回第 1 步。 
 

实验程序流程图： 
 

开始

初始化： CPU 频率、ICETEK-CTR、定时器、

中断控制寄存器、工作变量 

根据定时器计数确定当前状态 

根据当前状态设置指示灯状态 

根据当前状态设置发光二极管显示阵列状态 

读取键盘输入 

结束? 

是

否 

结束 

定时器中断服务程序入口 

计数工作变量值在原

退出定时器中断服务程序 

键盘中断服务程序入口 

设置突发事件标志 

退出键盘中断服务程序 
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实验 6.1.2：交通灯综合控制(V61 版) 

 
一．实验目的 

1．熟悉使用 ICETEK–F2812-A 评估板控制 ICETEK-CTR 上交通灯的方法。 
2．掌握 TMS320F2812DSP 定时器的使用和编程。 
3．掌握 TMS320F2812DSP 外中断的使用和编程。 
4．学习复杂控制程序设计思路。 

 
二．实验设备 

计算机，ICETEK-F2812-EDU 实验箱。 
 

三．实验原理 
1．交通灯控制要求 

利用 ICETEK-EDU 实验箱提供的设备，设计模拟实际生活中十字路口交通灯控制的程

序。要求如下： 
-交通灯分红黄绿三色，东、南、西、北各一组，用灯光信号实现对交通的控制：绿灯信号

表示通行，黄灯表示警告，红灯禁止通行，灯光闪烁表示信号即将改变。 
-计时显示：LCD 上显示 0-9 计数值，每秒改变计数显示。 
-正常交通控制信号顺序：正常交通灯信号自动变换 

(1)南北方向绿灯，东西红灯(10 秒)。 
(2)南北方向绿灯闪烁。 
(3)南北方向黄灯。 
(4)南北方向红灯，东西方向黄灯。 
(5)东西方向绿灯(210 秒)。 
(6)东西方向绿灯闪烁。 
(7)东西方向黄灯。 
(8)返回(1)循环控制。 

-紧急情况处理：模仿紧急情况(重要车队通过、急救车通过等)发生时，交通警察手动控制 
(1)当任意方向通行剩余时间多于 5 秒，将时间改成 5 秒。 
(2)正常变换到四面红灯(0 秒)。 
(3)直接返回正常信号顺序的下一个通行信号(跳过闪烁绿灯、黄灯状态)。 

2．交通灯模拟 
利用 ICETEK-CTR 上的一组发光二极管(共 12 只，分为东西南北四组、红黄绿三色)的亮

灭实现交通信号的模拟。 
发光二极管的控制方法可参见第二部分、第二章、二、2。 

3．计时显示 
利用 ICETEK-CTR 上的 LCD 显示当前剩余秒数。 

4．计时 
使用 TMS320F2812DSP 片上定时器，定时产生时钟计数，再利用此计数对应具体时间。 
定时器控制及中断编程可参考实验 3.3 程序。 

 
5．紧急情况 

利用 ICETEK-CTR 上键盘产生外中断，中断正常信号顺序，模拟突发情况。 
外中断编程控制可参考实验 3.4 程序。 
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6．程序设计 
根据设计要求，由于控制是由不同的各种状态按顺序发生的，我们可以采用状态机制控

制方法来解决此问题。这种方法是：首先列举所有可能发生的状态；然后将这些状态编号，

按顺序产生这些状态；状态延续的时间用程序控制。对于突发情况，可采用在正常顺序的控

制中插入特殊控制序列的方式完成。 
时钟计数：采用 250ms 一次中断进行累加计数。 

 
四．实验步骤 

1．实验准备 
(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)将 ICETEK-CTR 板的供电电源开关拨动到“开”的位置。 

2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 
请参看本书第三部分、第一章、四、2。 

3．启动 Code Composer Studio 3.3 
请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

4．打开工程文件 
工程目录为：C:\ICETEK\F2812 \DSP281x_examples\lab0601-TrafficLight\V61 

5．编译并下载程序 
6．运行程序观察结果 

观察交通灯信号是否正常工作。 
7．突发事件控制 

在 ICETEK-CTR 附带的键盘上按下除“9”键外的按键，观察信号是否满足要求。 
8．结束程序运行退出。 

在 ICETEK-CTR 附带的键盘上按下“9”键。 
9．退出 CCS：请参看本书第三部分、第一章、六。 
 
五．实验结果 

程序可以完成交通灯功能，顺序循环工作。 
在中断信号到来后，进入特殊过程：当前计时如果大于 5 改成 5，否则不变，等待状态切

换；切换后进入四面禁行状态，计数 10 秒后返回断点后的通行(有两方向是绿灯)状态。 
 

六．问题与思考 
请考虑修改此实验程序完成：主路与人行横道可由行人控制的交通信号控制。要求： 

1．平时为主路机动车通行(绿灯)状态，人行横道红灯。 
2．行人需要通过人行横道，按下交通灯控制按钮。 

根据情况处理： 
(1)如果机动车刚刚恢复通行步超过 3 分钟，行人需要等待 3 分钟计时满。 
(2)否则行人等待 1 分钟计时(从按下按钮时起)。 

3．机动车道绿灯闪烁。 
4．机动车道黄灯。 
5．机动车道红灯，人行横道绿灯，并开始计时 1 分钟。 
6．人行横道绿灯闪烁。 
7．人行横道黄灯。 
8．返回第 1 步。 
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实验程序流程图： 

 
 

 
开始

初始化： CPU 频率、ICETEK-CTR、定时器、

中断控制寄存器、工作变量 

根据定时器计数确定当前状态 

根据当前状态设置指示灯状态 

根据当前状态设置 LCD 显示当前剩余秒数 

读取键盘输入 

结束? 

是

否 

结束 

定时器中断服务程序入口 

计数工作变量值在原

退出定时器中断服务程序 

键盘中断服务程序入口 

设置突发事件标志 

退出键盘中断服务程序 
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实验 6.2：多路信号混频 

 
一．实验目的 

1．掌握 A/D 转换的基本过程和程序处理过程； 
2．学习通过对采样值进行计算产生混频波形。 

 
二．实验设备 

计算机，ICETEK-F2812-A 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 系统板+相关连

线及电源）。 
 

三．实验原理 
1．AD 原理 
参见实验 3.5、三、1。 
2．模数转换工作过程 
-模数转换模块接到启动转换信号后，按照设置进行相应通道的数据采样转换。  
-经过一个采样时间的延迟后，将采样结果放入 AD 数据寄存器中保存。 
-等待下一个启动信号。 
3．模数转换的程序控制 

模数转换相对于计算机来说是一个较为缓慢的过程。一般采用中断方式启动转换或保存

结果，这样在 CPU 忙于其他工作时可以少占用处理时间。设计转换程序应首先考虑处理

过程如何与模数转换的时间相匹配，根据实际需要选择适当的触发转换的手段，也要能及

时保存结果。 
4．混频波形产生 

将接收到的两路 AD 
采集信号进行相加，并 
对结果的幅度进行限制， 
从而产生混合后的输出 
波形。实验中采用了同 
相位混频方法，也可修 
改程序完成异相混频法。 
 
程序流程图： 

开始

初始化： CPU 频率、ICETEK-CTR、 
AD 时钟控制寄存器 

是否产生中断? 

启动转换：通道 0,1

保存结果到 Voltage1 [0..1024]， 
保存结果到 Voltage2 [0..1024] 

退出中断服务程序 

否 

是]

是 
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四．实验步骤 

1．实验准备 
(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)准备信号源进行 AD 输入。 
①取出 2 根实验箱附带的信号线(如右图，两端均为单声道语音插头)。 
②用 1 根信号线连接实验箱左侧信号源的波形输出 A 端口和“A/D 输入”模块的

“ADCIN0”插座注意插头要插牢、到底。这样，信号源波形输出 A 的输出波形即可送

到 ICETEK–F2812-A 板的 AD 输入通道 0。 
③用 1 根信号线连接实验箱左侧信号源的波形输出 B 端口和“A/D 输入”模块的

“ADCIN1”插座注意插头要插牢、到底。这样，信号源波形输出 B 的输出波形即可送

到 ICETEK–F2812-A 板的 AD 输入通道 1。 
④设置波形输出 A： 

- 向内侧按波形频率选择旋钮，直到标有正弦波的指示灯点亮。 
        - 上下调节波形频率选择旋钮，直到标有 10-100Hz 的指示灯点亮。 
        - 调节幅值调整旋钮，将波形输出 A 的幅值调到最大。 

⑤设置波形输出 B： 
- 向内侧按波形频率选择旋钮，直到标有正弦波的指示灯点亮。 

        - 上下调节波形频率选择旋钮，直到标有 100-1KHz 的指示灯点亮。 
        -调节幅值调整旋钮，将波形输出 B 的幅值调到最大。 
注意：如果使用 2812 单板，请把您的信号源输入端接到 P2 扩展接口上的 ad 输入引脚， 

把地线接到扩展接口上的 AGND 引脚上。（具体位置参考 ICETEK　F2812-A 评估板

原理图） 

2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 
请参看本书第三部分、第一章、四、2。 

3．启动 Code Composer Studio 3.3 
请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

4．打开工程文件 
工程文件为：C:\ICETEK\F2812\DSP281x_examples\Lab0602-Mixer\ADC.pjt 

5．编译、下载程序，选择菜单 Debug->Go Main，使程序运行到 main 函数入口位置。 
6．设置观察窗口 

-选择菜单“View”、“Graph”、“Time/Frequency…”做如下设置，然后单击“OK”按钮； 
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图 3.2.6.1  观察窗口设置 1 
-选择菜单“View”、“Graph”、“Time/Frequency…”做如下设置，然后单击“OK”按钮； 

 

 
 

图 3.2.6.2  观察窗口设置 2 
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-选择菜单 View->Graph->Time/Frequency…进行如下设置： 

 

 
 

图 3.2.6.3  观察窗口设置 3 
 

-在弹出的图形窗口中单击鼠标右键，选择“Clear Display”。 
7. 设置信号源 

由于模数输入信号未经任何转换就进入 DSP，所以必须保证输入的模拟信号的幅度在 
0-3V 之间。必须用示波器检测信号范围，保证最小值 0V 最大值 3 V，否则容易损坏 DSP 芯

片的模数采集模块。 
8．运行程序观察结果 

按“F5”键运行程序，等一会再停止运行程序，注意观察窗口“AD0”和“AD1”中的

输入波形，同时分析“nMixing”窗口中混频合成的波形与输入波形的关系。 
9．修改程序 

 
程序所采用的算法是两个信号源对混合后的波形的影响相同，下面改变其比例为 3:1。将

程序中：nMixing[ConversionCount]=Voltage1[ConversionCount]+Voltage2[ConversionCount]; 
改成 
nMixing[ConversionCount]=Voltage1[ConversionCount]+Voltage2[ConversionCount]*3; 
再次编译程序并下载、运行，观察新的结果。 

10．退出 CCS 
请参看本书第三部分、第一章、六。 

 
五．实验结果 
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图 3.2.6.4  结果显示 
 
 

六．问题与思考  
请修改实验程序，实现可改变相位的混频(即在作运算时使用不同时间的输入数据进行叠

加)。 
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实验 6.3：FIR 滤波器的信号滤波 
 

实验 6.3.1：FIR 滤波器的信号滤波(V60 版) 
 
 
一．实验目的 

1．掌握 A/D 转换的基本过程和程序处理过程； 
2．学习通过对采样值进行计算产生混频波形。 
3．熟悉 FIR 滤波器及其参数的调整。 

 
二．实验设备 

计算机，ICETEK-F2812-A 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 系统板+相关连

线及电源）。 
 

三．实验原理 
1．AD 原理 

参见实验 3.4、三、1。 
2．模数转换工作过程 

-模数转换模块接到启动转换信号后，按照设置进行相应通道的数据采样转换。  
-经过一个采样时间的延迟后，将采样结果放入 AD 数据寄存器中保存。 
-等待下一个启动信号。 

3．模数转换的程序控制 
模数转换相对于计算机来说是一个较为缓慢的过程。一般采用中断方式启动转换或保存

结果，这样在 CPU 忙于其他工作时可以少占用处理时间。设计转换程序应首先考虑处理

过程如何与模数转换的时间相匹配，根据实际需要选择适当的触发转换的手段，也要能及

时地保存结果。 
4．混频波形产生 

将接收到的两路 AD 采集信号进行相加，并对结果的幅度进行限制，从而产生混合后的

输出波形。实验中采用了同相位混频方法，也可修改程序完成异相混频法。 
5．FIR 滤波器工作原理及参数计算 

参见实验 5.1。 
滤波器参数：采样频率 15kHz，带通滤波 500Hz-1kHz，增益 40dB，阶数 25。 
分别用低通和高通两种方式进行滤波。 

6．源程序及注释 
本实验程序在 AD 中断中对 AD 进行连续采样。由于需要进行实时混频，所以交替转换

通道 0 和通道 1(ICETEK-F2812-A 实验箱上 ADCIN0 和 ADCIN1)。混频的波形通过 FIR 滤

波器，得到输出波形。 
低通滤波时，输入频率在 500Hz-1kHz 之间的才能通过滤波器。 
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高通滤波时，输入频率在高于 1kHz 的才能通过滤波器。 
 
 
 
程序流程图： 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
四．实验步骤 

1．实验准备 
(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)准备信号源进行 AD 输入。 
① 取出 2 根实验箱附带的信号线(如右图，两端均为单声道语音插头)。 

开始 

初始化： CPU 频率、ICETEK-CTR、 
AD 控制寄存器 

中断产生？ 

启动 ad 转换 

保存结果到 Voltage1 和 Voltage2 数组中 

检查按键为 0 键时，把采集到的两路 ad 数据在

lcd 上显示出来 

检查按键为 1 键时，把采集到的两路 ad 数据混

频后在 lcd 上显示出来 

检查按键为 2 键时，把采集到的两路 ad 数据混

频后经过低通滤波后在 lcd 上显示出来 

是 

否 

检查按键为 3 键时，把采集到的两路 ad
数据混频后经过高通滤波后在 lcd 上显示
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将一根信号线一端插入信号源波形输出 A 端口，另一端插入试验箱上 
ADCIN2 端口。 
将另一根信号线一端插入信号源波形输出 B 端口，另一端插入试验箱上 ADCIN3 端口。 

      ②将波形输出 A 波形选择调为正弦波，频率调整调至 100-1KHz。 
         将波形输出 B 波形选择调为正弦波，频率调整调至 1K-10KHz。 
     详细操作方法见第二部分，第三章，信号源使用说明。 

2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 
请参看本书第三部分、第一章、四、2。 

3．启动 Code Composer Studio 3.3 
请参看本书第三部分、第一章、五、2。选择菜单 Debug->Reset CPU。 

4．打开工程文件 
工程目录：C:\ICETEK\F2812\DSP281x_examples\Lab0603-MixerFIR\V60 

5．编译、下载程序，选择菜单 Debug->Go Main，使程序运行到 main 函数入口位置。 
6．观察窗口 

-打开源程序 main_nonBIOS.c，查看源代码。  
7．运行程序观察结果 

打开“Debug”菜单，选择“Run”选项运行程序（或按 F5 键），此时观察液晶屏上显示 

两路 ad 采集后显示的波形。按数字键“0”也会完成以上功能；按数字键“1”是两路 ad 采

集后信号混叠的显示；数字键“2”是对混叠后信号进行低通滤波，此时会把高于 1k 的信号

滤掉，保留小于 1k 的信号；数字键“3”是对混叠后信号进行高通滤波，高于 1k 的信号被

保留，低于 1k 信号被滤掉。 

8．观察动态效果，调节信号源输出，观察滤波器输出 
改变信号源输入的波形、频率参数，观察动态效果。 

9．退出 CCS 
请参看本书第三部分、第一章、六。 

 
五．实验结果 

按数字键“0” 液晶屏上显示两路 ad 采集后显示的波形；按数字键“1”是两路 ad 采集

后信号混叠的显示；数字键“2”是对混叠后信号进行低通滤波，此时会把高于 1k 的信号滤掉，

保留小于 1k 的信号；数字键“3”是对混叠后信号进行高通滤波，高于 1k 的信号被保留，低

于 1k 信号被滤掉。 
 
六．问题与思考 

可以修改程序，换上不同的滤波系数，可以滤掉不同频率的波形。 
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实验 6.3.2： FIR 滤波器的信号滤波(V61 版) 

 
一．实验目的 

1．掌握 A/D 转换的基本过程和程序处理过程； 
2．学习通过对采样值进行计算产生混频波形。 
3．熟悉 FIR 滤波器及其参数的调整。 

 
二．实验设备 

计算机，ICETEK-F2812-EDU 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 系统板+相
关连线及电源）。 

 
三．实验原理 

1．AD 原理 
参见实验 3.4、三、1。 

2．模数转换工作过程 
-模数转换模块接到启动转换信号后，按照设置进行相应通道的数据采样转换。  
-经过一个采样时间的延迟后，将采样结果放入 AD 数据寄存器中保存。 
-等待下一个启动信号。 

3．模数转换的程序控制 
模数转换相对于计算机来说是一个较为缓慢的过程。一般采用中断方式启动转换或保存

结果，这样在 CPU 忙于其他工作时可以少占用处理时间。设计转换程序应首先考虑处理

过程如何与模数转换的时间相匹配，根据实际需要选择适当的触发转换的手段，也要能及

时地保存结果。 
4．混频波形产生 

将接收到的两路 AD 采集信号进行相加，并对结果的幅度进行限制，从而产生混合后的

输出波形。实验中采用了同相位混频方法，也可修改程序完成异相混频法。 
5．FIR 滤波器工作原理及参数计算 

参见实验 5.1。 
滤波器参数：采样频率 15kHz，带通滤波 500Hz-1kHz，增益 40dB，阶数 25。 
分别用低通和高通两种方式进行滤波。 

6．源程序及注释 
本实验程序在 AD 中断中对 AD 进行连续采样。由于需要进行实时混频，所以交替转换

通道 0 和通道 1(ICETEK-F2812-EDU 实验箱上 ADCIN0 和 ADCIN1)。混频的波形通过 FIR
滤波器，得到输出波形。 

低通滤波时，输入频率在 500Hz-1kHz 之间的才能通过滤波器。 
高通滤波时，输入频率在高于 1kHz 的才能通过滤波器。 
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程序流程图： 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
四．实验步骤 

1．实验准备 
(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)准备信号源进行 AD 输入。 
① 取出 2 根实验箱附带的信号线(如右图，两端均为单声道语音插头)。 
将一根信号线一端插入信号源波形输出 A 端口，另一端插入试验箱上 
ADCIN2 端口。 
将另一根信号线一端插入信号源波形输出 B 端口，另一端插入试验箱上 ADCIN3 端口。 

开始 

初始化： CPU 频率、ICETEK-CTR、 
AD 控制寄存器 

中断产生？ 

启动 ad 转换 

保存结果到 Voltage1 和 Voltage2 数组中 

检查按键为 1 键时，把采集到的两路 ad 数据在

lcd 上显示出来 

检查按键为 2 键时，把采集到的两路 ad 数据混

频后在 lcd 上显示出来 

检查按键为 4 键时，把采集到的两路 ad 数据混

频后经过低通滤波后在 lcd 上显示出来 

是 

否 

检查按键为 5 键时，把采集到的两路 ad
数据混频后经过高通滤波后在 lcd 上显示
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      ②将波形输出 A 波形选择调为正弦波，频率调整调至 100-1KHz。 
         将波形输出 B 波形选择调为正弦波，频率调整调至 1K-10KHz。 
     详细操作方法见第二部分，第三章，信号源使用说明。 

2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 
请参看本书第三部分、第一章、四、2。 

3．启动 Code Composer Studio 3.3 
请参看本书第三部分、第一章、五、2。选择菜单 Debug->Reset CPU。 

4．打开工程文件 
工程目录：C:\ICETEK\F2812\DSP281x_examples\Lab0603-MixerFIR\V61 

5．编译、下载程序，选择菜单 Debug->Go Main，使程序运行到 main 函数入口位置。 
6．观察窗口 

-打开源程序 main_nonBIOS.c，查看源代码。  
7．运行程序观察结果 

打开“Debug”菜单，选择“Run”选项运行程序（或按 F5 键），此时观察液晶屏上显示 

两路 ad 采集后显示的波形。按数字键“1”也会完成以上功能；按数字键“2”是两路 ad 采

集后信号混叠的显示；数字键“4”是对混叠后信号进行低通滤波，此时会把高于 1k 的信号

滤掉，保留小于 1k 的信号；数字键“5”是对混叠后信号进行高通滤波，高于 1k 的信号被

保留，低于 1k 信号被滤掉。 

8．观察动态效果，调节信号源输出，观察滤波器输出 
改变信号源输入的波形、频率参数，观察动态效果。 

9．退出 CCS 
请参看本书第三部分、第一章、六。 

 
五．实验结果 

按数字键“1” 液晶屏上显示两路 ad 采集后显示的波形；按数字键“2”是两路 ad 采集

后信号混叠的显示；数字键“4”是对混叠后信号进行低通滤波，此时会把高于 1k 的信号滤掉，

保留小于 1k 的信号；数字键“5”是对混叠后信号进行高通滤波，高于 1k 的信号被保留，低

于 1k 信号被滤掉。 
 
六．问题与思考 

可以修改程序，换上不同的滤波系数，可以滤掉不同频率的波形。 
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实验 6.3.3： FIR 滤波器的信号滤波(V80 版) 

 
一．实验目的 

1．掌握 A/D 转换的基本过程和程序处理过程； 
2．学习通过对采样值进行计算产生混频波形。 
3．熟悉 FIR 滤波器及其参数的调整。 

 
二．实验设备 

计算机，ICETEK-F2812-EDU 实验箱（或 ICETEK 仿真器+ICETEK-F2812-A 系统板+相关

连线及电源）。 
 

三．实验原理 
1．AD 原理 

参见实验 3.4、三、1。 
 
2．模数转换工作过程 

-模数转换模块接到启动转换信号后，按照设置进行相应通道的数据采样转换。  
-经过一个采样时间的延迟后，将采样结果放入 AD 数据寄存器中保存。 
-等待下一个启动信号。 

 
3．模数转换的程序控制 

模数转换相对于计算机来说是一个较为缓慢的过程。一般采用中断方式启动转换或保存

结果，这样在 CPU 忙于其他工作时可以少占用处理时间。设计转换程序应首先考虑处理

过程如何与模数转换的时间相匹配，根据实际需要选择适当的触发转换的手段，也要能及

时地保存结果。 
 
4．混频波形产生 

将接收到的两路 AD 采集信号进行相加，并对结果的幅度进行限制，从而产生混合后的

输出波形。实验中采用了同相位混频方法，也可修改程序完成异相混频法。 
 
5．FIR 滤波器工作原理及参数计算 

参见实验 5.1。 
滤波器参数见实验工程文件 LAB0603-MixerFIR 源文件 

 
6．源程序及注释 

本实验程序在 AD 中断中对 AD 进行连续采样。由于需要进行实时混频，所以交替转换

通道 0 和通道 1(ICETEK-F2812-EDU 实验箱上 ADCIN0 和 ADCIN1)。混频的波形通过 FIR
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滤波器，得到输出波形。 
程序流程图： 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
四．实验步骤 

1．实验准备 
⑴连接实验设备：请参看本书第三部分、第一章、二。 
⑵准备信号源进行 AD 输入。 
①取出 2 根实验箱附带的信号线(如右图，两端均为单声道语音插头)。 
②用 1 根信号线连接实验箱左侧信号源的波形输出 A 端口和“A/D 输入”模块的

“ADCIN0”插座注意插头要插牢、到底。这样，信号源波形输出 A 的输出波形即可送

到 ICETEK-F2812A 板的 AD 输入通道 0。 

开始 

初始化： CPU 频率、ICETEK-CTR、 
AD 控制寄存器 

中断产生？ 

启动 ad 转换 

保存结果到 Voltage1 和 Voltage2 数组中 

检查按键为 k8 键时，把采集到的两路 ad 数据在

lcd 上显示出来 

检查按键为 k7 键时，把采集到的两路 ad 数据混

频后在 lcd 上显示出来 

检查按键为 k6 键时，把采集到的两路 ad 数据混

频后经过低通滤波后在 lcd 上显示出来 

是 

否 
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③用 1 根信号线连接实验箱左侧信号源的波形输出 B 端口和“A/D 输入”模块的

“ADCIN1”插座注意插头要插牢、到底。这样，信号源波形输出 B 的输出波形即可送

到 ICETEK-F2812A 板的 AD 输入通道 1。 
④设置波形输出 A： 

-向内侧按波形频率选择旋钮，直到标有正弦波的指示灯点亮。 
        -上下调节波形频率选择旋钮，直到标有 100-1KHz 的指示灯点亮。 

-调节幅值调整旋钮，将波形输出 A 的幅值调到适当位置。 
⑤设置波形输出 B： 

-向内侧按波形频率选择旋钮，直到标有正弦波的指示灯点亮。 
        -上下调节波形频率选择旋钮，直到标有 1K-10KHz 的指示灯点亮。 
        -调节幅值调整旋钮，将波形输出 B 的幅值调到适当位置。 

注意：由于模数输入信号未经任何转换就进入 DSP，所以必须保证输入的模拟信号的幅

度在 0-3V 之间。必须用示波器检测信号范围，保证最小值 0V 最大值 3 V，否则

容易损坏 DSP 芯片的模数采集模块。 

         由于程序设定为低通滤波，可以滤掉 650Hz 以上的信号，所以在设定信号源 A

时要用微调按钮将将输出波形频率调到 650HZ 以下，否则出不来滤波效果。 
 

2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 
请参看本书第三部分、第一章、四、2。 

 
3．启动 Code Composer Studio 3.3 

请参看本书第三部分、第一章、五、2。选择菜单 Debug->Reset CPU。 
 
4．打开工程文件 

工程目录：C:\ICETEK\F2812\DSP281x_examples\Lab0603-MixerFIR\V80 
 
5．编译、下载程序，选择菜单 Debug->Go Main，使程序运行到 main 函数入口位置。 
 
6．观察窗口 

-打开源程序 adc.c，查看源代码。  
 
7．运行程序观察结果 

按 CTR 控制板的 K6 键，实现滤波显示，K7 键实现混频显示，按 K8 实现键 A、B 两信

号源分屏显示。 
 
8．观察动态效果，调节信号源输出，观察滤波器输出 

改变信号源输入的波形、频率参数，观察动态效果。 
 
9．退出 CCS 

请参看本书第三部分、第一章、六。 
 

五．实验结果 
 
六．问题与思考 

可以修改程序，换上不同的滤波系数，可以滤掉不同频率的波形。 
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实验 6.4：PID 算法控制实验 

 
实验 6.4.1：PID 算法控制实验(V60 版) 

 
 
一．实验目的 

1．掌握利用 ICETEK–F2812-A 评估板与 ICETEK-CTR 板上带速度反馈的直流电机 B 的

连接和控制原理。 
2．熟悉 F2812DSP 的通用 IO 端口和定时器的编程使用。 
3．学习利用数字 PID 控制算法控制电机转速。 

 
二．实验设备 

计算机，ICETEK-F2812-A 实验箱。 
 

三．实验原理 
1．直流电机测速原理 

直流电机 B：在 ICETEK-CTR 板上有一个带速度反馈的直流电机 B，它的额定工作电

压为+12V，额定转速为 6500 转，带有速度反馈线路，反馈信号为方波脉冲，其频率与转

速成正比(电机转动一圈产生两个脉冲)。 
电机闭环控制系统：如图在 DSP 系统板的控制下形成闭环速度控制系统，DSP 发送的

PWM 波控制直流电机的转速，通过速度反馈，DSP 可实时读取当前速度值，利用 DSP 中

运行的控制程序根据速度读数控制 PWM 的脉宽，从而实现闭环调速控制。 
 

 
 
 

                           
 
 
 
 
 
 
 

 

图 3.2.6.5  直流电机设计原理 

 
2．数字 PID 控制器 
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将偏差的比例(P)、积分(I)和微分(D)通过线性组合构成控制量，用这一控制量对被控对象

进行控制，这样的控制器称 PID 控制器。 
(1)模拟 PID 控制原理 

 
模拟 PID 控制系统原理图如图所示。该系统由模拟 PID 控制器和被控对象组成。图中，

r(t)是给定值，y(t)是系统的实际输出值，给定值与实际输出值构成控制偏差 e(t) 
e(t)=r(t)-y(t) 
e(t)作为 PID 控制器的输入，u(t)作为 PID 控制器的输出和被控对象的输入。所以模拟

PID 控制器的控制规律为 

00

)()(1)()( u
dt

tdeTdtte
T

teKtu
t

D
I

P +⎥
⎦

⎤
⎢
⎣

⎡
++= ∫    (1-1) 

其中： PK ——比例系数 
      IT ——积分常数 
 
      DT ——微分常数 
      0u ——控制常量 
 
 

 
 
      r(t)      +      )(te               +    +   )(tu                  y(t) 
             )(tn   -                      + 
 
 
 

 
 
比例环节的作用是对偏差瞬间做出快速反应。偏差一旦产生，控制器立即产生控制作

用，使控制量向减少偏差的方向变化。控制作用的强弱取决于比例系数 PK ， PK 越大，

控制越强，但过大的 PK 会导致系统震荡，破坏系统的稳定性。 
积分环节的作用是把偏差的积累作为输出。在控制过程中，只要有偏差存在，积分环

节的输出就会不断增大。直到偏差 e(t)=0，输出的 u(t)才可能维持在某一常量，使系统在给

定值 r(t)不变的条件下趋于稳态。积分环节的调节作用虽然会消除静态误差，但也会降低

系统的响应速度，增加系统的超调量。积分常数 IT 越大，积分的积累作用越弱。增大积分

常数 IT 会减慢静态误差的消除过程，但可以减少超调量，提高系统的稳定性。所以，必须

根据实际控制的具体要求来确定 IT 。 
微分环节的作用是阻止偏差的变化。它是根据偏差的变化趋势(变化速度)进行控制。

偏差变化得越快，微分控制器的输出越大，并能在偏差值鞭打之前进行修正。微分作用的

引入，将有助于减小超调量，克服震荡，使系统趋于稳定。但微分的作用对输入信号的噪

积分 被控对象 

比例 

微分 
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声很敏感，对那些噪声大的系统一般不用微分，或在微分起作用之前先对输入信号进行滤 
波。适当地选择微分常数 DT ，可以使微分的作用达到最优。 
(2)数字 PID 控制算法 

由于计算机的出现，计算机进入了控制领域。人们将模拟 PID 控制规律引入到计算机 
 
中来。由于计算机控制是一种采样控制，它只能根据采样使可的偏差计算控制量，而不能

象模拟控制那样连续输出控制量，进行连续控制。由于这一特点，式(1-1)中的积分和微分

项不能直接使用，不许进行离散化处理。离散化处理的方法为：以 T 作为采样周期，k 作

为采样序号，则离散采样时间 kT 对应着连续时间 t，用求和的形式代替积分，用增量的形

式代替微分，可作如下近似变换： 
 

 
kTt ≈                  k=(0,1,2,…) 

∑∑∫
==

=≈
k

j
j
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上式中，为了表示方便，将类似于 e(kT)键化成 ke 等。 
将式(1-2)代入式(1-1)，就可以得到离散的 PID 表达式： 
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或 
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j
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=
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式中：k ——采样信号，k=0,1,2,… 
      ku ——第 k 次采样时刻的计算机输出值 
      ke ——第 k 次采样时刻输入的偏差值 
      1−ke ——第 k-1 次采样时刻输入的偏差值 
      IK ——积分系数，

I

P
I T

TKK =  
      DK ——微分系数，

T
TKK DP

D =  
      0u ——开始进行 PID 控制时的原始初值 
 
如果采样周期取得足够小，则以上近似计算可获得足够精确的结果，离散控制过程与
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连续控制过程十分接近。 
如果只需要计算控制量的增量 kuΔ ，可以使用增量式 PID 控制算法。由式(1-3)可得控

制器在第 k-1 个采样时刻的输出值为 
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T
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T
TeKu kk

D
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j
j

I
kPk +−++= −−

−

=
−− ∑                         (1-5) 

 
将(1-3)与(1-5)相减，就可以得到增量式 PID 控制算法公式为 
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式中： )1(
T
T

T
TKA D

I
P ++= ， )21(

T
TKB D

P +−= ，
T
TKC D

P=  

 
由式(1-6)可以看出，如果计算机控制系统采用恒定的采样周期 T,一旦确定了 A、B、C，

只要用前后 3 次测量值的偏差，就可以由式(1-6)求出控制增量。 

(3)程序设计 

-控制环节：系统维护一个全局变量 pwm，计算控制电机绕组电压的 PWM 波形的占空比，

取值越大，通过电机的电流越多，电机加速，反之，占空比越小电机越慢。 

-采样环节：由于电机速度反馈信号频率为几十赫兹，所以设计测量周期较长，这样保证偶

然偏差值较少发生，但系统“反应”较慢。采样脉冲设计为 1 赫兹的方波信号。测量的

结果为电机转动圈数，比如测速结果为 84，则实际转速为 84 转/秒。 

-计算环节：利用公式(1-6)，取 A=0.6、B=0.2、C=0.1，直接由测速结果计算出占空比调节

增量，计算中限制了增量的最大值不能超过 10，以免引起太大的电流波动。 

-显示：在每次调节电机转速时刷新显示各参数。“设定”为实验者指定电机转速，单位为

“转/秒”；“测速”为通过采样环节得到的电机速度测量值，单位也为“转/秒”；“误差”

指速度测量值与设定值之差；“调整”为通过 PID 算法得到并付诸调整的调整值，调整对

象为占空比；“占空比”当前采用的占空比；“输入”通过小键盘输入新的转速设置，按

“Enter”键生效。 
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9． 程序流程图： 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
四．实验步骤 

1．实验准备 

开始 

结束 

初始化：CPU 频率、ICETEK-CTR、工作变量、
LCD 库、定时器、中断控制寄存器、液晶显示内容 

有键盘输入？

处理输入速度值 

Num Lock？ 关闭 ICETEK-CTR 

是

是

否

否

有 GEL 输入？

是

否

处理输入速度值 

读取速度，求平均速度 

调用 PID 算法程序，用结果改变
PWM 波形的占空比 

显示当前各参数 



         瑞泰创新—ICETEK-F2812-A 教学系统软件实验指导 

 
 
地址：北京市海淀区知春路 108 号豪景大厦 A 座 18 层                    http://www.realtimedsp.com.cn 
电话：010-62105690(中继)/91-97                                      传真：010-62105699   

199 

(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)将 ICETEK-CTR 板的供电电源开关拨动到“开”的位置。 

 
2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 

请参看本书第三部分、第一章、四、2。 
3．启动 Code Composer Studio 3.3 

请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

4．打开工程文件 
工程目录 C:\ICETEK\F2812\DSP281x_examples\lab0604-PID\V60 
浏览 PID.c 文件的内容，理解各语句作用。 

5．编译、下载、运行程序观察结果 
-单击“Debug”菜单，“Run”项，运行程序。 
-观察 ICETEK-CTR 上液晶上的显示。 

6．设置电机转速 
-按小键盘上数字键，修改转速(单位：转/秒)，输入在液晶显示屏上可观察，按回车生效。

继续观察液晶显示屏中参数在 PID 控制算法下的变化。 
7．结束程序运行，退出 CCS。 

请参看本书第三部分、第一章、六。 
 

五．实验结果 
我们可以看到液晶屏幕上占空比随 PID 算法控制逐步改变，同时电机转速也同设置值逐步

接进并稳定。 
 

六．问题与思考 
PID 控制的参数可以随需要变化，当采用不同的参数组合时，得到的系统响应也不尽相同，

优化的参数区值并不是唯一的。在凑试参数时，可以按照先比例—后积分—再微分的顺序反复

调试参数，直到满意为止。 
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实验 6.4.2：PID 算法控制实验(V61 版) 

 
一．实验目的 

1．掌握利用 ICETEK–F2812-A 评估板与 ICETEK-CTR 板上带速度反馈的直流电机 B 的

连接和控制原理。 
2．熟悉 F2812DSP 的通用 IO 端口和定时器的编程使用。 
3．学习利用数字 PID 控制算法控制电机转速。 

 
二．实验设备 

计算机，ICETEK-F2812-EDU 实验箱。 
 

三．实验原理 
1．直流电机测速原理 

直流电机：在 ICETEK-CTR 板上有一个带速度反馈的直流电机，带有速度反馈线路，

反馈信号为方波脉冲，其频率与转速成正比(电机转动一圈产生两个脉冲)。 
电机闭环控制系统：如图在 DSP 系统板的控制下形成闭环速度控制系统，DSP 发送的

PWM 波控制直流电机的转速，通过速度反馈，DSP 可实时读取当前速度值，利用 DSP 中

运行的控制程序根据速度读数控制 PWM 的脉宽，从而实现闭环调速控制。 
 

 
 
 

                           
 
 
 
 
 
 
 

 

图 3.2.6.6  直流电机设计原理 

 
2．数字 PID 控制器 

将偏差的比例(P)、积分(I)和微分(D)通过线性组合构成控制量，用这一控制量对被控对象

进行控制，这样的控制器称 PID 控制器。 
(1)模拟 PID 控制原理 
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模拟 PID 控制系统原理图如图所示。该系统由模拟 PID 控制器和被控对象组成。图中，

r(t)是给定值，y(t)是系统的实际输出值，给定值与实际输出值构成控制偏差 e(t) 
e(t)=r(t)-y(t) 
e(t)作为 PID 控制器的输入，u(t)作为 PID 控制器的输出和被控对象的输入。所以模拟

PID 控制器的控制规律为 

00

)()(1)()( u
dt

tdeTdtte
T

teKtu
t

D
I

P +⎥
⎦

⎤
⎢
⎣

⎡
++= ∫    (1-1) 

其中： PK ——比例系数 
      IT ——积分常数 
 
      DT ——微分常数 
      0u ——控制常量 
 
 

 
 
      r(t)      +      )(te               +    +   )(tu                  y(t) 
             )(tn   -                      + 
 
 
 

 
 
比例环节的作用是对偏差瞬间做出快速反应。偏差一旦产生，控制器立即产生控制作

用，使控制量向减少偏差的方向变化。控制作用的强弱取决于比例系数 PK ， PK 越大，

控制越强，但过大的 PK 会导致系统震荡，破坏系统的稳定性。 
积分环节的作用是把偏差的积累作为输出。在控制过程中，只要有偏差存在，积分环

节的输出就会不断增大。直到偏差 e(t)=0，输出的 u(t)才可能维持在某一常量，使系统在给

定值 r(t)不变的条件下趋于稳态。积分环节的调节作用虽然会消除静态误差，但也会降低

系统的响应速度，增加系统的超调量。积分常数 IT 越大，积分的积累作用越弱。增大积分

常数 IT 会减慢静态误差的消除过程，但可以减少超调量，提高系统的稳定性。所以，必须

根据实际控制的具体要求来确定 IT 。 
微分环节的作用是阻止偏差的变化。它是根据偏差的变化趋势(变化速度)进行控制。

偏差变化得越快，微分控制器的输出越大，并能在偏差值鞭打之前进行修正。微分作用的

引入，将有助于减小超调量，克服震荡，使系统趋于稳定。但微分的作用对输入信号的噪

声很敏感，对那些噪声大的系统一般不用微分，或在微分起作用之前先对输入信号进行滤 
波。适当地选择微分常数 DT ，可以使微分的作用达到最优。 
(2)数字 PID 控制算法 

由于计算机的出现，计算机进入了控制领域。人们将模拟 PID 控制规律引入到计算机 

积分 被控对象 

比例 

微分 
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中来。由于计算机控制是一种采样控制，它只能根据采样使可的偏差计算控制量，而不能

象模拟控制那样连续输出控制量，进行连续控制。由于这一特点，式(1-1)中的积分和微分

项不能直接使用，不许进行离散化处理。离散化处理的方法为：以 T 作为采样周期，k 作

为采样序号，则离散采样时间 kT 对应着连续时间 t，用求和的形式代替积分，用增量的形

式代替微分，可作如下近似变换： 
 

 
kTt ≈                  k=(0,1,2,…) 

∑∑∫
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上式中，为了表示方便，将类似于 e(kT)键化成 ke 等。 
将式(1-2)代入式(1-1)，就可以得到离散的 PID 表达式： 
 

01
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或 
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式中：k ——采样信号，k=0,1,2,… 
      ku ——第 k 次采样时刻的计算机输出值 
      ke ——第 k 次采样时刻输入的偏差值 
      1−ke ——第 k-1 次采样时刻输入的偏差值 
      IK ——积分系数，

I

P
I T

TK
K =  

 
      DK ——微分系数，

T
TKK DP

D =  
      0u ——开始进行 PID 控制时的原始初值 
 
如果采样周期取得足够小，则以上近似计算可获得足够精确的结果，离散控制过程与

连续控制过程十分接近。 
如果只需要计算控制量的增量 kuΔ ，可以使用增量式 PID 控制算法。由式(1-3)可得控

制器在第 k-1 个采样时刻的输出值为 
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将(1-3)与(1-5)相减，就可以得到增量式 PID 控制算法公式为 
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式中： )1(
T
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T
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I
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由式(1-6)可以看出，如果计算机控制系统采用恒定的采样周期 T,一旦确定了 A、B、C，

只要用前后 3 次测量值的偏差，就可以由式(1-6)求出控制增量。 

(3)程序设计 

-控制环节：系统维护一个全局变量 pwm，计算控制电机绕组电压的 PWM 波形的占空比，

取值越大，通过电机的电流越多，电机加速，反之，占空比越小电机越慢。 

-采样环节：由于电机速度反馈信号频率为几十赫兹，所以设计测量周期较长，这样保证偶

然偏差值较少发生，但系统“反应”较慢。采样脉冲设计为 1 赫兹的方波信号。测量的

结果为电机转动圈数，比如测速结果为 84，则实际转速为 84 转/秒。 

-计算环节：利用公式(1-6)，取 A=0.6、B=0.2、C=0.1，直接由测速结果计算出占空比调节

增量，计算中限制了增量的最大值不能超过 10，以免引起太大的电流波动。 

-显示：在每次调节电机转速时刷新显示各参数。“设定”为实验者指定电机转速，单位为

“转/秒”；“测速”为通过采样环节得到的电机速度测量值，单位也为“转/秒”；“误差”

指速度测量值与设定值之差；“调整”为通过 PID 算法得到并付诸调整的调整值，调整对

象为占空比；“占空比”当前采用的占空比；“输入”通过键盘输入新的转速设置，按“9”

键生效。 

10． 程序流程图： 
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四．实验步骤 

1．实验准备 
(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)将 ICETEK-CTR 板的供电电源开关拨动到“开”的位置。 

注意:只有 2812 的实验箱须在扩展模块上的“JP1”跳线设置为 2，3 连接方式，其他

系列 dsp 板卡须设置为 1，2 连接状态。 

开始 

结束 

初始化：CPU 频率、ICETEK-CTR、工作变量、
LCD 库、定时器、中断控制寄存器、液晶显示内容 

有键盘输入？

处理输入速度值 

Num Lock？ 关闭 ICETEK-CTR 

是

是

否

否

有 GEL 输入？

是

否

处理输入速度值 

读取速度，求平均速度 

调用 PID 算法程序，用结果改变
PWM 波形的占空比 

显示当前各参数 
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2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 

请参看本书第三部分、第一章、四、2。 
3．启动 Code Composer Studio 3.3 

请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

4．打开工程文件 
工程目录 C:\ICETEK\F2812\DSP281x_examples\lab0604-PID\V61 
浏览 PID.c 文件的内容，理解各语句作用。 

5．编译、下载、运行程序观察结果 
-单击“Debug”菜单，“Run”项，运行程序。 
-观察 ICETEK-CTR 上液晶上的显示。 

6．设置电机转速 
-按键盘上数字键，修改转速(单位：转/秒)，输入在液晶显示屏上可观察，按“9”键生效。

继续观察液晶显示屏中参数在 PID 控制算法下的变化。 
7．结束程序运行，退出 CCS。 

请参看本书第三部分、第一章、六。 
 

五．实验结果 
我们可以看到液晶屏幕上占空比随 PID 算法控制逐步改变，同时电机转速也同设置值逐步

接进并稳定。 
 

六．问题与思考 
PID 控制的参数可以随需要变化，当采用不同的参数组合时，得到的系统响应也不尽相同，

优化的参数区值并不是唯一的。在凑试参数时，可以按照先比例—后积分—再微分的顺序反复

调试参数，直到满意为止。 
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实验 6.4.3：PID 算法控制实验(V80 版) 

 
一．实验目的 

1．掌握利用 ICETEK-F2812-A 评估板与 ICETEK-CTR 板上带速度反馈的直流电机 B 的

连接和控制原理。 
2．熟悉 F2812DSP 的通用 IO 端口和定时器的编程使用。 
3．学习利用数字 PID 控制算法控制电机转速。 

 
二．实验设备 

计算机，ICETEK-F2812-EDU 实验箱。 
 

三．实验原理 
1．直流电机测速原理 

直流电机 B：在 ICETEK-CTR 板上有一个带速度反馈的直流电机 B，它的额定工作电

压为+12V，额定转速为 6500 转，带有速度反馈线路，反馈信号为方波脉冲，其频率与转

速成正比(电机转动一圈产生两个脉冲)。 
电机闭环控制系统：如图在 DSP 系统板的控制下形成闭环速度控制系统，DSP 发送的

PWM 波控制直流电机的转速，通过速度反馈，DSP 可实时读取当前速度值，利用 DSP 中

运行的控制程序根据速度读数控制 PWM 的脉宽，从而实现闭环调速控制。 
 

 
 
 

                           
 
 
 
 
 
 
 

 

图 3.2.6.7  直流电机设计原理 

 
2．数字 PID 控制器 

将偏差的比例(P)、积分(I)和微分(D)通过线性组合构成控制量，用这一控制量对被控对象

进行控制，这样的控制器称 PID 控制器。 
(1)模拟 PID 控制原理 
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模拟 PID 控制系统原理图如图所示。该系统由模拟 PID 控制器和被控对象组成。图中，

r(t)是给定值，y(t)是系统的实际输出值，给定值与实际输出值构成控制偏差 e(t) 
e(t)=r(t)-y(t) 
e(t)作为 PID 控制器的输入，u(t)作为 PID 控制器的输出和被控对象的输入。所以模拟

PID 控制器的控制规律为 

00

)()(1)()( u
dt

tdeTdtte
T

teKtu
t

D
I

P +⎥
⎦

⎤
⎢
⎣

⎡
++= ∫    (1-1) 

其中： PK ——比例系数 
      IT ——积分常数 
 
      DT ——微分常数 
      0u ——控制常量 
 
 

 
 
      r(t)      +      )(te               +    +   )(tu                  y(t) 
             )(tn   -                      + 
 
 
 

 
 
比例环节的作用是对偏差瞬间做出快速反应。偏差一旦产生，控制器立即产生控制作

用，使控制量向减少偏差的方向变化。控制作用的强弱取决于比例系数 PK ， PK 越大，

控制越强，但过大的 PK 会导致系统震荡，破坏系统的稳定性。 
积分环节的作用是把偏差的积累作为输出。在控制过程中，只要有偏差存在，积分环

节的输出就会不断增大。直到偏差 e(t)=0，输出的 u(t)才可能维持在某一常量，使系统在给

定值 r(t)不变的条件下趋于稳态。积分环节的调节作用虽然会消除静态误差，但也会降低

系统的响应速度，增加系统的超调量。积分常数 IT 越大，积分的积累作用越弱。增大积分

常数 IT 会减慢静态误差的消除过程，但可以减少超调量，提高系统的稳定性。所以，必须

根据实际控制的具体要求来确定 IT 。 
微分环节的作用是阻止偏差的变化。它是根据偏差的变化趋势(变化速度)进行控制。

偏差变化得越快，微分控制器的输出越大，并能在偏差值鞭打之前进行修正。微分作用的

引入，将有助于减小超调量，克服震荡，使系统趋于稳定。但微分的作用对输入信号的噪

声很敏感，对那些噪声大的系统一般不用微分，或在微分起作用之前先对输入信号进行滤 
波。适当地选择微分常数 DT ，可以使微分的作用达到最优。 
(2)数字 PID 控制算法 

由于计算机的出现，计算机进入了控制领域。人们将模拟 PID 控制规律引入到计算机 

积分 被控对象 

比例 

微分 
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中来。由于计算机控制是一种采样控制，它只能根据采样使可的偏差计算控制量，而不能

象模拟控制那样连续输出控制量，进行连续控制。由于这一特点，式(1-1)中的积分和微分

项不能直接使用，不许进行离散化处理。离散化处理的方法为：以 T 作为采样周期，k 作

为采样序号，则离散采样时间 kT 对应着连续时间 t，用求和的形式代替积分，用增量的形

式代替微分，可作如下近似变换： 
 

 
kTt ≈                  k=(0,1,2,…) 

∑∑∫
==

=≈
k

j
j

k

j

t
eTjTeTdtte

00
0

)()(                                     (1-2) 

T
ee

T
TkekTe

dt
tde kk 1])1[()()( −−

=
−−

≈  

 
 
 
 
上式中，为了表示方便，将类似于 e(kT)键化成 ke 等。 
将式(1-2)代入式(1-1)，就可以得到离散的 PID 表达式： 
 

01
01

)]([ uee
T
T

e
T
TeKu kk

D
k

j
jkPk +−++= −

=
∑                        (1-3) 

 
或 

 

01
0

)( ueeKeKeKu kkD

k

j
jIkPk +−++= −

=
∑                         (1-4) 

 
式中：k ——采样信号，k=0,1,2,… 
      ku ——第 k 次采样时刻的计算机输出值 
      ke ——第 k 次采样时刻输入的偏差值 

      1−ke ——第 k-1 次采样时刻输入的偏差值 

      IK ——积分系数，
I

P
I T

TK
K =  

      DK ——微分系数，
T
TK

K DP
D =  

      0u ——开始进行 PID 控制时的原始初值 

 
如果采样周期取得足够小，则以上近似计算可获得足够精确的结果，离散控制过程与

连续控制过程十分接近。 
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如果只需要计算控制量的增量 kuΔ ，可以使用增量式 PID 控制算法。由式(1-3)可得控

制器在第 k-1 个采样时刻的输出值为 
 
 

021

1

0
11 )]([ uee

T
T

e
T
TeKu kk

D
k

j
j

I
kPk +−++= −−

−

=
−− ∑                         (1-5) 

 
将(1-3)与(1-5)相减，就可以得到增量式 PID 控制算法公式为 
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D
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TeeKuuu  
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2
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D
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D

Pk
D

I
P e
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21 −− ++ kkk CeBeAe                                             (1-6) 
 
 

式中： )1(
T
T

T
TKA D

I
P ++= ， )21(

T
T

KB D
P +−= ，

T
T

KC D
P=  

 
由式(1-6)可以看出，如果计算机控制系统采用恒定的采样周期 T,一旦确定了 A、B、C，

只要用前后 3 次测量值的偏差，就可以由式(1-6)求出控制增量。 

(3)程序设计 

-控制环节：系统维护一个全局变量 pwm，计算控制电机绕组电压的 PWM 波形的占空比，

取值越大，通过电机的电流越多，电机加速，反之，占空比越小电机越慢。 

-采样环节：由于电机速度反馈信号频率为几十赫兹，所以设计测量周期较长，这样保证偶

然偏差值较少发生，但系统“反应”较慢。采样脉冲设计为 1 赫兹的方波信号。测量的

结果为电机转动圈数，比如测速结果为 84，则实际转速为 84 转/秒。 

-计算环节：利用公式(1-6)，取 A=0.6、B=0.2、C=0.1，直接由测速结果计算出占空比调节

增量，计算中限制了增量的最大值不能超过 10，以免引起太大的电流波动。 

-显示：在每次调节电机转速时刷新显示各参数。“设定”为实验者指定电机转速，单位为

“转/秒”；“测速”为通过采样环节得到的电机速度测量值，单位也为“转/秒”；“误差”

指速度测量值与设定值之差；“调整”为通过 PID 算法得到并付诸调整的调整值，调整对

象为占空比；“占空比”当前采用的占空比；“输入”通过小键盘输入新的转速设置，按

“Enter”键生效。 

11． 程序流程图： 
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四．实验步骤 

1．实验准备 
(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)将 ICETEK-CTR 板的供电电源开关拨动到“开”的位置。 

 

开始 

结束 

初始化：CPU 频率、ICETEK-CTR、工作变量、
LCD 库、定时器、中断控制寄存器、液晶显示内容 

有键盘输入？

处理输入速度值 

Num Lock？ 关闭 ICETEK-CTR 

是

是

否

否

有 GEL 输入？

是

否

处理输入速度值 

读取速度，求平均速度 

调用 PID 算法程序，用结果改变
PWM 波形的占空比 

显示当前各参数 
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2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 
请参看本书第三部分、第一章、四、2。 

 
3．启动 Code Composer Studio 3.3 

请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

 
4．打开工程文件 

选择文件为 C:\ICETEK\F2812\DSP281x_examples\lab0604-PID\V80。 
浏览 PID.c 文件的内容，理解各语句作用。 

 
5．编译、下载、运行程序观察结果 

-单击“Debug”菜单，“Run”项，运行程序。 
-观察 ICETEK-CTR 上液晶上的显示。 

 
6．设置电机转速 

-通过 8 件数字键盘，修改转速(单位：转/秒)，k1 键为+1，k2 键为-1，k3 键为+10，k4 键
为-10。继续观察液晶显示屏中参数在 PID 控制算法下的变化。 

 
7．结束程序运行，退出 CCS。 

请参看本书第三部分、第一章、六。 
 

五．实验结果 
我们可以看到液晶屏幕上占空比随 PID 算法控制逐步改变，同时电机转速也同设置值逐步

接进并稳定。“设定”显示当前设定的稳定转速；“测速”显示当前的实际转速；“误差”显示

当前实际速度与设定值的差距；“调整”显示每次误差的调整值；“占空比”显示当前方波波形

的占空比。 
 
六．问题与思考 
PID 控制的参数可以随需要变化，当采用不同的参数组合时，得到的系统响应也不尽相同，优

化的参数区值并不是唯一的。在凑试参数时，可以按照先比例—后积分—再微分的顺序反复调

试参数，直到满意为止。 
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七. 语音信号采集与分析实验 

（注意此部分实验需要另配 icetek-aic23-e 背板后才可以运行） 

 
实验 7.1：语音采集和放送 

 
一．实验目的 

1．了解 ICETEK–F2812-A 评估板上扩展语音 codec 芯片 TLV320AIC23 的设计和程序控

制原理。 
2．了解数字回声产生原理、编程及其参数选择、控制。 
3．熟悉 F2812DSP 扩展存储器的编程使用方法。 

 
二．实验设备 

计算机，ICETEK-F2812-A 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 系统板+相关

连线及电源），ICETEK-AIC23-E 背板，耳机，麦克风。 
 

三．实验原理 
1．TLV320AIC23 芯片性能指标及控制方法 
-请参见本书第一部分、第六章。 
-背板位置及其插座： 
 

 
 
图 3.2.7.1  ICETEK-AIC23-E 板实物图 

 
-语音信号的输入：AIC23 通过其中的 AD 转换采集输入的语音信号，每采集完一个信号后，

将数据发送到 DSP 的 McBSP 接口上，DSP 可以读取到语音数据，每个数据为 16 位无符

号整数，左右通道各有一个数值。 
-语音信号的输出：DSP 可以将语音数据通过 McBSP 接口发送给 AIC23，AIC23 的 DA 器

件将他们变成模拟信号输出。 
2．数字回声原理 

在实际生活中，当声源遇到物体时，会发生反射，反射的声波和声源声波一起传输，听

者会发现反射声波部分比声源声波慢一些，类似人们面对山体高声呼喊后可以在过一会儿听

到回声的现象。声音遇到较远的物体产生的反射会比遇到较近的物体的反射波晚些到达声源

TLV320AIC23 耳机输出 

立体声输出 

立体声线入 

麦克风输入 
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位置，所以回声和原声的延迟随反射物体的距离大小改变。同时，反射声音的物体对声波的

反射能力， 
决定了听到的回声的强弱和质量。另外，生活中的回声的成分比较复杂，有反射、漫反

射、折射，还有回声的多次反、折射效果。 
当已知一个数字音源后，可以利用计算机的处理能力，用数字的方式通过计算模拟回声

效应。简单地讲，可以在原声音流中叠加延迟一段时间后的声流，实现回声效果。当然通过

复杂运算，可以计算各种效应的混响效果。如此产生的回声，我们称之为数字回声。 
3．程序流程图： 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
四．实验步骤 

1．实验准备 
(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)准备音频输入、输出设备。 

 

注意：ICETEK-AIC23-E 背板可以在 2812，5416，6713 等板卡上使用，但要根据图 2-33-2 

来重新插板上跳线，此图在背板背面有绘制。 
 

是 

否 

开始 

初始化： CPU 频

率、AIC23 

制作回声？ 

读取语音数据 

保存于语音缓冲区 

语音数据输出到 McBSP0 

是 

否 

中断开始 

等待 McBSP 通道 0 传送结束 

根据延迟参数读回保存数据 

MCBSP 中断

产生 
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图 3.2.7.2  跳线设置说明 
 
 
   把 ICETEK-AIC23-E 板插到 ICETEK–F2812-A 评估板上，图 2-33-3 中的 P4 插槽和插

入到图 2-33-4 的 P4 插槽；，图 2-33-3 中的 P3 插槽和插入到图 2-33-4 的 P3 插槽上。完成

后的样子如图 2-33-5。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
                           

 
 

图 3.2.7.3  ICETEK–F2812-A 评估板 
 

 
 

P4 插槽 

P3 插槽 
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图 3.2.7.4  ICETEK-AIC23-E 背板 
 
 

①将耳机上麦克风插头插到 ICETEK–F2812-A 评估板的 LINE IN 插座，即图 2-33-4 中

“麦克风输入”。 
②将耳机上音频输入插头插到 ICETEK–F2812-A 评估板的 PHONE 插座，即图 2-33-4
中“耳机输出”。 

④调节耳机上音量旋钮到适中位置。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
                    

图 3.2.7.5  ICETEK–F2812-A+ICETEK-AIC23-E 
 

 
2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 

请参看本书第三部分、第一章、四、2。 
 
3．启动 Code Composer Studio 3.3 

请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

P4 插槽 P3 插槽 
麦克风 
输入 

耳机 
输出 
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4．打开工程文件 
工程目录为：C:\ICETEK\F2812\DSP281x_examples\Lab0701-Echo。 

5．编译、下载程序，选择菜单 Debug->Go Main，使程序运行到 main 函数入口位置。 
6．设置观察窗口 

打开源程序 AIC23_Loopback.c，将变量 bEcho 和 uEffect 加入观察窗口。 
7．运行程序观察结果 

-按“F5”键运行，注意观察窗口中的 bEcho=0，表示数字回声功能没有激活。 
-这时从耳机中能听到麦克风中的输入语音放送。 
-将观察窗口中 bEcho 的取值改成非 0 值。 
-这时可从耳机中听到带数字回声道语音放送。 
-试着调整 uEffect 的取值，使他们保持在 0-0xd000 范围内，同时听听耳机中的输出有何变

化。 
8．退出 CCS 

请参看本书第三部分、第一章、六。 
 

五．实验结果 
声音放送可以加入数字回声，数字回声与原声的延迟可在程序中设定和调整。 

 
六．问题与思考 

请修改实验程序，实现第二重回声。例如：原声音直接放送表示为“A------”，而带数字回

声的发送为“A—a----”，那么带第二重回声的为“A—a—a---”。第二重回声的音效要比第一重

的弱。 
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实验 7.2：语音信号编码解码(G.711) 

（注意此部分实验需要另配 icetek-aic23-e 背板后才可以运行） 

 
一．实验目的 

1． 熟悉 ICETEK–F2812-A 评估板上扩展语音 codec 芯片 TLV320AIC23 的设计和程序

控制原理。 
2．了解语音编码 G.711 的特点、工作原理及其编程。 
3．了解 PCM 编码过程及应用，学习 ALaw 压缩解压缩方法的运算过程和程序编制实现。 
4．通过实验体会语音编解码过程及应用。 

 
二．实验设备 

计算机，ICETEK-F2812-A 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 系统板+相关连

线及电源），耳机，麦克风。 
 

三．实验原理 
1．TLV320AIC23 芯片性能指标及控制方法 

见上一个实验。 
2．G.711 语音编码标准 

G.711 是国际电报电话咨询委员会(CCITT)和国际标准化组织(ISO)提出的一系列有关音

频编码算法和国际标准中的一种。应用于电话语音传输。 
G.711 是一种工作在 8kHz 采样率模式下的脉冲编码调制(Pulse Code Modulation,PCM)

方案，采样值是 8 位的。按照恩奎斯特法则规定，采样频率必须由高于被采信号最大频率

成分的 2 倍，G.711 可以编码的频率范围是从 0 到 4kHz。G.711 可以由两种编码方案：A
律和μ律。 

G.711 采用 8kHz、8 位编码值，占用带宽为 64kbps。 
3．PCM 编码 

在电话网络中规定，传输语音部分采用 0.3 到 3.3kHz 的语音信号。这一频率范围可覆

盖大部分语音信号，它可以保留语音频率的前 3 个共振峰信息，而通过分析这 3 个共振峰

的频率特性和幅度特性可以识别不同人，而 0-0.3Hz 和 3.3kHz-4kHz 未用，也被当成保护

波段。总之，电话网络具有 4kHz 的带宽。由于需要通过这一带宽传送小幅变化的语音信

号，需要借助于脉冲调制编码(PCM)，使模拟的语音信号在数字化时使用固定的精度，以

最小的代价得到高质量的语音信号。 
PCM 编码需要经过连续的三步：抽样、量化和编码。抽样取决于信号的振幅随时间的

变化频率，由于电话网络的带宽是 4kHz 的，为了精确地表现语音信号，必须用至少 8kHz
的抽样率来取样。量化的任务是由模拟转换成数字的过程，但会引入量化误差，应尽量采

用较小的量化间隔来减小这一误差。最后，编码完成数字化的最后工作，在编码的过程中，

应保存信息的有效位，而且算法应利于快速计算，无论是编码还是解码。 
其中，压扩运算可以采用两种标准：A 律(A-law)和μ律(μ-law)。μ律是美洲和日本的

公认标准，而 A 律是欧洲采用的标准。我国采用的是欧洲标准。 
4．A 律压扩标准 

A 律(A-Law)编码的数据对象是 12 位精度的，它保证了压缩后的数据有 5 位的精度并存

储到一个字节(8 位)中。其方程如下： 
F(x) = sgn(x) A |x| / (1 + lnA)   0 < |x| < 1/A  

= sgn(x) (1+ln A|x|) /(1 + lnA)  1/A < |x| < 1 
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其中，A 为压缩参数取值 87.6，x 为规格化的 12 位(二进制)整数。下面是用折线逼近的

压缩 
图 3.2.7.6 方程曲线示意图 

 

 
 
 
我们将 A 律压缩编码图示如下： 
 

 
 

图 3.2.7.7  A 律压缩编码图 1 
 
 
A 律解码方程为： 
 

 

 
 

 
A 律解码示意图： 
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图 3.2.7.8  A 律压缩编码图 2 
 

一般地，用程序进行 A 律编码解码有两种方法：一种是直接计算法，这种方法程序代

码较多，时间较慢，但可节省宝贵的内存空间；另一种是查表法，这种方法程序量小、运

算速度快，但占用较多的内存以存储查找表。 
5．程序流程图：见最后。 

 
四．实验步骤 

1．实验准备 
(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)准备音频输入、输出设备。 
①测试计算机语音输出：用“我的电脑”帮助启动播放语音文件

C:\ICETEK\F2812\Lab0702-AudioG711\Audio\LineIn.mp3，并选择播放器参数为循环播

放；将耳机上音频输入插头插入计算机上耳机插座；仔细听耳机中是否有输出、左右声

道应该输出不同。 
②拔下耳机音频输入插头，用实验箱附带的音频连接线(两端均为双声道音频插头) 将耳

机上麦克风插头插到 ICETEK–F2812-A 评估板的 LINE IN 插座，即图 2-33-4 中“麦克

风输入”。 
③将耳机上音频输入插头插到 ICETEK–F2812-A 评估板的 PHONE 插座，即图 2-33-4
中“耳机输出”。 
④调节耳机上音量旋钮到适中位置。 

2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 
请参看本书第三部分、第一章、四、2。 

3．启动 Code Composer Studio 3.3 
请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

4．打开工程文件 
工程目录为：C:\ICETEK\F2812\DSP281x_examples\Lab0702-AudioG711。 
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5．编译、下载、运行程序到 main 函数。 
6．设置观察窗口 

 
打开 AIC23_Loopback.c，将变量 bCodec 加入观察窗口。 

7．运行程序，听效果 
-按“F5”键，可以听到立体声线路输入的语音信号。这时的语音信号并未经过压扩处理。 
-修改观察窗口中 bCodec 的值为非 0 值，启动 A-law 压扩算法，听效果。 
-反复修改 bFIR 的值成 0 或非 0，比较原声和编码并还原的声音。 

8．退出 CCS 
请参看本书第三部分、第一章、六。 

 
五．实验结果 

分析：压扩后的声音与原声质量相近，且左右声道使用一个缓冲区存储，至少节省了一半

存储空间。实验程序采用了直接计算方法进行压缩和解压缩。 
 
六．问题与思考 

试采用查找表法提高压扩算法速度。 
 
程序流程图： 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

否 

是 

开始 

初始化：CPU 频率、
AIC23 

读取语音数据 

保存于缓冲区 

中断开始 

等待 McBSP 通道 0 传送结束 

调用解码函数生成声音数据 

声音数据 
输出到 McBSP0 

调用编码函数进行 ALaw 压缩 

PCM 编码？ 

是 

否 

 
MCSP 产生

中断
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实验 7.3：语音信号的 FIR 滤波 

（注意此部分实验需要另配 icetek-aic23-e 背板后才可以运行） 

一．实验目的 
1．熟悉 ICETEK–F2812-A 评估板上语音 codec 芯片 TLV320AIC23 的设计和程序控制原

理。 
2．熟悉 FIR 滤波器工作原理及其编程。 
3．掌握使用 TI 的算法库 filter 提高程序运行效率的方法。 
4．学习使用 CCS 图形观察窗口观察和分析语音波形及其频谱。 

 
二．实验设备 

计算机，ICETEK-F2812-A 实验箱（或 ICETEK 仿真器+ICETEK–F2812-A 系统板+相关连

线及电源），耳机，双头音频线。 
 

三．实验原理 
1．TLV320AIC23 芯片性能指标及控制方法 

-请参见实验 7.1、三、1。-  
2．FIR 滤波器原理 

请参见实验 5.1、三、1。 
参数选取：实验程序采用 64 阶滤波参数，低通滤波，汉明窗(Hamming Window)函数，

截止频率为 1000Hz，采样频率为 48000Hz，增益 1dB。 
3．TI 的算法库 filter.lib 

在这里，我们需要调用 filter.lib。为什么要用算法库来完成语音滤波？实验 5.1 已经完

成了 fir 滤波了，为什么没有放到本实验中？原因是：实验 5.1 的滤波程序为了容易读懂，

采用 c 语言来写的，没有经过优化，代码的执行效率比较低，在不考虑实时处理的情况时，

是没问题的。但本实验是对语音信号进行实时滤波处理，就必须采用一种执行速度比较快

的滤波算法程序来完成。Ti 提供的滤波算法库是目前已知的在 DSP 上运算速度最快的一

种程序。 
4．程序流程图： 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

是 

否

开始

初始化： CPU 频

率、AIC23 

读取语音数据 

保存左声道缓冲区 

滤波结果送左右声 
道，输出到 McBSP0 

计算 FIR 滤波输出 

MCBSP 接口
等待数据接

收完毕
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四．实验步骤 
1．实验准备 
(1)连接实验设备：请参看本书第三部分、第一章、二。 
(2)准备音频输入、输出设备。 
①测试计算机语音输出：双击

C:\ICETEK\F2812\DSP281x_examples\Lab0703-AudioFIR\SweepGen.exe（见图

2-35-1）.。将耳机上音频输入插头插入计算机上耳机插座，可以听到从 20hz---20khz
频率的声音输出。 

 

 
 
 
图 3.2.7.9   输出声音的软件界面 
 
 

②拔下耳机音频输入插头，用实验箱附带的音频连接线(两端均为双声道音频插头) 将耳

机上麦克风插头插到 ICETEK–F2812-A 评估板的 LINE IN 插座，即图 2-33-4 中“麦

克风输入”。 
③将耳机上音频输入插头插到 ICETEK–F2812-A 评估板的 PHONE 插座，即图 2-33-4
中“耳机输出”。 

④调节耳机上音量旋钮到适中位置。 
2．设置 Code Composer Studio 3.3 在硬件仿真(Emulator)方式下运行 

请参看本书第三部分、第一章、四、2。 
3．启动 Code Composer Studio 3.3 

请参看本书第三部分、第一章、五、2。 
选择菜单 Debug→Reset CPU。 

4．打开工程文件 
 

1．设置
20hz—20khz
频率输出 

2．选择快速

变换频率 

3．启动音频输出 
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工程目录为：C:\ICETEK\F2812\DSP281x_examples\Lab0703-AudioFIR\projects。 
5．编译、下载、运行程序。 
  可以听到高频部分的声音被消除掉了。可以下载实验 7.1 程序做对比，这是未经处理的声 

音采集输出， 
6．设置断点 

在 main_nonBIOS.c 文件中标注有“//设置软件断点”注释的语句上加注软件断点(双击此

行前的灰色控制条)，程序会停止在此行上。 
7．打开观察窗口，观察滤波效果显示 

-分 3 次选择菜单 View->Graph->Time/Frequency，分别使用以下参数打开 3 个观察窗口： 
 

 
 

图 3.2.7.10  观察窗口设置 1 
 

 
 

图 3.2.7.11  观察窗口设置 2 
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图 3.2.7.12  观察窗口设置 3 

 
-观察窗口中各波形的时域波形。 
-将各观察窗口参数中“Display Type”项分别改成“FFT Magnitude”。 
-观察窗口中各波形的频域波形。 

8．点击菜单 debug\Animate，这样程序每次在断点处停止运行，读出数据，然后自动开始往 
下执行程序。我们可以在频域中看到 fIn 中显示的高频部分，在 fOut 显示中已经被滤除

掉了。 
9．停止运行程序，退出 CCS 

请参看本书第三部分、第一章、六。 
 

五．实验结果 
 

 
图 3.2.7.13  结果显示 1 
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分析：输入波形是一个比较低的频率，所以没有被滤掉。 
 

 
 
图 3.2.7.14  结果显示 2 

 
分析：输入波形是一个拥有高频部分的一段信号，从输入和输出音频数据的频域上可以看

出，输出音频的高频部分被较好地滤除了。从时域图也可发现，输出波形去掉了输入波形的震

动较快的成分。 
 

六．问题与思考 
试选用高通和带通 FIR 滤波系数来做此实验(滤波系数可以写入 main_nonBIOS.c 文件中的

efHn 数组中)。  
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